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Introduction

This document describes tasks that must be completed or coordinated by the administrator of the Fiery® ES IC-418.
The procedures in this document require the following conditions:

• The Fiery ES is installed at the site and confirmed as operational by the service technician.

• The Fiery ES is connected to the network, a power source, and the printer.

• The printer is powered and operational.

Note: For information about how to configure the printer, see the documentation accompanying the printer.

Terminology, conventions, and documentation resources

This document uses the following terminology and conventions to refer to the Fiery® ES IC-418, printer, and
supported operating systems.

Term or convention Refers to

Aero Fiery ES (in illustrations and examples)

Command WorkStation Fiery Command WorkStation

Printer MFP

Fiery ES Fiery® ES IC-418

Mac OS All supported Mac operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Windows All supported Windows operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Warning: A warning concerning operations that may lead to death or injury to persons if not performed
correctly. To use the equipment safely, always pay attention to these warnings.

Caution: A caution concerning operations that may lead to injury to persons if not performed correctly. To
use the equipment safely, always pay attention to these cautions.

Important: Operational requirements and restrictions. Be sure to read these items carefully to operate the
equipment correctly, and avoid damage to the equipment or property.
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The following documentation resources are available for the Fiery® ES IC-418.

Resource Description

User documentation Documents in this set: Color Printing, Configuration and Setup, Fiery Productivity Package,
Printing, Utilities

Online help • Help can be accessed directly from each Fiery application or by going to help.efi.com.

• Each help system is available as a printable PDF, accessed from the PDF icon in the upper right
corner of the Help window.

Additional reference
material • Fiery Color Reference - help.efi.com/ref/colorref/en-us/

• Variable Data Printing - help.efi.com/ref/vdp/en-us/

• Workflow Examples - help.efi.com/ref/workflows/en-us/

• Configure Help - help.efi.com/configure/3.0/en-us/

General precautions for working with the Fiery ES

Fiery ES hardware

Always observe the following precautions to assist with personnel safety and prevent data loss or equipment damage.

Warning: Do not store or use flammable sprays or solvents near the Fiery ES or the printer. Components
within these machines can operate at a high enough temperature to provide an ignition source. Storing or using
flammable items near these machines could cause the items to catch fire or explode.

Warning: Never set any liquid on or near the Fiery ES or the printer. Spilling liquids into either machine could
result in electric shock and damage the machine. If liquid is spilled on or underneath either machine, or any
object falls into either machine, disconnect the corresponding power cable immediately, if safe to do so.

Warning: Do not remove the covers or otherwise open the Fiery ES hardware. Cables and parts inside the
chassis are intended to be serviced by technical support only.

Warning: Ensure that the power cabling remains as configured by the service technician. The designated power
cable and a grounded, correctly rated outlet must be used. If required, the cable should be protected by a surge
suppressor, line conditioner, or uninterruptible power supply (UPS).

Warning: Do not allow the power cords or cables to be compressed or bent at a sharp angle. Arrange them so
that no one might accidentally step on or trip over them.

Caution: Do not block the vents on the Fiery ES or otherwise restrict airflow. Leave clearance around all vents
and ensure that nothing falls into the vents.

Caution: Do not make mechanical modifications to the system. The safety and regulatory compliance of
modified equipment cannot be guaranteed.
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System requirements

We strongly recommend that you review all system requirements before you set up the Fiery ES.

Ethernet connection

For Ethernet connections, the Fiery ES supports Unshielded Twisted Pair (UTP) cabling for certain network speeds.
The following network speeds are supported:

• 10BaseT: Category 3 or later

• 100BaseTX: Category 5 or later (4‑pair/8‑wire, short‑length)

• 1000BaseT: Category 5e or later (4‑pair/8‑wire, short‑length)

Network requirements

When the Fiery ES is connected to a network, it behaves as a networked printer. Connecting to a live network allows
the Fiery ES to query the network for zones, servers, and server-based queues.

Supported network protocols

The Fiery ES is compatible with multiple network protocols. Client computers that do not have any of the
compatible protocols can send print jobs through a print server that has a supported protocol.
The Fiery ES can process concurrent protocols over the same connection. It automatically switches to the correct
protocol and handles connections simultaneously.
The Fiery ES supports TCP/IP and UDP/IP (IPv4 or IPv6), including:

• Bonjour

Note: Bonjour allows the Fiery ES to act as a Bonjour printer when communicating with Mac computers.

• DHCP

• FTP

• HTTP

• IMAP

• IPP

• LDAP

Configuration and Setup
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• LPD

• LPR

• NetBios over TCP/IP (NBT)

• POP3

• Port 9100

• SMB

• SMTP

• SNMP

• SNTP

• SSL/TLS

• WSD

AppleTalk (supported for font downloads only)

Enabling this setting allows Mac client computers to use AppleTalk to download fonts to the Fiery ES.

Internet Protocol (IP) requirements

The Fiery ES requires the following:

• Unique IP address (IPv4 or IPv6)

• Subnet mask

• Gateway address

You can enter these items manually or use DHCP protocol to assign them dynamically. Make sure the Fiery ES name
and address are listed in the domain name server (DNS) or host name database used by your system.

Client computer requirements

The Fiery ES utilities software, printer drivers, and online help are supported for Windows and Mac client
computers.

Installing and configuring printer drivers

Before you can print from a client computer to the Fiery ES, you must first install a printer driver on each client
computer and then configure them to include Fiery ES and printer installed options.
After you install and configure printer drivers, you can print from any application on a client computer to the Fiery
ES.
For more information about installing printer drivers, including installing printer drivers on other operating systems,
see Printing, which is part of the user documentation set.

Configuration and Setup
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Requirements for Windows client computers

The Fiery ES utilities and printer drivers support the standard Windows operating systems and system specifications.

Supported operating systems for Windows client computers

The Fiery ES utility applications and printer drivers are supported for the following Windows operating systems on
client computers.

Note: Support for Windows versions is based upon the latest service pack. Both 32 and 64-bit versions are supported
unless otherwise noted.

• Windows 8.1: Windows 8.1, Windows 8.1 Pro, Windows 8.1 Enterprise

• Windows 10: Windows 10 Home, Windows 10 Pro, Windows 10 Enterprise, Windows 10 Education, Windows
10 Mobile, Windows 10 Mobile Enterprise, Windows 10 IoT Core

• Windows Server 2008 R2 (64-bit only): Foundation, Standard, Enterprise, Datacenter, Web Server, Itanium-
Based

• Windows Server 2012 (64-bit only): Foundation, Essentials, Standard, Datacenter

• Windows Server 2012 R2 (64-bit only): Foundation, Essentials, Standard, Datacenter

• Windows Server 2016: Windows Server 2016 Technical Preview

System requirements for Windows client computers

The following table lists the system specifications required to install and use Fiery ES utility applications and printer
drivers on Windows client computers.

System requirement Description

Processor Pentium 4, 1.0 GHz or faster

Memory (except for Command WorkStation) 500MB (2GB recommended)

Hard disk space (except for Command WorkStation) 1GB (2GB recommended)

Requirements for Mac client computers

The Fiery ES utilities and printer drivers support the standard Mac operating systems and system specifications.

Supported operating systems for Mac client computers

The Fiery ES utility applications and printer drivers are supported for the following Mac operating systems.

Configuration and Setup
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Note: Support for Mac OS versions requires Intel-based Mac computers.

• Mac OS X v10.9

• Mac OS X v10.10

• Mac OS X v10.11

• Mac OS X v10.12

System requirements for Mac client computers

The following table lists the system specifications required to install and use Fiery ES utility applications and printer
drivers on Mac client computers.

System requirement Description

Processor Intel processor that supports the version of Mac installed. For
more information, go to apple.com.

Memory (except for Command WorkStation) 500MB (1GB recommended)

Hard disk space (except for Command WorkStation) 500MB (1GB recommended)

System requirements for Command WorkStation and WebTools

The following specifications are required to install and use Command WorkStation or WebTools on a client
computer.

Note: The Fiery ES supports Command WorkStation and WebTools by default (no configuration is required).

Requirement Descriptions

Internet browser versions supported for using WebTools and
for viewing Configure within Command WorkStation • Windows: Internet Explorer 11 or later, Firefox 31.0 or

later, Chrome 37.0 or later

In addition, Microsoft Edge is supported for client
computers that are running Windows 10 (not supported
for other versions of Windows)

• Mac OS: Safari 7 or later, Firefox 31.0 or later, Chrome
37.0 or later

Note: Microsoft releases frequent updates to Internet
Explorer. Because support cannot be guaranteed for all
versions, use the specified version for best results. On Mac
OS, some versions of Firefox may not allow you to enter
passwords into Configure. If this occurs, use Safari instead.

Memory (required for Command WorkStation only) 1GB or more

Hard disk space (required for Command WorkStation only) 3GB

Configuration and Setup
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Requirement Descriptions

Display 1024 x 768 screen resolution

Graphics card 16-bit color

Network protocol TCP/IP

Other requirements The IP address or DNS name of the Fiery ES must be
provided to each user who requires access through
WebTools.

Fiery JobMaster, Impose, and Compose requirements

To use Fiery JobMaster, Impose, and Compose, you must have the following on each client computer:

• Command WorkStation

• An activated license

• Acrobat/PitStop software

Mobile device requirements

Direct Mobile Printing is supported on the following mobile devices with iOS 4.2 or later and print functionality:

• iPad

• iPhone (4 or later)

• iPod touch (3rd generation or later)

Configuration and Setup
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Setting up from the printer control panel

Access Setup

You can use the Setup feature on the printer control panel to perform initial setup of the Fiery ES. You can also use
the printer control panel to access menus for additional Fiery ES functions.
1 Make sure that the Fiery ES is not receiving, printing, or processing files.

2 On the printer control panel, press the Menu button.

3 Press the Fiery logo.
The Fiery ES interface displays.

4 If prompted, log on with Administrator privileges.
The default Administrator password is Fiery.1 (case-sensitive).

5 On the Tools tab, press Setup.

Fiery-related menus on the printer

You can access many of the Fiery ES controls through the printer control panel.
For detailed information about the job management features, see Utilities.
Press Fiery on the printer control panel to access the Fiery ES tabs. Each tab typically includes the following items:

Logout (blue icon at top of
window)

Press to log out. You can then log back in using a different account
(administrator or operator).

Suspend printing (orange icon at
top of window)

Press to suspend communication between the Fiery ES and the printer, such
as for maintenance tasks. Pressing this button interrupts the current print
job and stops additional jobs from printing, but allows jobs to continue to
process on the Fiery ES. After being pressed, the button turns green to
become the Resume printing button.

Resume printing (green icon at top
of window)

Press to resume communication between the Fiery ES and the printer. After
being pressed, the button turns orange to become the Suspend printing
button.

Current tab name (blue button at
bottom of window)

Press to return to the main screen.
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Waiting Jobs, Held Jobs, and Printed Jobs tabs

You can use these tabs to view jobs that are either currently queued to print, on hold, or printing. To delete or print a
job, you must log on as Administrator or Operator.

Secure Jobs tab

You can use this tab to view jobs sent to secure printing with the same code.  For more information about using
secure printing, see Printing.

USB Media Server tab

You can use this tab to print a file from a USB flash drive to one of the published print connections. For more
information about printing from a flash drive, see Printing.

PrintMe tab

You can use this tab to submit print jobs using Document IDs (if you have a PrintMe subscription). PrintMe must
first be enabled. For more information about using PrintMe, see Printing.

Print Pages tab

You can print the following items from this tab:

PS Test Page Prints a test page to confirm that the Fiery ES is properly connected to the
printer. Also provides postscript (PS) versions of color and grayscale
samples, which can be used to troubleshoot problems with the printer or the
Fiery ES. Settings on the PS Test Page may include: Server Name, color
settings, printer model, and date and time the PS Test Page was printed.

PS Font List Prints a list of all PS fonts currently on the Fiery ES hard disk drive.

PCL Test Page Prints a test page to confirm that the Fiery ES is properly connected to the
printer. Also provides printer command language (PCL) versions of color
and grayscale samples, which can be used to troubleshoot problems with the
printer or the Fiery ES. Settings on the Test Page may include: Server Name,
color settings, printer model, and date and time the PCL Test Page was
printed.

PCL Font List Prints a list of all PCL fonts currently on the Fiery ES hard disk drive.

Configuration Provides general information about the hardware and software
configuration of the Fiery ES, the current Setup options, the current
calibration, and the IP address of the Fiery ES.

Job Log Prints a list of the last 55 jobs.

E-mail Log Prints a list of recent e-mail activity (if e-mail is enabled on the Fiery ES).

Tools tab

You can use this tab to select the following operations:

Calibrate Use to calibrate the Fiery ES using ColorCal. For more information, see
Color Printing. If an Administrator password has been set, you must enter it.
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Align Tray Use to adjust the placement of text and images on a page so that they are
correctly aligned on the sheet of paper, and to ensure that both sides of a
duplex sheet have the exact same alignment. For more information about
this function, see Command WorkStation Help.

Setup Use to select settings for the Fiery ES, including network settings and the
timeout period for the login to the printer control panel.

Restart Server Use to reboot, restart, and shut down the Fiery ES .

Clear Server Use to delete all jobs on the Fiery ES. User needs to confirm before
proceeding.

Info tab

You can use this tab to view information about the Fiery ES:

Server Name The name assigned to the Fiery ES.

IP Address The Fiery ES IP address.

Memory The memory allocated to the Fiery ES.

Hard Drive The size of the Fiery ES hard drive and the available free space.

Version The Fiery ES operating system version.

User The type of user account in the current session.

Installed Options The software options installed on the Fiery ES.

Setup options on the printer control panel

You can configure the network settings for the Fiery ES through the Tools > Setup feature on the printer control
panel.
Before configuring the network information, confirm that the Fiery ES is connected to an active network. This allows
the Fiery ES to query the network for zones, servers, and server-based queues. If you perform Network Setup without
a connected and functioning network, default settings are used that might not be accurate for your network.
Configure options only for the network systems that are currently used at your site. If your network requirements
change, you can change Setup at any time. If the Fiery ES is configured to enable more than one protocol, it
automatically switches to the correct protocol when it receives a print job.

Important: The submenus and options in this topic appear in sequence.

Server Name

Sets the name of the Fiery ES on the network (15 characters maximum).

Note: If you set up more than one Fiery ES, do not assign them the same name.
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Login timeout

Specify when the Fiery ES times out after you log on.
When you finish making changes, save the changes. The Fiery ES requires a reboot in order for any Setup changes to
take effect.

Ethernet Speed

Choose the appropriate speed of the network.
You can allow the Fiery ES to detect automatically the speed in any of these cases:

• The network speed is unknown.

• The network environment is mixed.

• The network uses 1 Gbps.

Get IP Address Automatically

Select to automatically obtain an IP address for the Fiery ES. Clearing this check box activates the fields for entering
the IP Address, Gateway Address, and Subnet Mask.

IP Address

Enter the Fiery ES IP address for Ethernet.
This IP address, unlike an IP address set automatically, remains the same if you restart the Fiery ES. You must
change the default to a valid address for your network.

Gateway Address

Set the gateway address for printing with TCP/IP on your network.

Subnet Mask

Set the subnet mask for printing with TCP/IP on your network.

Note: Before proceeding, confirm the subnet mask setting with your network administrator.

802.1x Setup

The Fiery ES can seek authentication from an 802.1x authentication server (such as a RADIUS server), often through
an intermediate access point (an authenticator).
The Fiery ES seeks this authentication at startup, or when the Ethernet cable is disconnected and reconnected. If the
Fiery ES is successfully authenticated, it is allowed access to the network.
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Enable 802.1x Authentication

Select to allow the Fiery ES to seek authentication from an 802.1x authentication server.

Select EAP Type

Choose the type of EAP (Extensible Authentication Protocol).

Note: This option is only available when Enable 802.1x Authentication is selected.

Validate Server Certificate

Select this option if you set Select EAP Type to PEAP-MSCHAPv2 and want the Fiery ES to use a trusted root
certificate when communicating with the authentication server. If you want the Fiery ES to validate the server
certificate, place the certificate in the list of trusted certificates of the Fiery ES.

Note: This option is only available when Enable 802.1x Authentication on page 16 is selected.

Username

The Fiery ES uses this information to request authentication from an 802.1x authentication server.

Note: This option is only available when Enable 802.1x Authentication is selected.
Use ASCII code characters (63 characters maximum). It is possible to enter more, but the supported length is 63
characters maximum. Although you can enter characters other than ASCII code characters, only ASCII code
characters are guaranteed for authentication.

Password

The Fiery ES uses this information to request authentication from an 802.1x authentication server.

Note: This option is only available when Enable 802.1x Authentication on page 16 is selected.
Use ASCII code characters (63 characters maximum). It is possible to enter more, but the supported length is 63
characters maximum. Although you can enter characters other than ASCII code characters, only ASCII code
characters are guaranteed for authentication.

Obtain IP for Engine

Select to allow the Fiery ES to obtain an IP address for the printer.

• Select if the printer is connected to the network through the Fiery ES.

• Clear to allow the printer to obtain its own IP address, which is possible if the printer is connected directly to the
network by a separate network cable.

Configuration and Setup

Setting up from the printer control panel

16



Enable Private MIB

Select to enable the private MIB (Management Information Base) included with the Fiery ES.

Enable Web Services

Select to enable web services for the Fiery ES. This feature must be enabled to allow the following:

• Access to the Fiery ES functions through the printer control panel

• Access to WebTools from client computers

• The option to submit print jobs using IPP network protocols

Important: We recommend leaving this option selected. If it is disabled, the above functions are not available.
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Integrating the Fiery ES into your network

Your service technician ensures that the Fiery ES is correctly installed at your site, the power supply and cooling are
adequate, and the required cables are connected.

Fiery ES hardware description

This section provides illustrations for the Fiery ES.

Front and back panels

Following are illustrations of the connector and LED panels.

Figure 1: Fiery ES front panel
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Figure 2: Fiery ES connector panel

1 Type A USB2.0 ports (x2)

2 Type A USB3.0 ports (x2)

3 Service switch

4 Power connector

5 Network port (10/100/1000 BaseT)

6 Printer interface port

7 LED display

8 Power button

9 Power switch

I: Power ON

O: Power OFF

Steps to integrate the Fiery ES into your network

This procedure provides an overview of the steps required to integrate the Fiery ES into your network and print
environment.

Warning: Ensure all cables remain routed to prevent trip hazards and to prevent accidental disconnection or
damage. Ensure that the cables are not compressed, pinched, or bent at a sharp angle. Damaged cables can
result in electric shock to personnel, in addition to faulty operation of the equipment.

Caution: Use caution and correct ergonomic procedures if it is necessary to lift or move the Fiery ES or
connected equipment.
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Important: If you are concerned about the possibility of information being extracted from the Fiery ES
Ethernet port without authorization, consider securing the Ethernet port.

Important: For the power connection to the Fiery ES, only use the power cable provided with the Fiery ES. Do
not use a power cable intended for any other electronic device.

Important: For the connection between the Fiery ES and the printer, only use the shielded Ethernet cable
provided with the Fiery ES. Do not use an unshielded cable.

Note: As an option, you can configure a Windows computer to act as a print server between the Fiery ES and the
client Windows computers. The client computers then print to the Fiery ES by printing to the print server, and you
can monitor and control printing at the network server.
To configure a Windows print server, install the Fiery ES printer driver on the Windows server, then share the
queues with network users. Make sure that the printer driver is updated as required. For information about
configuring a Windows print server, see the Windows documentation.

1 Review the Fiery ES requirements information to ensure the client computer requirements and other
requirements are met.

2 Confirm the Fiery ES network port (RJ-45 connector) is connected to a live network node.

3 Make sure all the Fiery ES cables are firmly seated.

4 Use the Fiery Setup Wizard to perform initial setup of the Fiery ES.

Note: If the settings are reset to factory defaults at any point, the server automatically reboots to identify the
printer model. During this process, the Fiery logo on the printer control panel briefly disappears and reappears.

5 Plan the levels of user access and set up the required accounts.

6 Review the server and network settings and customize as required for compatibility with your network and
printing environment.

Note: If the local workflow or network environment changes after the Fiery ES set up is complete, we recommend
reviewing the Fiery ES configuration settings again.

7 Review the Fiery ES job processing and printing settings and customize as required.

8 Plan the management of software updates and system backups.

9 Prepare the client computers by installing the Fiery ES printer driver and the Fiery ES utilities (including
Command WorkStation).

10 Print a variety of test pages to confirm that printing is working as expected.

Powering the Fiery ES on or off

Generally, you can leave the Fiery ES and the printer operating continuously. However, configuration changes may
require a reboot of the Fiery ES.
You can restart the Fiery ES system software without rebooting the Fiery ES. During a restart, network access to the
Fiery ES is temporarily interrupted and all processing jobs are terminated.
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Note: If a bootable USB flash drive is inserted in the Fiery ES, remove it before rebooting. Non-bootable flash drives
do not interfere with the boot process.

Important: Before you restart, reboot, or shut down the Fiery ES, we recommend that you confirm the reason
with your local network administrator or with technical support.
If the Fiery ES must be powered off for any reason, always shut it down correctly by following the shut down
instructions provided in this document.
Protect the Fiery ES from power interruptions. Ensure that the power cable remains as configured by the
service technician and that the cable is protected as required by a surge suppressor, line conditioner, or
uninterruptible power supply (UPS).

Power on the Fiery ES

1 If the printer is off, press the main power switch on the printer to turn it on.

2 Make sure that the Fiery ES power cable is connected to power as it was configured by the service technician.

3 Make sure the Fiery ES power switch is in the ON (|) position.

Note: Depending on the market region, the power supply cover may be attached to the Fiery ES chassis, and the
power switch may not be accessible. In this case, the power switch is in the ON (|) position by default.

4 Press the Fiery ES power button once.
The power supply automatically senses the correct voltage. Allow startup to proceed without interruption.

5 Wait for the Fiery ES to power on and reach Idle.

Restart, Reboot, or Shut Down the Fiery ES

You can restart the Fiery ES software, reboot the Fiery ES, or shut down the Fiery ES through the following methods:

• Command Workstation: Restart or reboot

• Printer control panel: Restart, reboot, or shut down

Important: Avoid using the power button to shut down the Fiery ES, as doing so may cause the system to
operate unpredictably.  If you need to shut down the Fiery ES, we recommend shutting down through the
printer control panel. Use the power button only if the printer is off or the system is unresponsive to keyboard
or mouse actions. In this case, briefly press and release the power button.

Restart or reboot from Command WorkStation

1 Make sure that the Fiery ES is not receiving, processing, or printing any files.
If the system has just finished processing, wait at least five seconds after the system reaches Idle before you
proceed.
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2 In Command WorkStation, click the Server menu.

3 Select one of the following:

• Restart Fiery

Restarts the Fiery ES system software without rebooting the operating system on the Fiery ES.

• Reboot Server

Reboots the Fiery ES.

Shut down, restart, or reboot from the printer control panel

1 Make sure the Fiery ES is not receiving, processing, or printing any files. If the system has just finished
processing, wait at least five seconds after the system reaches Idle before you proceed.

2 On the printer control panel, press the Menu button. Press the Fiery logo and then press Tools.

3 Press Restart Server.

4 If prompted, log on as Administrator or Operator.
The default password is Fiery.1 (case-sensitive).

5 Select one of the following:

• Reboot Server

Completely restarts the Fiery ES, both the Fiery ES system software and the operating system software on the
Fiery ES.

• Restart Server

Restarts the Fiery ES system software without rebooting the operating system software on the Fiery ES.

• Shut Down System

Completely shuts down the Fiery ES.
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Accessing the Fiery ES

You can access the Fiery ES as follows:

• Printer control panel: Provides access to selected Fiery ES features.

You can also use Fiery ES utilities such as WebTools or Command WorkStation to view Fiery ES status and manage
print jobs from a client computer. For more information, see Utilities.

Access Configure from Command WorkStation

1 From Command WorkStation, connect to the desired Fiery ES and log in as Administrator.

2 Do one of the following to start Configure:

• In Device Center, on the General Info tab, click the Configure button.

• In the Server menu, click Configure.

3 From Configure, change current Fiery ES setup options.

WebTools

WebTools consists of several utilities that allow you to manage your Fiery ES from the Internet or your company
intranet.
From WebTools, you can access:

• Home provides current information about the jobs processing and printing on the Fiery ES. Home also allows
you to download software updates, manage installed Fiery options, and check for product updates.

• Docs allows remote users to access jobs on the Fiery ES over the Internet or intranet.

• Mailbox allows remote users to access jobs on the printer over the Internet or intranet. You can also create, edit,
and delete User Boxes on the printer.

• Configure allows the Fiery ES administrator to view and modify Setup options remotely from a Windows or Mac
OS computer.

• Fiery System Restore allows you to back up the Fiery ES manually, schedule automatic backups, and restore the
Fiery ES from a backup file.
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Access Configure from WebTools

Use Configure to set up the Fiery ES. Setup is required the first time the Fiery ES is turned on or after system
software is installed. You also use Configure to specify information about the network environment and printing
preferences for jobs that users send to the Fiery ES.
1 Open an Internet browser and type the IP address of the Fiery ES.

2 In WebTools, click the Configure tab.

Note: If you receive a message about untrusted connections, you can ignore the message and proceed anyway.

3 Log on with Administrator privileges.
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Administration

The Fiery ES includes many features to help you manage printing, performance, and security.

Maintaining optimal Fiery ES performance

The Fiery ES is designed to require no maintenance. In addition, the Fiery ES supports multiple methods for
optimizing performance.
Reduce network traffic:

• Only publish the print connections that are being used.
The Fiery ES constantly checks all published connections, even if they are inactive. It is easy to re-establish
connections if required.
The related settings can be found in Configure > Job Submission.

• Schedule less-urgent and recurring print jobs for low-traffic periods.
Move jobs that are not urgent to the Hold queue. At low-traffic periods, a Fiery ES Administrator or Operator
can move jobs between queues.

• Reduce unnecessary network communication.
Large numbers of users running Fiery ES utilities, especially with frequent updates, may impact Fiery ES
performance.
Schedule Fiery ES software updates and non-critical network usage for low-traffic periods.

Manage print jobs for greatest efficiency:

• Disable the ability to preview jobs while the jobs are processing.
This setting can be found in Configure > Job Management.

• Allow print jobs to process while they are being received.
This setting can be found in Configure > Job Management.
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Make sure there is adequate disk space on the Fiery ES:

• Confirm that only essential files are stored on the Fiery ES.
Do not store unnecessary files on the Fiery ES.

• Reduce the number of jobs retained in the Printed queue.
This setting can be found in Configure > Job Management > Printed Queue.

• Remove inactive jobs from the queues.
When you remove inactive jobs, new jobs are spooled and printed more quickly.
Periodically review the jobs in the Held queue and other queues.

Back up and restore settings

You can back up and restore selected settings or the entire Fiery ES configuration.

Recommended back up actions

Important: We recommend creating a bootable system image on an external USB device. This allows recovery
if the hard disk is not functional or has been replaced.
If it becomes necessary to restore the Fiery ES from a bootable image, contact your service technician.
If the hard disk is still functional, you can use Fiery System Restore to restore the system from a non-bootable
image. You can also use Fiery System Restore to restore from a bootable image without booting from the image.

Important: Restoring the Fiery ES system image reformats the hard disk and overwrites any customizations
and data created since the system image was created.
All print jobs are lost when the system image is restored.

1 After the Fiery ES installation is complete, back up the Fiery ES factory image onto a bootable USB device.
This backup image is created from a factory image provided on the Fiery ES. You can use this image to revert the
system to the factory image, such as if software updates cause issues.

2 After you install any software updates and customize the Fiery ES configuration settings, back up the customized
Fiery ES system image onto a bootable USB device.
For details on what is included in the system image, see the back up and restore methods table in this chapter.
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3 Schedule regular automated back ups of the Fiery ES customized image.
This ensures that a recent customized system image is always available. The image is written to the internal hard
disk. Only one image can be saved on the internal hard disk. If a new image is created, it overwrites the previous
scheduled image.

Important: If you schedule automatic software updates in addition to automatic system back ups, we
recommend that you schedule the system back ups a minimum of two hours before the software updates.
This ensures a recent back up is available in case a software update causes any issues. Both automatic
features check if an automatic service is already running before taking action. Fiery System Restore also
checks to make sure the Fiery ES is idle before backing up the system.

4 Save your customized configuration settings as a separate file, as described later in this chapter.
This back up of the configuration settings as a separate file allows you to restore the configuration settings
without restoring the entire system image.

5 Optional: If you want to capture recent changes before the next scheduled back up occurs, you can manually back
up the Fiery ES customized image at any time. You can create this backup image as either a non-bootable image
on the internal hard drive (which does not overwrite the scheduled backup image) or on a USB device, or as a
bootable image on a USB device.

Back up requirements

Backups of the Fiery ES image require the following disk space:

• Factory default or customized Fiery ES image: 8 GB

Additional considerations for USB devices:

• For the fastest back up, use a USB 3.0 device in conjunction with the USB 3.0 port on the Fiery ES.

• USB flash drive: If you want to create a bootable image, the flash drive must be no larger than 32 GB.

• Fiery System Restore: If the image is larger than 32 GB, Fiery System Restore displays a message that there is
not enough space. In this case, we recommend backing up to a USB hard drive instead of a USB flash drive.

• USB hard drive: No size limit.

The estimated time needed for back up or restore is 25 minutes or more.

Recommendations to protect data

To protect your data, we recommend the following:

• Save a backup file of any important print job data in a separate location, such as on removable media.

• If the Fiery ES must be shut down for any reason, shut the system down correctly using the operating system
commands. Do not force a shut down.

• Prevent interruption of power to the Fiery ES. Ensure that the power setup remains as configured by the service
technician, and keep the necessary protection in place such as a surge suppressor, line conditioner, or
uninterruptible power supply (UPS).
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Data that cannot be guaranteed

If technical difficulties occur on the Fiery ES, we cannot assure storage of the following data:

• Print jobs

• Print job notes and instructions

• Scanned image data

• Jobs edited using Fiery Impose

• Variable data printing (VDP) job information

• Third-party fonts

• Color profiles, including profiles downloaded or edited using the Fiery ES Spot-On feature

• Fiery ES virtual printers

• Fiery ES configuration settings

Backing up and restoring the Fiery ES system image

The Fiery ES can be backed up and restored through Fiery System Restore, available through WebTools. Fiery
System Restore includes a feature for scheduling automatic back ups.
You can create two types of system image: a factory default image and a customized image.
A factory default image has the following characteristics:

• Can only be saved as bootable image

• Includes the factory default versions of both the software and the configuration settings

• Can be restored to the same Fiery ES unit and to other Fiery ES units

A customized image has the following characteristics:

• Can be saved as bootable or non-bootable image (we recommend creating a bootable image to ensure the ability
to efficiently restore the system in any circumstance)

• Includes any installed software updates plus the current state of the configuration settings

• Can only be restored to the same Fiery ES unit

Note: For details about what is included with each type of system image, refer to the back up and restore methods
table in this chapter.

Back up and restore methods for the Fiery ES system image

If the hard disk is functioning, you can restore the Fiery ES from a non-bootable image. You can also restore the
Fiery ES from a bootable image without booting from the image.
If the hard disk is not functioning, it must be restored from a bootable image by the service technician.
You can use the factory image to restore any Fiery ES unit. However, a customized image can only be used to restore
the same Fiery ES unit used to create the image.
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Note: The system image does not include VDP/FreeForm resources. To back up the FreeForm masters 1 and 2, save
the configuration settings as described in this document.

Back up method Description of backup
image

Bootable option Possible
destinations

Restore method

Fiery System Restore
in WebTools: Home
Tab > Fiery System
Restore > Create
Backup (Fiery factory
image)

Factory default image,
manually backed up.
Includes factory default
version of software and
configuration settings.

Does not include print job
information (print jobs, job
logs, and job settings such as
paper size).

Factory default
image can only be
saved as a bootable
image, and requires
a bootable USB
device.

USB device only. • Can restore
directly from
image

• Fiery System
Restore

Fiery System Restore
in WebTools: Home
Tab > Fiery System
Restore > Create
Backup (New image)

Customized image, manually
backed up. Includes contents
of C drive (except for items
excluded by standard
Windows back up process,
such as items in recycle bin).
Includes software updates
and current configuration
settings.

Does not include print job
information (print jobs, job
logs, and job settings such as
paper size).

Bootable option
supported for USB
devices only.

Can also create a
non-bootable image.

USB device or
internal hard disk. • If bootable, can

restore directly
from image

• Fiery System
Restore

Fiery System Restore
in WebTools: Home
Tab > Fiery System
Restore (Schedule
automatic backup)

Customized image,
automatically backed up.
Includes same content as
manually-backed up
customized image (described
in previous row).

Non-bootable image
only.

Internal hard drive. • Fiery System
Restore

Back up and restore the system image with Fiery System Restore

With Fiery System Restore, you can back up the Fiery ES manually, schedule automatic backups, and restore the
system from a backup file.
The Fiery System Restore backup file includes the operating system, the Fiery ES software, and the Fiery ES
configuration settings. It does not include these items:

• Jobs, job logs, or job settings

• VDP/FreeForm resources

The backup file can be saved as a file or onto a bootable USB device.
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Back up the Fiery ES system with Fiery System Restore

Important: We recommend that you save the system backup to an external location. This ensures that the
backup image is available even if the Fiery ES hard disk fails.

Important: If you create the system backup as a bootable image, Fiery System Restore automatically
prepares the USB device as a bootable drive. The destination device is reformatted and any existing data on
the device is lost.

1 Connect a USB storage device to the Fiery ES.
For faster backup, we recommend connecting a USB 3.0 device to a USB 3.0 port on the Fiery ES.

2 Make sure that the USB device does not contain any data or software that you want to keep.

3 Enter the IP address of the Fiery ES into a browser.

4 Confirm the Fiery ES is in the Idle state.

5 On the Home tab in WebTools, select Create Backup under Fiery System Restore.

6 Select USB to specify the file location.

7 Select the options that you want and click Continue.

• To create a bootable image with all the factory default versions of software and settings, select Fiery factory
image. Fiery System Restore automatically creates the factory image as bootable (a non-bootable factory
image cannot be created).

• To create a bootable customized image, select New image, then select Create bootable image. This creates
a bootable image that contains the current software updates and settings, including any customizations to
the Fiery ES configuration.

• To create a non-bootable customized image, select New image. This creates a non-bootable image that
contains the current software updates and settings, including any customizations to the Fiery ES
configuration.

8 Follow the on-screen prompts to complete the backup.

Schedule automated backups with Fiery System Restore

To minimize impact to Fiery ES performance, schedule the backups for a time when the Fiery ES is idle.
The automated backup files are saved to the local hard disk and can be accessed only through Fiery System
Restore. Only one automatic backup file is retained (each new automatic backup overwrites the previous
backup).

Note: Ensure that the Fiery ES remains powered up during the scheduled backup times, allowing enough time
for the backup to complete.

1 Enter the IP address of the Fiery ES into a browser.

2 Confirm the Fiery ES is in the Idle state.

3 On the Home tab in WebTools, select Schedule Automatic Backup under Fiery System Restore.

4 Select Enable automatic backup.
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5 Select the backup time.

6 Follow the on-screen prompts to complete the backup.

Restore the Fiery ES system using Fiery System Restore

Important: If the hard disk is not booting, the system must be restored from a bootable backup. If it
becomes necessary to restore the Fiery ES from a bootable image, contact your service technician.

Important: Before you restore the Fiery ES, we recommend that you contact technical support to confirm
the necessity of restoring.

Important: This procedure overwrites all data, customizations, and software updates implemented on the
Fiery ES since the customized backup image was created. It also overwrites any backup image that is stored
locally. If you restore from a factory default image, all data is lost.

Important: A customized image can only be restored to the same Fiery ES unit from which it was created.

1 If applicable, attach the external hard drive or USB containing the image to the Fiery ES.

2 On the Home tab in WebTools, select Restore under Fiery System Restore.

3 Follow the on-screen prompts to complete the restore.

4 Optional: After restoring the Fiery ES, run System Updates to ensure the latest Fiery ES software version is
installed, or request the service technician to install the patches.

5 Optional: If a backup of the configuration settings is available, restore the configuration settings as described
in this document.
This can be useful if the configuration backup is more current than the system image backup (such as if you
restored from factory default), or if the configuration backup included the job log and VDP/FreeForm
resources.

Backing up and restoring the Fiery ES configuration settings

You can back up and restore the Fiery ES configuration settings as a separate file from the system image. You can
restore the configuration settings file if you want to reapply the custom settings after reinstalling or upgrading
system software.
The configuration settings backup file can be applied to any Fiery ES unit that has the same version of Fiery ES
software installed (the client software utilities version does not matter). To determine the Fiery ES software version,
view the configuration summary in Configure.
You can back up and restore the configuration settings through Configure or Command WorkStation, both of which
provide the same options for which settings to back up. This document describes the Configure feature. For
information about the Command WorkStation feature, see Command WorkStation Help.
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Back up and restore methods for the configuration settings

Backup method Factory default or
customized settings

Possible destinations Restore method

In Configure, click Fiery
Server > Backup

Settings at time of backup. Any standard file location,
such as local or network
folder, external hard disk, or
USB device.

• In Configure, click Fiery
Server > Restore

• In Command
WorkStation, click
Server > Backup &
Restore

• In Command
WorkStation, click
Device Center >
General > Tools >
Backup & Restore

In Command WorkStation,
click Server > Backup &
Restore

Settings at time of backup. Any standard file location,
such as local or network
folder, external hard disk, or
USB device.

• In Configure, click Fiery
Server > Restore

• In Command
WorkStation, click
Server > Backup &
Restore

• In Command
WorkStation, click
Device Center >
General > Tools >
Backup & Restore

In Command WorkStation,
click Device Center >
General > Tools > Backup &
Restore tab

Settings at time of backup Any standard file location,
such as local or network
folder, external hard disk, or
USB device.

• In Configure, click Fiery
Server > Restore

• In Command
WorkStation, click
Server > Backup &
Restore

• In Command
WorkStation, click
Device Center >
General > Tools >
Backup & Restore
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Configuration settings not available for backup in Configure

You can back up most Fiery ES settings in Configure, but there are some exceptions.

• Fiery System Settings

• Current date and time (but the date and time are indicated by timestamp on the configuration file)

• Color Settings

• Added Calibration settings

• Color Adjustment features in ImageViewer
Use the Export Color Adjust feature from the File menu in ImageViewer

These features can be backed up by additional methods:

• Job Log

In Configure, select Job Log to specify how the Job Log is automatically exported.

The following information is not saved with the configuration file:

• Saved jobs in Hold queue
To back up these jobs, archive the jobs from the Hold queue.

• Saved jobs in Printed queue
To back up these jobs, archive the jobs from the Printed queue.

• Job settings
To save these settings, create a Job Properties local preset and back it up to external media.

• Paper simulation
You can export this information from Command WorkStation, Device Center > Resources > Profiles.

Back up settings with Configure

When you back up settings, you can specify which settings you want to save.
1 In Configure, select Fiery Server > Backup.

2 Follow the on-screen instructions to select the settings.

3 Click Backup to back up the selected settings.

Restore settings with Configure

If you have backed up your settings, you can recover them in Configure after a system crash. You can only recover
the settings that were selected for back up.
1 In Configure, select Fiery Server > Restore.
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2 Select the backup reference file and the backup data file and click Next.

3 Follow the on-screen instructions to restore your settings and click Finish.

Reset the configuration settings to factory defaults from the printer control panel

Important: If you reset the configuration settings to factory defaults, all the customized configuration settings
on the Fiery ES are lost. Before you reset the Fiery ES to factory defaults, we recommend that you discuss the
issue with technical support.

Note: You can reset the configuration settings to factory defaults from the printer control panel or in Configure
through Fiery Server > Restore Default Fiery Settings. This procedure describes the printer control panel method (the
Configure command is described in Configure Help). With either method, we recommend that you review all the
configuration settings after the reset and customize as required for your print environment.

1 Print out the configuration page or otherwise record the customized configuration settings. This can be used as a
reference if you want to reenter specific settings after returning the configuration to factory defaults.

2 Review the configuration settings and customize as required, then reboot to apply the changes.

Clearing print jobs

The Clear Server command allows you to clear all queued print jobs from the Fiery ES Print, Hold, and Printed
queues. Jobs can also be deleted, individually or as a group, using Command WorkStation. Clear Server also clears all
jobs archived on the Fiery ES hard disk drive, the index of archived jobs, and all FreeForm masters.
Back up your original data on your own media at the same time you store and save data on the Fiery ES hard disk
drive. Never damage or reset the Fiery ES hard disk drive, and do not turn off the system while accessing the hard
disk drive.
If the Fiery ES hard disk drive or system software experiences technical difficulties, data stored and saved on the
Fiery ES hard disk drive may be irretrievably lost. If problems with the hard disk drive occur, extended storage of the
following data cannot be assured:

• Third-party fonts

• Print jobs

• Color profiles, including profiles downloaded or edited using Spot-On

• Job notes and instructions

• Scanned image data

• Jobs edited using Impose

• Variable data documents

• Address books

• Fiery ES configuration information (list of all the settings currently in effect)

In Command WorkStation, click Clear Server from the Server menu.
For instructions on how to turn on and turn off the Fiery ES, see Powering the Fiery ES on or off on page 20.
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Types of data that can be cleared

The following types of data can be cleared:

• Held jobs

• Active jobs

• Printed jobs

• Archived jobs that are stored on the server

• Archived network links to jobs

• Scan jobs

• VDP resources (including FreeForm)

• Job log

• FTP log

• Email log

Software updates

The Fiery ES includes multiple update options.

Configure System Updates

You can use the System Updates feature to schedule updates of the system software.
Plan system updates for when the Fiery ES is not in use, such as nights or weekends.

Note: Ensure that the Fiery ES remains powered up during the scheduled update times, allowing enough time for the
update to complete.

Important: If you schedule automatic software updates in addition to automatic system back ups, we
recommend that you schedule the system back ups a minimum of two hours before the software updates. This
ensures a recent back up is available in case a software update causes any issues. Both automatic features check
if Fiery Service is already running before taking action.

While system updates are being installed, print jobs cannot be sent to the Fiery ES.
The Fiery ES automatically reboots during the system update process. It may need to reboot several times.

1 In Configure, log in with Administrator privileges, click Fiery Server > System Updates, and select Enable System
Updates.

2 Specify how frequently the Fiery ES contacts the Update Server.
This feature sets a schedule for downloading updates.

Note: The system updates are performed only when there are no jobs in process. If the system updates might not
occur due to extensive printer usage, increase the frequency of updates (such as daily instead of weekly).
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3 If you use a proxy server to connect through a firewall to the Update Server, click the HTTP Proxy Settings link. In
the Proxy dialog box, select Enable HTTP Proxy, enter the following information, and then click Save.

• Address: proxy server IP address

• Port: port used by the proxy server

• User Name: user name for accessing the proxy server

• Password: password for accessing the proxy server

4 Click Save.

Note: To confirm all outstanding updates are installed, check for product updates (for example, click Check for
Product Updates on the Home icon in WebTools).

Managing firewalls

If your network includes a firewall, make sure that the network firewall is configured to enable communication
between the Fiery ES and the client computers.
If the Fiery ES is behind a network firewall, configure a proxy server to allow the Fiery ES access to the internet for
automatic updates.
To configure a proxy server, open Configure and select Network > Proxy, then select Enable HTTP Proxy and enter
the required information about the proxy server.

User software

User software applications are first downloaded from the Update Server to a partition on the Fiery ES hard disk
drive. Users access the Fiery ES over the Internet and download the applications onto client computers and then
manually install them.
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Troubleshooting

Startup diagnostics are described in the documentation for service technicians. Contact your authorized service/
support center if you see startup error messages on Command WorkStation or if the Fiery ES does not reach the Idle
state.

Perform basic troubleshooting

These troubleshooting steps can help to resolve the most common issues.
1 Confirm that all the cables required for the Fiery ES are intact and firmly seated in the correct ports.

The most common cause of an issue is a faulty or loose cable.

Warning: Do not remove the covers or otherwise open the Fiery ES hardware. The parts inside the chassis
and internal cables are intended to be serviced by authorized service technicians only.

2 If the Fiery ES cannot power on, confirm that the power cord is intact and adequate power is available at the
power outlet.

3 If the Fiery ES is not visible on the network, confirm that the correct type of Ethernet cable is connected to the
correct network port.

4 Confirm that the Fiery logo is showing on the printer control panel. If not, check the status of the Fiery ES and
the cable connection to the printer.

5 Review any messages showing on the printer control panel.

6 If one or more client computers cannot print to the Fiery ES, confirm that the client computers have the correct
version of the Fiery ES printer driver and utilities installed.
For information about installing the printer driver, see Printing. For information about installing the utilities, see
Utilities.

7 If the Fiery ES is printing slowly or is not managing jobs as expected, review the Fiery ES configuration to confirm
the settings are optimal for your network and print environment.
Any changes to your network environment or workflow may require changes to the Fiery ES configuration.

8 Confirm that the operating system settings on the Fiery ES are not modified and the operating system is not
upgraded (unless approved by technical support).
Changes to the operating system settings or version can cause system problems.

9 Review any error messages showing in the Command WorkStation Servers list.

10 Take a screenshot of the Command WorkStation display and any error messages, then close and reopen
Command WorkStation. If any error messages display when it restarts, contact technical support.
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11 Reboot the Fiery ES. If the Fiery ES does not reach the Idle state or any other issues remain, collect the related
information and contact technical support.

Collect troubleshooting information

Collecting the following information can help technical support provide efficient solutions.
1 Record or photograph the current status showing on the printer control panel.

2 If applicable, take a screenshot of the WebTools display.

3 If applicable, take a screenshot of the Command WorkStation display and any error messages.

4 Close and reopen Command WorkStation and take a screenshot of any error messages that display when it
restarts.

5 Record any error codes displayed on the two-digit LED on the Fiery ES.

6 Make a list of the actions taken immediately prior to the issue and after the issue was discovered.

7 If the issue is relating to a specific job, create a job error report.

Job error reports

If errors occur when the Fiery ES is processing or printing jobs, you can submit a job error report to Technical
Support.
The job error report captures important information for Technical Support to troubleshoot and resolve issues such
as job errors, system failures, or unexpected print output. Job error reports collect job files, logs, and information
about the Fiery ES.
When you create a job error report, Command WorkStation collects job files, logs, and information about the Fiery
ES, and saves them to a zip file. Before sending the zip file to Technical Support, you can remove any files contained
in the zip file for security purposes.

Note: Print jobs do not need to be in an error state for generating job error reports. You can create a job error report
for any jobs in the Held or Printed queues.

1 In Command WorkStation, select a job in the Printed or Held list.

2 On Windows, press Ctrl and right-click the job. On Mac OS, press Command and right-click the job.

3 In the shortcut menu, click Create Error Report.

4 Enter information about the job error.
a) Enter comments and any additional details in the text field, such as steps for Technical Support to reproduce

the error.

b) Optional: If desired, select Rasters to include in the report.

c) Optional: If desired, select E-mail log to include in the report.

d) Optional: Attach files to the report, such as a PS file.
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5 Save the job error report to a specified folder.

Runtime error messages

Error messages related to canceling jobs and printing, including Disk Full messages and alerts about loading media,
may display.

Printer not found

Most failures to find a printer on the network are due to a missing or conflicting name or IP address for the Fiery ES.
On the Fiery ES:

• Make sure that the host name (DNS name) is entered at Configure > Fiery Server > Server Name. For more
information, see Command WorkStation Help.

On each Windows or Mac client computer:

• Ping the Fiery ES from the client computer, and perform standard troubleshooting of any connection issues.

• If standard troubleshooting does not resolve the issue, then you can specify the Fiery ES host name (DNS name)
in the hosts file.

Note: Once you specify the host name on the client computer, it must be updated each time the name changes.

• To allow Command WorkStation and other Command WorkStation utilities on the client computer to connect
to the Fiery ES, the Fiery ES IP address or DNS name must be configured in the server list. For more information,
see Utilities.

Cannot connect to the Fiery ES with Command WorkStation

If a problem occurs while you are connecting to the Fiery ES, an error message is displayed.
The problem can occur when:

• The Fiery ES is initially turned on.

• The Fiery ES restarts.

• You have changed settings affecting the server address and have not reconfigured the connection to the server.

If you experience this problem, try the following solutions, in this order:

• A remote computer running utilities or WebTools may be interfering by obtaining status information. If
possible, close the remote application, and try to connect again.

• Restart the Command WorkStation software and try to connect again.

• Restart the Fiery ES.
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Introduction

This document explains the Fiery Productivity Package features and how they work.
The Fiery Productivity Package option for the Fiery® ES IC-418 offers additional color and production features for
operators (or users with Operator or Administrator privileges) to monitor and manage the print workflow of jobs on
the Fiery® ES IC-418.

Terminology, conventions, and documentation resources

This document uses the following terminology and conventions to refer to the Fiery® ES IC-418, printer, and
supported operating systems.

Term or convention Refers to

Aero Fiery ES (in illustrations and examples)

Command WorkStation Fiery Command WorkStation

Printer MFP

Fiery ES Fiery® ES IC-418

Mac OS All supported Mac operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Windows All supported Windows operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Warning: A warning concerning operations that may lead to death or injury to persons if not performed
correctly. To use the equipment safely, always pay attention to these warnings.

Caution: A caution concerning operations that may lead to injury to persons if not performed correctly. To
use the equipment safely, always pay attention to these cautions.

Important: Operational requirements and restrictions. Be sure to read these items carefully to operate the
equipment correctly, and avoid damage to the equipment or property.

The following documentation resources are available for the Fiery® ES IC-418.

Resource Description

User documentation Documents in this set: Color Printing, Configuration and Setup, Fiery Productivity Package,
Printing, Utilities

Fiery Productivity Package

Introduction

5



Resource Description

Online help • Help can be accessed directly from each Fiery application or by going to help.efi.com.

• Each help system is available as a printable PDF, accessed from the PDF icon in the upper right
corner of the Help window.

Additional reference
material • Fiery Color Reference - help.efi.com/ref/colorref/en-us/

• Variable Data Printing - help.efi.com/ref/vdp/en-us/

• Workflow Examples - help.efi.com/ref/workflows/en-us/

• Configure Help - help.efi.com/configure/3.0/en-us/

Fiery Productivity Package

Fiery Productivity Package is installed with Command WorkStation and most Fiery Productivity Package features are
accessible from Command WorkStation.

Production features

The production features include:

Feature Where to set values or access

Fiery JDF Command WorkStation

Fiery Hot Folders Fiery Hot Folders (application)

Virtual Printers Command WorkStation: Virtual Printers

Advanced job management features:

• Print Next

• Process Next

Command WorkStation: Job Center

Fiery JobFlow Base Fiery JobFlow (application)

For information about Hot Folders, see Hot Folders Help.
For information about Fiery JobFlow Base, see Utilities.
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Color and graphic arts features

The color and graphic arts features include:

Feature Where to set values or access Print option name

Auto trapping (with customization and
rich black)

Command WorkStation: Device Center:
Color Setup: Trapping

Auto trapping

Control bar Command WorkStation: Device Center:
Color Setup: Control Bar

Control bar

Hot Folders file filters Hot Folders none

ImageViewer Command WorkStation: Job Center:
ImageViewer

none

Image Enhance Visual Editor Command WorkStation: Job Center:
Image Enhance Visual Editor

none

Postflight none Postflight

Spot-On (spot color manager) Command WorkStation: Device Center:
Resources: Spot Colors

none

For information about Hot Folders file filters, see Hot Folders Help.
For information about Spot-On, see Color Printing.

Feature activation

The Fiery Productivity Package option must be activated at the Fiery ES before you can access its features from your
computer. An administrator activates the option at your site using the software licensing feature in Command
WorkStation or in WebTools.

Check activation status

• To check if an optional feature is activated at the Fiery ES, do one of the following:

• Print the Configuration page (see Configuration and Setup).

• In Command WorkStation Device Center, check the General Info tab.

• In Command WorkStation Device Center, go to the Server Configuration tab and check the list of installed
options in the BIOS Setup section under RIP.
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Update the status on your computer

If an optional feature is activated at the Fiery ES, you must update the status of the option on your computer before
you can access the feature from your computer.

Update the status on Windows

Before updating the status on a Windows computer, you must install the printer driver. For information about
installing the printer driver, see Printing.

1 Open the Printers (or Printers and Faxes or Devices and Printers) window.

2 Right-click the Fiery ES and select Properties (or Printer Properties).

3 Click the Installable Options (or Configuration, or Accessories) tab.

4 Select Two-Way Communication.

5 Type the IP address or DNS name and click Update.

6 Verify that the feature appears under Installed Options, and click OK.

Update the status on Mac OS

Before updating the status on a computer running Mac OS, install the printer driver. For information about
installing the printer driver, see Printing.

1 Select Apple menu > System Preferences, and then select Print & Scan, or Printers & Scanners.

2 In the Printer List, select the Fiery ES and click Options & Supplies.

3 Click the Driver tab or the Options tab.

4 Select the option from the appropriate list.

5 Click OK to apply changes.

6 Quit System Preferences.
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Advanced job management features

The following sections describe how to access and use some of the advanced job management features.

Print Next

The Print Next feature moves the selected job immediately to the printing queue. If another job is currently printing,
the selected job for Print Next is printed immediately after.

Note: The Print Next feature is valid for jobs that have spooled to the Fiery ES, but have not yet been sent to the
printer. If you want a job that has already been sent to the printer to print next, you must specify that job from the
printer control panel. For more information, see the documentation that accompanies your printer.

Process Next

The Process Next feature moves the selected job immediately to the processing queue. If another job is currently
processing, the selected job for Process Next is processed immediately after.
The feature is accessed from the Actions menu in Command WorkStation and is described in Command
WorkStation Help.
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Auto Trapping customization

Trapping is a technique where some objects are printed slightly larger or smaller than you have specified in an
application, in order to prevent white edges around the objects. These white edges, or "halos," can be caused by
factors such as misregistration, the physical properties of the ink or toner, and the stiffness of the media.
The Auto Trapping customization feature provides you with advanced trapping settings and gives you full control
over their values. The Fiery ES is shipped with values that are optimized for the printer using regular paper, but if
these values do not provide the results necessary for the media that you use, modify the values to meet your
requirements.

Print a job with Auto Trapping

1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the print options in the
printer properties.
For information about how to set print options and print to the Fiery ES from Windows and Mac OS
applications, see Printing.
Alternatively, submit the job to the Fiery ES Hold queue and then set print options in Job Properties in Command
WorkStation.

2 On the Color tab, turn on the Auto trapping print option.

3 Click OK and print the job.

If you have not customized the trapping values with Command WorkStation, your job is printed with the default
trapping values. If you edited the values, your job is printed with the custom trapping values.

Customize Auto trapping

In Command WorkStation, the Auto trapping customization feature is on the Trapping tab under Color Setup in
Device Center. For more information about using Trapping, see Command WorkStation Help.
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Control Bar

Control Bar allows you to add a static color bar and dynamic job information to each printed page at a user-defined
location.

• The job information includes the print settings that were used to generate the page.

• The color bar is typically a series of color patches designed for process control. An instrument, such as a
spectrophotometer, and special software such as EFI Color Verifier are required to measure and interpret the
color bar readings.

The Control Bar feature can apply a control bar to any job. It does not require the document designer to insert any
information and it does not require special commands other than the Control Bar print option.

Note: If a control bar does not fit on the page, it will be clipped.

Note: If a background color is defined as "white" for a user-defined control bar, it must be defined in the CMYK
color space. Setting CMYK rendering intent to Absolute Colorimetric simulates the white of the paper using CMYK
values.

Print a job with a control bar

If you want to print a job from an application and specify a user-defined control bar, Two-Way Communication
must be enabled in the printer driver. Otherwise, only the factory-supplied control bar is available.

1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the print options in the
printer properties.
For information about how to set print options and print to the Fiery ES from Windows and Mac OS
applications, see Printing.
Alternatively, submit the job to the Fiery ES Hold queue and then set print options in Job Properties in Command
WorkStation.

2 On the Job Info tab, under Reporting, select a setting for the Control Bar print option.
Fiery is the factory-supplied control bar that prints the Ugra/Fogra Media Wedge by default.

3 Click OK and print the job.
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Callout Refers to

1 Static color bar

2 Job information
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ImageViewer

ImageViewer allows you to adjust colors in a job before it is printed. You can also use the preview in ImageViewer to
verify job placement, orientation, and content, as well as general color accuracy.
You can choose to display the plate data for each process color independently or in combination with the other
colors, allowing inspection of individual plate data or a combination of any range of plates.
You can inspect the color values at specific places on a page, allowing you to soft proof the color output.
If the job contains halftone simulation settings, the preview shows a composite view of all separations at the dot
level.
For information about using ImageViewer, see Command WorkStation Help.

Access ImageViewer

Start ImageViewer from the Actions menu or Preview window of Command WorkStation.

Access ImageViewer from Actions menu

1 In Job Center in Command WorkStation, select the job that you want to preview.

Note: ImageViewer recognizes only jobs that show processed/held (dark yellow) status. Processed/held jobs are
also indicated by the raster job icon (page with blue arrow).

2 If needed, select Actions > Process and Hold to move the job to processed/held status.

3 To start ImageViewer, do one of the following:

• Select Actions > ImageViewer.

• Right-click the selected job and select ImageViewer from the menu that appears.

Access ImageViewer from Preview

1 In Job Center in Command WorkStation, select the job that you want to preview.

Note: ImageViewer recognizes only jobs that show processed/held (dark yellow) status.

2 If needed, select Actions > Process and Hold to move the job to processed/held status.
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3 Select Actions > Preview or right-click the job and select Preview.

4 To start ImageViewer, select the thumbnail of the page that you want to soft proof, and then click the
ImageViewer button.

Callout Refers to

1 ImageViewer button

Monitor settings

This feature requires that a job be displayed with correct colors on your monitor. To display the colors correctly on
your monitor, you must set up the monitor according to the manufacturer’s recommendations, and specify the
correct monitor profile for your monitor.
Specify the following settings for the monitor:

• On the monitor: Brightness, Contrast, and Color Temperature

• In the operating system: Resolution, Refresh rate, and Number of colors

For more information about setting up the monitor and the monitor profile, see the documentation that
accompanies the monitor.
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Image Enhance Visual Editor

Image Enhance Visual Editor (IEVE) is an image editing application that provides users with a visual workspace to
adjust individual images in a job. With IEVE, you can see the effects of your adjustments and fine-tune the
appearance of an image.
With IEVE, you can adjust tone, color, and sharpness, and perform red-eye correction. You can apply the same
adjustments to all images on a page or a range of pages. When you save a set of adjustments as a preset, you can
easily apply the same adjustments in the future.
Adjustments made in IEVE affect the job on the server and cannot be applied to the original source document.
IEVE is accessible from Command WorkStation. For more information about IEVE, see Fiery Command
WorkStation Help.

Access IEVE in Command WorkStation

1 In Job Center in Command WorkStation, select the job containing the images that you want to adjust.

Note: IEVE supports PDF, PostScript, and imposed (.dbp) jobs only.

2 To start IEVE, do one of the following:

• Select Actions > Image Enhance Visual Editor.

• Right-click the selected job and select Image Enhance Visual Editor from the menu that appears.

IEVE and Apply image enhancement print option

IEVE adjustments are independent of the configurable Apply image enhancement print option. If the Apply image
enhancement print option is turned on for a job that is also modified with IEVE, the effects of both are applied to the
images in the job. We recommend that you use one or the other, not both, for a job.

• The Apply image enhancement print option is a faster way to apply simple adjustments that do not require
visual confirmation before printing.

• IEVE is faster for making selective adjustments that require fine-tuning and visual inspection.
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Postflight

The Postflight feature helps you determine why some printed jobs do not deliver expected color output. Both a
diagnostic and a training tool, it provides helpful global and object-specific information about how a job is received
and processed by the Fiery ES.
Postflight identifies not only those color spaces that are used by visible objects, but any color space used by a job. Use
Postflight to troubleshoot color problems with a previously printed job or as a preventive measure.

• You can print the original document with all objects (images, graphics, and text) color-coded.

• A report explains what color spaces are used in the job and what print options affect those spaces. The report
also provides information about the printing environment.

• You can print a Test Page to verify the condition of the printing environment.

You cannot use the Postflight print option for a job that uses Substitute Colors or Combine Separations.

Postflight settings

The Postflight print option can be set to print analytical reports for a job.

• Concise report

• Test page

• Color-coded pages

• All components

The Postflight print option is located in the Job Info tab of Job Properties or the printer driver.

Concise report

The concise report includes job information, global color management settings (such as output profile), object-
specific settings according to the object’s color space, and spot color information for all spot colors in the job.
The report is printed on the Fiery ES default paper size with the default calibrated color mode.
For mixed media jobs, which can use multiple output profiles, Postflight produces reliable results if the pages are
printed on the same media with the same settings.
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Test page

The Test page is printed with the same media and global settings as your job. However, color objects on this page are
printed independently of the user-specified source color definitions (such as CMYK and RGB source profiles).
If the color on the Test page is not correct, it is probably because of the output profile, calibration, or printer.
If the color on this page prints correctly, but the colors of objects in the job do not, it is likely because of a problem
with the objects themselves that cause them to be printed incorrectly. The problem might be the wrong color values
for text and graphics, bad quality images, or out-of-gamut colors.

Color-coded pages

Postflight can print a color-coded version of the original document that prints each object in a color that identifies
its source color space.
The colors used to represent the color spaces for objects are as follows:

• Gray objects: Gray

• CMYK objects: Cyan

• RGB objects: Red

• Device-independent objects: Indigo

• Spot color objects: Yellow

After identifying the color spaces of the objects that are printing incorrectly, you can make appropriate changes to
the settings that affect those color spaces to correct the problem.

Postflight examples

Scenarios show how Postflight can be helpful to users who require high-quality color.

• Diagnose an unexpected color

• Check the calibration status of a job

• Check the quality of an output profile

• Diagnose a color problem with a specific object

For each of the scenarios, instead of printing the report to the Fiery ES, you can send it to the Hold queue of the Fiery
ES and preview the information (of a job with raster data) in ImageViewer.

Note: The procedures for printing a job from a Windows and a Mac OS computer are similar.
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Diagnose unexpected color

If you print a job that results in an unexpected color, use Postflight to diagnose the problem.
1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the print options in the

printer properties.
For information about how to set print options and print to the Fiery ES from Windows and Mac OS
applications, see Printing.
Alternatively, submit the job to the Fiery ES Hold queue and then set print options in Job Properties in Command
WorkStation.

2 On the Job Info tab, under Reporting, set Postflight to All Components.

3 Click OK and print the job.
The Test page, Color-coded pages, and report are printed.

4 Review all Postflight pages.

5 Make appropriate changes based on all Postflight pages.
Depending on your printing environment, the condition of the printer, and the color settings, possible changes
are as follows:

• Correct problems with the printer (see the documentation that accompanies the printer).

• Calibrate the Fiery ES.

• Edit the colors of the output profile with Command WorkStation.

• Change the default settings in Command WorkStation.

• Change the job specific print option settings with Command WorkStation Job Properties.

6 Reprint the job, setting Postflight to Off.

7 Repeat these steps until the color results are acceptable.

Check the calibration status of a job

Use Postflight to check the calibration status of a job before printing the job.
1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the print options in the

printer properties.

2 On the Job Info tab, under Reporting, set Postflight to Concise Report.

3 Click OK and print the job.
The concise report is printed.

4 Review the information in the ColorWise global settings page.
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5 Perform calibration, if needed.
If service has been performed on the printer since the last calibration, or calibration has not been performed,
perform calibration using the calibration set specified in the Postflight report.

6 Reprint the job, setting Postflight to Off.

Check the quality of an output profile

Use Postflight to check the quality of an output profile on the Fiery ES.
1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the print options in the

printer properties.

2 On the Job Info tab, under Reporting, set Postflight to Test Page.

3 Click OK and print the job.
The Test page is printed.

4 Review the quality of the color on the Test page.

Note: Make sure that this page was printed with the same media and print option settings as the job.

5 Review the instructions on the Postflight Test Page.

6 Edit the color of the output profile, or create a profile, if needed.
It may be necessary to customize the output profile or create a new profile to get optimal results on the media the
job is using.

7 Reprint the job, setting Postflight to Off.

Diagnose color problem with a specific object

Use Postflight to diagnose a color problem with a specific object.
1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the print options in the

printer properties.

2 On the Job Info tab, under Reporting, set Postflight to Color-Coded Pages.

3 Click OK and print the job.
The color-coded pages are printed.

4 Review the Postflight color-coded pages.

5 Make changes to the color settings, if needed.

Note: Use the Color-Coded Pages setting to send a job to another printer that has a specific color-space
requirement. For example, a document targeted to a CMYK-only printer must have only Cyan-colored objects.

6 Reprint the job, setting Postflight to Off.
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Introduction

Printing describes how to install the printer drivers on Windows and Mac OS computers for the Fiery® ES IC-418.
This document covers the following topics:

• Installing printer drivers on Windows computers

• Setting up the printing connections on Windows computers

• Printing from Windows computers

• Installing printer drivers on Mac OS computers

• Setting up Mac OS computers for printing

• Printing from Mac OS computers

• Fiery® ES IC-418 print options

• Using printing methods other than the printer driver to print to the Fiery® ES IC-418

For information about setting up network servers and client computers to use the Fiery® ES IC-418, see
Configuration and Setup. For general information about using the printer, your computer, application software, or
network, see the documentation that accompanies those products.
For information about supported operating systems and system requirements, see Configuration and Setup.

Terminology, conventions, and documentation resources

This document uses the following terminology and conventions to refer to the Fiery® ES IC-418, printer, and
supported operating systems.

Term or convention Refers to

Aero Fiery ES (in illustrations and examples)

Command WorkStation Fiery Command WorkStation

Printer MFP

Fiery ES Fiery® ES IC-418

Mac OS All supported Mac operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Windows All supported Windows operating systems. For a complete list, see System Requirements in
Configuration and Setup.
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Term or convention Refers to

Warning: A warning concerning operations that may lead to death or injury to persons if not performed
correctly. To use the equipment safely, always pay attention to these warnings.

Caution: A caution concerning operations that may lead to injury to persons if not performed correctly. To
use the equipment safely, always pay attention to these cautions.

Important: Operational requirements and restrictions. Be sure to read these items carefully to operate the
equipment correctly, and avoid damage to the equipment or property.

The following documentation resources are available for the Fiery® ES IC-418.

Resource Description

User documentation Documents in this set: Color Printing, Configuration and Setup, Fiery Productivity Package,
Printing, Utilities

Online help • Help can be accessed directly from each Fiery application or by going to help.efi.com.

• Each help system is available as a printable PDF, accessed from the PDF icon in the upper right
corner of the Help window.

Additional reference
material • Fiery Color Reference - help.efi.com/ref/colorref/en-us/

• Variable Data Printing - help.efi.com/ref/vdp/en-us/

• Workflow Examples - help.efi.com/ref/workflows/en-us/

• Configure Help - help.efi.com/configure/3.0/en-us/

User software for printing

You need to install user software to set up basic printing on the Fiery ES.
Other documents may describe user software that can be used to print documents.

User software Description

Printer drivers (for Windows and
Mac OS)

Provides information about the Fiery ES and your particular printer model to your
application and printer driver.

Printer Delete Utility (for Windows) Uninstalls the Windows printer driver and associated printer driver files. (See 
Uninstall printer drivers from Windows client computers on page 16.)

Fiery Software Uninstaller Utility (for
Mac OS)

Uninstalls the Mac OS printer and associated printer driver files. (See Uninstall
printer driver from a Mac OS computer on page 30.)

Printing
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Windows for Fiery ES

The Fiery ES can be set up as a printer on a Windows computer by installing the printer driver that corresponds to
your printer and setting up the Fiery ES for printing.
Printer drivers provide a way to communicate information about print jobs between your applications, the Fiery ES,
and the printer.

Installing Windows printer drivers

Installing the printer driver is the first step to set up the Fiery ES as a printer.
The User Account Control (UAC) feature is available on computers with the Windows operating systems supported
by the Fiery ES. You must be the administrator or a user with Administrator privileges to install printer drivers. For
information about supported operating systems, see Configuration and Setup.

Note: If the Fiery ES printer driver is already installed, you must uninstall it before you install a new driver. (See 
Uninstall printer drivers from Windows client computers on page 16.)

Installing printer drivers with Point and Print

SMB printing (also known as Windows or WINS printing) allows you to install PostScript printer drivers on your
computer from the Fiery ES with Point and Print.
You can then print to a particular connection (Print queue, Hold queue, Direct connection or the name of the virtual
printer).
Each connection requires a separate installation. Repeat the procedure for each connection.
When you install the printer driver using Point and Print, you cannot configure installable options manually. The
installed options are displayed as the Fiery ES configuration in the printer driver. (See Configure installable options
on Windows client computers on page 23.)
Before you begin, ask your administrator to do the following in Setup on the Fiery ES:

• Assign the Fiery ES a valid IP address.
The IP address or DNS name is required in the following procedure.

• Configure the Fiery ES for SMB printing.

Note: SMB printing is referred to as Windows Printing in Setup and on the Configuration page.
For more information, see Configure Help or Command WorkStation Help.

Printing
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Set up SMB printing on Windows computers for the Fiery ES

Install the Fiery ES printer driver with SMB printing on Windows computers.
1 To navigate to computers and devices on your network, do one of the following:

• Windows 10/Server 2016: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, right-click the Start button in the lower-left corner of the screen. Click Control Panel. Click Hardware
and Sound and then click Devices and Printers.

• Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

• Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

2 Search for the Fiery ES on the network using either its name or IP address.
If you cannot locate the Fiery ES, contact your administrator.

3 Double-click the Fiery ES icon to display active print connections.

Note: For a description of each print connection, see Configure Help.

You must now create a printer port and install the printer driver from the User Software DVD.

Note: You can use Point and Print to install the printer driver and configure a particular connection to the Fiery
ES, but if you want to configure the print driver to connect to another Fiery ES then you must install the printer
driver from the User Software DVD.

4 Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for example, D:\), browse to
the Print Drivers\Driver_Installer folder, and double-click setup.exe.

5 Select the printer driver language in the Fiery Driver Installer dialog box, and click Next.
The Fiery Driver Installer installation wizard appears.
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6 Click Next to install the Fiery Driver Installer on your computer.

7 Read the license agreement, click I accept the terms of the license agreement and click Next.

8 Click Next in the Welcome to the Add Printer Wizard dialog box.

9 To add a local printer on the Windows client computer, do one of the following:

• Windows 10/Server 2016: Select Add a printer.

• Windows 8.1/Server 2012 R2: Select Add a local printer or network printer with manual settings.

• Windows 7/Server 2008 R2: Select Add a local printer.

10 Select Create a New Port, select Local Port from the Type of port menu, and then click Next.

11 In the Port Name dialog box, type the name of the Fiery ES, followed by the printing connection, and click OK.
Enter the port name as follows: \\Aero\print where Aero is the name of the Fiery ES and print is the printing
connection.

12 Click Have Disk in the dialog box displaying lists of manufacturers and printers.
You will now install the printer driver from the User Software DVD.

13 Browse to the Print Drivers\Ps_drvr folder.

14 Make sure oemsetup.inf or oemsetup is selected and click Open.

15 Verify the path is correct in the Install From Disk dialog box and click OK.

16 Follow the on-screen instructions.

Download printer drivers with WebTools

WebTools allow you to download printer driver installers to your computer directly from the Fiery ES, if your
administrator has turned on access to WebTools.
For information about Setup, see Configuration and Setup.
For information about setting up and starting WebTools, see Utilities.

1 Start your Internet or intranet browser and type the DNS name or IP address of the Fiery ES.

2 Expand Software Downloads.

3 Click the Printer Drivers link under the Windows tab.

4 If a dialog box prompts you to open the file or save it to disk, save it to disk.

5 Browse to the location where you want to save the PRNTDRV.EXE file and click Save.
The file is downloaded from the Fiery ES. This compressed file is an archive that contains multiple files.
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6 Double-click the PRNTDRV.EXE file to extract the files.
Depending on your operating system, you might be prompted to select a location to extract the files.
After the files are copied to the specified location, the Fiery Driver Installer starts automatically.

Note: The User Account Control (UAC) feature is available on computers with the Windows operating systems
supported by the Fiery ES. You must be the administrator or a user with Administrator privileges to install
printer drivers. Right-click PRNTDRV.EXE and select Run as administrator. For information about supported
operating systems, see Configuration and Setup.

7 Install the printer driver.
Follow the instructions for your operating system to install the printer driver. The procedures are the same as for
installing from the DVD. (See Install and complete the print connection for Windows on page 12.)

Install and complete the print connection for Windows

You need to install the printer driver and then complete the setup for the print connection.
You can install the printer driver from the User Software DVD or download and install it from WebTools.
When you install the printer driver and complete the print connection, you are automatically creating a local printer
(Port 9100). You can modify the port connection later, according to your network type.

1 To install the printer driver, do one of the following:

• Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for example, D:\), browse
to the Windows_User_SW\Print Drivers\Driver_Installer folder, and double-click setup.exe.

Note: When you insert the User Software DVD into the DVD drive, the Fiery Driver Installer may start
automatically.

• From WebTools, after the printer driver is copied to the specified location, the Fiery Driver Installer starts
automatically.

2 In the Fiery Driver Installer dialog box, select the printer driver language and click Next.
The Fiery Driver Installer - InstallShield Wizard appears.

3 Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.

4 Read the license agreement, click I accept the terms of the license agreement and click Next.

5 For these Windows operating systems, do the following:

• Windows 10/Server 2016: Click The printer that I want isn’t listed.

• Windows 8.1/Server 2012 R2: Click The printer that I want isn’t listed.

6 To add a local printer on the network, do one of the following:

• Windows 10/Server 2016: Select Add a local printer or network printer with manual settings.

• Windows 8.1/Server 2012 R2: Select Add a local printer or network printer with manual settings.

• Windows 7/Server 2008 R2: Select Add a local printer.
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7 Select Create a new port, select Standard TCP/IP Port from the Type of port menu, and then click Next.

Note: The WSD port is supported on Windows 7 or later.

8 Do one of the following:

• Windows 10/Server 2016: Type the host name or IP address of the Fiery ES. Select the Query the printer and
automatically select the driver to use check box. Click Next and proceed to step 9.

• Windows 8.1/Server 2012 R2: Type the host name or IP address of the Fiery ES. Select the Query the printer
and automatically select the driver to use check box. Click Next and proceed to step 9.

• Windows 7/Server 2008 R2: Type the host name or IP address of the Fiery ES, and then click Next. Proceed to
step 9.

9 In the Printers box, select your printer and click Next.

Note: Select the printer driver with "US" for North America (the default document size is Letter) or without "US"
for International (the default document size is A4).

10 Type a name for the Fiery ES in the Printer name field, and click Next.
This name is used in the Devices and Printers (or Printers and Faxes or Printers) folder and the queues window.

11 Follow the on-screen instructions.
Indicate whether you want to make it the default printer. Do not share the printer and do not print a Test Page at
this time.
Continue with the printer driver installation and at the last screen, click Finish.
The necessary files are installed on your hard disk drive.

12 Configure the installable options.
For more information, see Configure installable options on Windows client computers on page 23.

13 To set up a connection other than Port 9100, see Set up Standard TCP/IP Port (Raw or LPR) printing
connections on Windows client computers on page 18.

14 To use the printer driver, you must select the following options on the Advanced tab of the printer driver:

• Spool print documents so program finishes printing faster

• Start printing immediately

• Print spooled documents first

15 Click Apply in the Fiery ES Properties dialog box, and then click OK.

Install and connect to a virtual printer

A virtual printer allows you to print to the Fiery ES using a predefined set of job settings.
You do not have to set print options manually. Before you can print to a virtual printer, the administrator must
create and configure the virtual printer using Command WorkStation. After the virtual printer is set up, you can
install the printer driver and printer description files on your computer from the Fiery ES using Point and Print.
For more information about setting up virtual printers, see Command WorkStation Help.
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When you install the printer driver with Point and Print, you cannot configure installable options manually.
Installable options are configured automatically. The installed options are displayed in the printer driver when you
select the Two-Way Communication option.

Set up a virtual printer on a Windows computer

You need to install the printer driver and then complete the installation and setup of the virtual printer on the
Windows computer.
The printer driver can be installed from the User Software DVD.

1 To navigate to computers and devices on your network, do one of the following:

• Windows 10/Server 2016: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, right-click the Start button in the lower-left corner of the screen. Click Control Panel. Click Hardware
and Sound and then click Devices and Printers.

• Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

• Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

2 Search for the Fiery ES on the network using either its name or IP address.
If you cannot locate the Fiery ES, contact your administrator.

3 Double-click the Fiery ES icon to display active print connections.
Virtual printers are listed along with the Print queue, Hold queue, and Direct connection (if those connections
are active). Virtual printers are usually assigned names that indicate the type of job for which they are set up.

4 Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for example, D:\), browse to
the Print Drivers\Driver_Installer folder, and double-click setup.exe.

5 In the Fiery Driver Installer dialog box, select the printer driver language and click Next.
The Fiery Driver Installer installation wizard appears.

6 Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer screen.

7 Read the license agreement, click I accept the terms of the license agreement and then click Next.

8 For these Windows operating systems, do the following:

• Windows 10/Server 2016: Click The printer that I want isn’t listed.

• Windows 8.1/Server 2012 R2: Click The printer that I want isn’t listed.

9 To add a local printer on the network, do one of the following:

• Windows 10/Server 2016: Select Add a local printer or network printer with manual setting.

• Windows 8.1/Server 2012 R2: Select Add a local printer or network printer with manual setting.

• Windows 7/Server 2008 R2: Select Add a local printer.

10 Select Create a new port, select Standard TCP/IP Port from the Type of port menu, and then click Next.
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11 In the Port Name dialog box, type the name of the virtual printer for the printing connection, and click OK.

12 In the Printers box, select your printer and click Next.

Note: Select the printer driver with “US” for North America (the default document size is Letter) or without “US”
for International (the default document size is A4).

13 Type a name for the virtual printer in the Printer name field, and click Next.
This name is used in the Printers window and the queues window.

14 Follow the on-screen instructions.
Indicate whether you want to make the virtual printer the default printer. Do not share the printer and do not
print a Test Page at this time.
Continue with the printer driver installation and at the last screen, click Finish.
The virtual printer is displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.
You can print to a virtual printer as you would print to any other printer. Depending on how the virtual printer is
configured, you may not be able to set some print options.

Note: If you use Command WorkStation to import a PostScript file to a virtual printer and the file already
specifies the number of copies, the setting for the number of copies in the PostScript file takes precedence over
the number of copies set in the virtual printer.

Turn on Two-Way Communication on Windows client computers

You must turn on the Two-Way Communication option to automatically update your printer driver to reflect the
options currently installed on the printer.

Note: The User Account Control (UAC) feature is available on computers with the Windows OS supported by Fiery
ES. You must be the administrator or a user with Administrator privileges to add or change the installable options
after the printer driver is installed. (See Configure installable options on Windows client computers on page 23.)
For information about supported operating systems, see Configuration and Setup.

1 Navigate to the devices and printers on your network.

• Windows 10/Server 2016: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, right-click the Start button in the lower-left corner of the screen. Click Control Panel. Click Hardware
and Sound and then click Devices and Printers.

• Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

• Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

2 Right-click the Fiery ES icon and choose Printer properties or Properties.

3 Click the Installable Options tab.

4 Select the Two-Way Communication check box.
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5 Type the Fiery ES IP address or DNS name.

6 Select Update Fiery Driver When Opened to display the current default settings for the printer when the printer
driver is opened.

7 Click Update.

Note: To confirm that Two-Way Communication is turned on, click the About tab and check that the Fiery ES
name and other server information are displayed.

8 Click Apply, and then click OK.
You must click OK for the printer driver to reflect the correct installable options.

Uninstall printer drivers from Windows client computers

The Printer Delete Utility is installed and used locally to uninstall printer drivers from a Windows client computer.
You do not need to connect to the Fiery ES before you use the software.
1 Install the Fiery Printer Delete Utility using one of the following methods:

• Download Printer Drivers for Windows from WebTools.
Start your Internet or intranet browser and type the DNS name or IP address of the Fiery ES. Expand Software
Downloads. Click the Printer Drivers link under the Windows tab and follow the on-screen instructions to
install.

• Insert the User Software DVD into the DVD drive of the computer.
The Fiery User Software Installer starts automatically.

Note: AutoPlay must be turned on for the Fiery User Software Installer to start automatically.

2 Navigate to the local folder where the printer driver files were downloaded and double-click the Fiery Printer
Delete Utility folder. Double-click setup.exe and follow the on-screen instructions to install the utility.

3 Click Start, select Programs or All Programs, and then select Fiery.
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4 Select Printer Delete Utility.
Any Fiery ES printer drivers found on your computer are listed.

Note: All printer drivers installed on your computer are listed.

5 Do one of the following:

• To delete a printer, select the check box next to the printer name and click Delete the Selected Printers.

• To delete all of the installed printer drivers, select the Delete All Printer Drivers check box, and click OK.

6 When you finish deleting printer drivers, click Exit.

Setting up Windows computers for printing

After the printer driver is installed on the Windows client computer, you need to configure the proper connection
for your networked Fiery ES printer.
To print from Windows computers, you or the administrator must perform the following tasks to set up a
connection:

• Set up network servers, if any.

• Set up the Fiery ES to accept print jobs from your computer.

• Configure a port on each Windows computer for the network type.

Setting up printing connections on Windows client computers

The print connections must be set up on the Windows client computers.
The Fiery ES supports the following printing connections:

• SMB

• Standard TCP/IP (RAW or LPR)
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• IPP or IPP over SSL

• FTP

• WSD

Set up Standard TCP/IP Port (Raw or LPR) printing connections on Windows client
computers

After you install the printer driver, you can add or configure the Setup for the Standard TCP/IP Port (Raw or LPR)
connection on a Windows client computer.
To complete the Standard TCP/IP Port (Raw or LPR) connection, do the following:

• Prepare the Fiery ES to accept print jobs using Standard TCP/IP Port (Raw or LPR) protocols.

• Turn on LPD or Port 9100 on the Fiery ES.

• Configure the computer for the TCP/IP connection.

For more information about Setup, see Command WorkStation Help.
Before you complete the following procedure, contact your administrator for the IP address assigned to the Fiery ES.
The TCP/IP protocol should be installed as a default on the Windows computer. For Port 9100, you can set up the
connection and install the printer driver in one procedure.

Note: You can also set up the LPR Port connection by installing Print Services for UNIX, which is supplied as an
add-on Windows component. For more information, see the documentation that accompanies Windows.

1 Navigate to the devices and printers on your network.
The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

2 Right-click the Fiery ES icon and choose Printer properties or Properties.
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3 Click the Ports tab.

4 To add a new port, click Add Port.
To change the port settings, proceed to step 10.

5 In the Printer Ports dialog box specify the port type, do one of the following:

• Select Standard TCP/IP Port from the list of Available port types and click New Port.

• Double-click Standard TCP/IP Port in the list.

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

6 Click Next.
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7 Type the Fiery ES IP address.

8 Click Next.

9 Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and then click Close in the Printer
Ports dialog box.
To change the default setting, proceed to step 10.
If you do not want to change the default setting, the setting is now completed.

Note: Port 9100 was set as the default setting in Install and complete the print connection for Windows on page
12.
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10 Click Configure Port on the Ports tab of the Properties dialog box.

11 To set up the port settings, do one of the following:

• To use LPR printing, select LPR in the Protocol area and LPR Byte Counting Enabled in the LPR Settings area.

Note: You can also proceed without selecting LPR Byte Counting Enabled.

• To use Port 9100 printing, select Raw in the Protocol area.
The port number 9100 automatically appears in the Raw Settings area. This is the default port number. You
can print to the printer connection selected for Port 9100 printing on the Fiery ES.
To specify a specific port number, see step 12.

12 Type the name of the print connection.
For Port 9100, type the following port numbers for each print connection in the Raw Settings area:

• Fiery ES default: 9100
• direct: 9101
• print: 9102
• hold: 9103

Note: Type the number exactly as shown.

13 When the SNMP Status Enabled check box is selected, spooling is stopped if the printer driver or spooler detects
an error status on the Fiery ES.
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14 Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.

Note: The Fiery ES supports printing in the IPv6 environment on Windows operating systems. For information
about supported operating systems, see Configuration and Setup.

15 Click Apply in the Fiery ES Properties dialog box, and then click OK.

Complete IPP connections on Windows client computers

With Internet Printing Protocol (IPP), print jobs are sent to the Fiery ES over the Internet from Windows
computers.
Before you begin, perform the following tasks:

• Make sure that the Fiery ES is configured for TCP/IP printing and IPP printing. (See Command WorkStation
Help.)

• Specify the printing destination on your computer.
IPP over SSL connections is supported.

Note: Using IPP over SSL connection requires certificates on Windows operating systems. For information about
supported operating systems and on certificate creation, see Configuration and Setup. You can manage certificates
from Configure. (See Command WorkStation Help.)

1 Navigate to the devices and printers on your network.
The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

2 To add a printer, do one of the following:

• Click Add a printer, and then select Add a network, wireless, or Bluetooth printer or Add a network printer.

• Double-click the Add Printer icon, click Next, and then select Network printer and click Next.

3 To search for a printer on the network, do one of the following:

• Windows 10/Server 2016: If the printer search takes a long time, click The printer that I want isn’t listed.

• Windows 8.1/Server 2012 R2: If the printer search takes a long time, click Stop, and then click The printer that I
want isn’t listed.

• Windows 7/Server 2008 R2: If the printer search takes a long time, click Stop, and then click The printer that I
want isn’t listed.
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4 To connect to a printer on the network, do one of the following:

• Windows 10/Server 2016: Click Select a shared printer by name, and in the URL field, type the IP address or
DNS name of the Fiery ES, followed by the name of the connection (print, hold, or direct).
For example, http://10.10.10.150/ipp/print or http://DNS name of server/ipp/print sends the job to the
Print queue on the Fiery ES.

Note: The URL for the printer is not case-sensitive.

• Windows 8.1/Server 2012 R2: Click Select a Shared printer by name, and in the URL field, type the IP address
or DNS name of the Fiery ES, followed by the name of the connection (print, hold, or direct).
For example, http://10.10.10.150/ipp/print or http://DNS name of server/ipp/print sends the job to the
Print queue on the Fiery ES.

Note: The URL for the printer is not case-sensitive.

• Windows 7/Server 2008 R2: Click Select a Shared printer by name, and in the URL field, type the IP address or
DNS name of the Fiery ES, followed by the name of the connection (print, hold, or direct).
For example, http://10.10.10.150/ipp/print or http://DNS name of server/ipp/print sends the job to the
Print queue on the Fiery ES.

Note: The URL for the printer is not case-sensitive.

5 Click Next.

6 To install the printer driver, do one of the following:

• Windows 10/Server 2016: Select the manufacturer and model of your printer and click OK.

• Windows 8.1/Server 2012 R2: Click Install driver.

• Windows 7/Server 2008 R2: Click Install driver.

7 If you are installing the PostScript printer for the first time, follow the procedure Install and complete the print
connection for Windows on page 12.

8 Indicate whether you want to make the Fiery ES the default printer.

• Windows 10/Server 2016: Click Finish.

• Windows 8.1/Server 2012 R2: Click Next.

• Windows 7/Server 2008 R2: Click Next.

9 To complete the printer driver installation, click Finish.

Configure installable options on Windows client computers

After you complete the printer driver installation, you must configure the Fiery ES for the options installed on the
printer to allow the Fiery ES to take advantage of the printer options.
Configure the options manually, or for TCP/IP network connections, use the Two-Way Communication option to
configure the options automatically.
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Note: When you configure installable options manually, make sure to leave Two-Way Communication and Update
Fiery Driver When Opened options unchecked.
For information about specifying installable options, see printer driver help.

Note: The User Account Control (UAC) feature is available on computers with the Windows operating systems
supported by the Fiery ES. You must log on with Administrator privileges to add or change the installable options
after the printer driver is installed. For more information about supported operating systems, see Configuration and
Setup.

1 Navigate to the devices and printers on your network.
The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

2 For Windows computers with User Account Control, right-click the Fiery ES icon, select Run as administrator,
and then select Printer properties or Properties.
The User Account Control dialog box opens.

3 Select the User that has administrator privileges, type the password, and then click OK.

4 Right-click the Fiery ES icon and choose Printer properties or Properties.

5 Click the Installable Options tab and make your selections.

6 Click Apply, and then click OK.
You must click OK for the printer driver to reflect the correct installable options.

Configure installable options for printer drivers installed with the Add Printer Wizard on Windows
client computers

After you install the printer driver, you must configure the installable options.
If you install the printer driver from Add Printer Wizard and then use Two-Way Communication to configure the
installable options, the installable options are not configured properly.

1 After you install the printer driver, right-click the Fiery ES icon, select Printer properties, click the Installable
Options tab, and then select your installable options.

2 Click Apply, and then click OK.
You must click OK for the printer driver to reflect the correct installable options.

Printing from Windows client computers

You can print to the Fiery ES just as you would print to any other printer from a Windows application.
You can print from a networked Windows computer or a computer using Windows (WINS) printing. Select the
Fiery ES as the current printer in the Printer Name list, specify print options, and then print the document from the
application.
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The following list includes other methods to print to the Fiery ES and describes where to find information about
these features:

• Downloading files to the Fiery ES with the Docs tab in WebTools. (See Utilities.)

• Printing documents with E-mail Services. (See E-mail Service on page 51.)

• Printing documents with Fiery Hot Folders. (See Fiery Hot Folders Help or Utilities.)

• Printing documents with Command WorkStation. (See Command WorkStation Help.)

• Printing documents on the USB flash drive to the Fiery ES. (See Printing from a USB flash drive on page 53.)

• Printing documents with PrintMe cloud printing. (See PrintMe cloud printing on page 58.)

• Printing documents with Web Services Device (WSD) printing. (See Web Services for Devices printing on page
61.)

The following list includes information about printing and saving files to the Fiery ES and describes where to find
information about these features:

• Achieving optimal printing results from applications. (See Color Printing and Fiery Color Reference.)

• Printing jobs from Windows applications. (See Print jobs from Windows applications on page 25.)

• Specifying default print options. (See Specify default print options for print jobs on Windows client computers
on page 27.)

• Customizing the Quick Access icon. (See Customize the Quick Access icon in the Windows printer driver on
page 27.)

• Viewing the printer status. (See View the printer status on page 28.)

• Saving files to print to a remote location. (See Saving files to print at a remote location on page 28.)

• Printing custom page sizes. (See Defining and printing custom page sizes on page 98.)

Print jobs from Windows applications

To print from Windows applications, install the PostScript printer driver, and then specify print options for a
particular job before sending it to the Fiery ES for printing.
Be sure to configure the options on the Advanced tab of the printer driver after installation is complete. (See 
Installing Windows printer drivers on page 9.)
If you print to a virtual printer, you may not be able to set some print options, depending on how the virtual printer
is configured.
Some print options that are selectable from an application are similar to print options that are specific to the Fiery
ES and the printer. In these cases, use the print options specific to the Fiery ES and the printer. These options appear
on the Fiery Printing tab. The application may not set up the file properly for printing on the Fiery ES, resulting in
unexpected finishing, printing errors, or longer processing time.
If you specify incompatible print settings when printing a document, the Conflict dialog box provides instructions to
resolve the conflict.
Some print options, such as expert color settings and VDP master information, are available only if Two-Way
Communication is turned on or a particular installable option is configured. For information about Two-Way
Communication, see printer driver help. (See Configure installable options on Windows client computers on page
23.)
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If you select Printer’s default, the job prints according to the settings that the administrator specified in Setup. (See 
Print options and default settings on page 63.)

Set print options for a specific print job with the Windows printer driver

After you install the Windows printer driver on the client computer, you can set print options for a print job.
1 In your application, select File > Print, and select the Fiery ES as your printer.

2 Click Properties.

3 Click the Fiery Printing tab.
The Fiery Printing tab serves as the control center for all frequently used printing functions.
When you save the print options in a preset, the following option settings are not reflected:

• Job Info options: Job notes > Secure print, User authentication > Password, Account track > Department name,
Account track > Account password, Server authentication > Authentication server name, Project code, and
Project password

• Layout option: Impose

For information about using presets, see printer driver help.

Note: For a list of print options, see Print options and default settings on page 63.

4 Specify print options and settings for your job.
The print options are grouped by categories. Each group or tab contains print options that are similar or
complement one another.

• Quick Access- Contains duplicate print options from the other job properties groups. It is customizable, so any
print option can be added or removed from the view. The Quick Access tab lets you find print options quickly
without browsing through all of the Job Properties tabs. (See Customize the Quick Access icon in the Windows
printer driver on page 27.)

• Job Info- All information about the job, including user information that may be required for user
authentication and job handling. (See Job Info options on page 63.)

• Media- Attributes and sources of paper to print and insert. (See Media options on page 68.)

• Layout- Defines the imposition of the print job and the booklet process on the media/sheet, except for
positioning that compensates for finishing options, for example, Tray Alignment. (See Layout options on page
70.)

• Color- Color settings and additional features (when optional color features are turned on). (See Color options
on page 77.)

• Image- All Image Quality settings supported by the connected Fiery ES and printer. (See Image options on
page 84.)

• Finishing- Print options related only to finishing equipment on the printer, and also image shifting to
compensate for finishing options. These options override settings in Fiery ES Printer Setup but can be changed
from Command WorkStation. (See Finishing options on page 86.)

• VDP- All Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP settings. (See Variable
Data Printing (VDP) options on page 87.)
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• Stamping- All image stamping options that add or hide/remove any image on the job. This also includes
watermark properties that define the placement and style of the watermark. (See Stamping (Watermark)
options on page 89 or printer driver help.)

• Printer- Information about printer status that includes the current paper and toner levels. (See View the printer
status on page 28 or printer driver help.)

5 After you specify the print settings, click OK, and then click Print to send your print job.

Note: When you use the Enable job tracking print option, a window is displayed for your job accounting
information.

Specify default print options for print jobs on Windows client computers

You can set the default print options for Windows print jobs using the Windows printer driver.
1 Navigate to the devices and printers on your network.

• Windows 10/Server 2016: Press the Windows button on the keyboard to open the Start screen. From the
desktop, right-click the Start button in the lower-left corner of the screen. Click Control Panel. Click Hardware
and Sound and then click Devices and Printers.

• Windows 8.1/Server 2012 R2: Press the Windows button on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

• Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

2 Right-click the Fiery ES icon and select Printing Preferences.

3 Click the Fiery Printing tab.

4 Specify the default settings for your print job. (See Set print options for a specific print job with the Windows
printer driver on page 26.)

5 Click OK to close the dialog box.

Customize the Quick Access icon in the Windows printer driver

The Quick Access icon can be customized with print options that you use frequently.
This saves time because you do not have to open all of the other print option icons to set the options that you placed
in Quick Access.
When you place a print option in Quick Access, it still appears under its original print option icon. You can set the
option from either location.

1 In your application, select File > Print and select the Fiery ES as your printer.

2 Click Properties.
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3 Click the Fiery Printing tab.

4 Click Customize to specify the options shown in the Customize Quick Access dialog box.

5 Add or remove a shortcut by selecting one and moving it from the Available Shortcuts list to/from the Current
Shortcuts list.

6 Click OK to save your changes.
For more information about Quick Access, see printer driver help.

Fiery Driver Updater

The Fiery Driver Updater notification is displayed by the default setting. When updates are available, the Fiery Driver
Updater notification window opens. You can update the printer driver by clicking the Update button.
You can also start the Fiery Driver Updater by clicking Check for driver update on the About tab of the Printer
Properties window.
If you prefer to have automatic notification for updates turned off, do the following procedure.

1 Start the Fiery Driver Updater.

2 Click the settings icon at the bottom left corner of the Fiery Driver Updater window.

3 Clear the Show notifications option in the Preferences window.

Note: The Fiery Driver Updater updates the Fiery core driver only.

View the printer status

You can retrieve the status and levels of consumable materials of the printer from the Fiery ES and display them in
the printer driver with the Two-Way Communication option.
You can retrieve its color settings from the Fiery ES and display them in the printer driver.
For information about monitoring the status of the printer, see printer driver help.

Saving files to print at a remote location

If you do not have the Fiery ES on site and are preparing files for a service bureau or other location, print the final
files to the File port (as opposed to one of the local ports).
You can also print to the File port to create a file to download using the Docs tab in WebTools. For instructions on
printing to the File port, see the documentation that accompanies Windows.
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Mac OS for Fiery ES

The Fiery ES can be set up as a printer on a Mac OS computer by installing the printer driver that correspond to
your printer and setting up the Fiery ES for printing.
Printer drivers provide a way to communicate information about print jobs between your applications, the Fiery ES,
and the printer.

Note: Select the printer driver with "US" for North America (the default document size is Letter) or without "US" for
International (the default document size is A4).

Installing printer driver on a Mac OS computer

Installing the printer driver is the first step to set up the Fiery ES as a printer.

Note: If the Fiery ES printer driver is already installed, you must uninstall it before you install a new driver. (See 
Uninstall printer driver from a Mac OS computer on page 30.)

Install the Mac OS printer driver

You can install the printer driver from the User Software DVD, as well as the software for Mac OS computers.

1 Quit all open applications.

2 Insert the User Software DVD into the DVD drive.

3 Open the Mac_User_SW folder.

4 Double-click Fiery Printer Driver.dmg.

5 Double-click Fiery Printer Driver.pkg and click Continue.

6 Read the license and click Continue.

7 Follow the on-screen instructions.
The Fiery Printer Driver Installer installs the printer driver that correspond to the Fiery ES.

Note: When the printer driver is added with the Bonjour connection, the last three bytes of the Mac OS address
is added to the Fiery ES name.
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8 If you can find the Fiery ES from the list of printers by Network Discovery, do one of the following:

• Select the Fiery ES, and continue to install the printer driver by specifying the Print queue. The printer uses the
Bonjour connection.

• If you specify the Hold queue, the printer uses the LPD (LPR) protocol.

9 If you cannot find the Fiery ES (on a different subnet) and you want to use Port9100/LPR/ipp or want to connect
to a virtual printer, then click Install Printer Driver Only.
You need to associate the printer driver from System Preferences > Printers & Scanners with the Fiery ES.

Download printer drivers with WebTools

WebTools allow you to download printer driver installers to your computer directly from the Fiery ES, if your
administrator has configured access to WebTools.
For more information about setting up and starting WebTools, see Utilities.

1 Start your Internet or intranet browser and type the DNS name or IP address of the Fiery ES.

2 Expand Software Downloads.

3 Click the Printer Drivers link under the Mac OSX tab.
A file named Fiery Printer Driver.dmg is downloaded to your desktop.

Note: If the file is not on the desktop, open the Downloads folder.

4 Double-click Fiery Printer Driver.dmg.

5 Double-click Fiery Printer Driver.pkg and click Continue.

6 Read the license and click Continue.

7 Follow the on-screen instructions.

Uninstall printer driver from a Mac OS computer

The Fiery Software Uninstaller utility is used to remove printer drivers from the Mac OS computer. It is installed and
used locally on your Mac OS computer.

Install and use the Fiery Software Uninstaller utility

1 Copy the Fiery Software Uninstaller.dmg to your desktop from the User Software DVD.

2 Double-click Fiery Software Uninstaller.dmg.
The Fiery Software Uninstaller opens in the Finder, displaying the Fiery Software Uninstaller icon and an arrow
pointing to a link to the Applications folder.

3 Drag the Fiery Software Uninstaller icon to the Applications folder.
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4 Open the Applications folder and double-click the Fiery Software Uninstaller icon.

5 Click the Printers tab if it is not already selected.

6 Select a printer from the Installed Printers list.

7 Do one of the following:

• Click Remove Printer and Driver to remove the printer along with its printer driver files.
If you want to remove the printer and the associated printer driver files, you can select only one printer at a
time.

• Click Remove Printer to remove the printer from the Installed Printers list only, but leave the printer driver files
installed.
The utility can remove only printers that are not currently in use or open on the Dock.

Note: If more than one printer uses the same printer driver file, removing the printer driver file also removes all
printers using that printer driver.

8 To confirm that you want to delete the printer, type the password for your Mac OS computer in the dialog box
and click OK.

9 Click the Drivers tab to view the installed printer drivers.

10 Close the Fiery Software Uninstaller dialog box.

Delete the Fiery Software Uninstaller utility

• Delete the Fiery Software Uninstaller icon from the Applications folder.

Set up Mac OS computers for printing

After the printer driver that corresponds to your printer has been installed, you must set up the Mac OS computer
for printing to the Fiery ES.

Set up the Fiery ES from the Print dialog box on a macOS Sierra 10.12

1 Open a file in your application.

2 Select File > Print.

3 Select Add Printer from the Printer menu.
In the dialog box that appears, select a printer connection.
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Set up printing on a macOS Sierra 10.12 client computer

After you have the Fiery ES printer driver installed, you must set up printing to the Fiery ES on a client computer
running macOS Sierra 10.12. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the Fiery ES with Printers & Scanners on a macOS Sierra 10.12 client computer

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Click the + button and select Add Printer or Scanner.
In the dialog box that appears, select one of the printer connections:

• Default

• IP
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Add a printer with the Default connection on a macOS Sierra 10.12 client computer

You can add a printer with the Default connection on a macOS Sierra 10.12 client computer.
1 Click the Default icon in the Add dialog box.

The names of printers with default connections are listed.
The names of the virtual printers appear as printer name : virtual printer name in the list of printers.
Any published virtual printer is available over LPR and FTP.

Note: SMB printing is not supported for macOS Sierra 10.12.

2 Select the Fiery ES from the list.
The information about the selected printer appears at the bottom of the Default pane. The appropriate printer
driver for the Fiery ES is automatically selected.

3 Click Add.
The Fiery ES name appears in the list of printers.

4 Select Fiery ES.

5 Click Options & Supplies, and then click the Options tab.

6 Specify the installable option settings, and then click OK.
For information about configuring installable options, see printer driver help.
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Obtain the IP address of the Fiery ES on a macOS Sierra 10.12 client computer

When the Bonjour connection is used for the Fiery ES printer driver on a macOS Sierra 10.12 client computer, you
can find out the IP address of the Fiery ES from the printer’s Webpage.

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Select the Fiery ES from the list, and then click Options & Supplies.

3 Click the General tab, and then click Show Printer Webpage.

4 Click the Configure tab.

5 Scroll to Network Protocol Setup, locate the IP address for the Fiery ES, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.
For information about Two-Way Communication, see printer driver help.

6 Click the Close button to exit WebTools.

7 Click OK to close the Options & Supplies pane.

8 Close the Printers & Scanners dialog box.

Add a printer with the IP Printer connection on a macOS Sierra 10.12 client computer

You can add a printer with the IP Printer connection on a macOS Sierra 10.12 client computer.
1 Click the IP icon in the Add dialog box.
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2 Do one of the following:

• For LPD printing, select Line Printer Daemon  -  LPD from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field, and then type the print connection (print or hold) or published virtual printer name
in the Queue field.

• For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field. The Queue field can be left empty.

• For IPP printing, select Internet Printing Protocol - IPP from the Protocol list and type the Fiery ES IP address
or DNS name in the Address field, and then type ipp/ followed by the print connection (print, hold, direct, or
name of virtual printer) in lowercase letters in the Queue field.

Note: The Fiery ES requires a queue name. If the Queue field is left empty, the default queue is used.
The IP address or DNS name appears in the Name field.

3 Choose Select Software from the Use menu.

4 Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

5 Click Add.

6 Specify the installable option settings in the installable options pane in the Printers & Scanners dialog box, and
then click OK.
The Fiery ES with its IP address appears in the list of printers.
For information about configuring installable options, see printer driver help.

Set up printing on a Mac OS X v10.11 client computer

After you have the Fiery ES printer driver installed, you must set up printing to the Fiery ES on a client computer
running Mac OS X v10.11. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the Fiery ES from the Print dialog box on a Mac OS X v10.11 client computer

1 Open a file in your application.

2 Select File > Print.

3 Select Add Printer from the Printer menu.
In the dialog box that appears, select a printer connection.

Set up the Fiery ES with Printers & Scanners on a Mac OS X v10.11 client computer

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Click the + button to add a printer.

Printing

Mac OS for Fiery ES

35



In the dialog box that appears, select one of the printer connections:

• Default

• IP Printer

Add a printer with the Default connection on a Mac OS X v10.11 client computer

You can add a printer with the Default connection on a Mac OS X v10.11 client computer.
1 Click the Default icon in the Add dialog box.

The names of printers with default connections are listed.
The names of the virtual printers appear as printer name : virtual printer name in the list of printers.
Any published virtual printer is available over LPR and FTP.

Note: SMB printing is not supported for Mac OS X v10.11.

2 Select the Fiery ES from the list.
The information about the selected printer appears at the bottom of the Default pane. The appropriate printer
driver for the Fiery ES is automatically selected.

3 Click Add.
The Fiery ES name appears in the list of printers.

4 Select Fiery ES.

5 Click Options & Supplies, and then click the Options tab.
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6 Specify the installable option settings, and then click OK.
For information about configuring installable options, see printer driver help.

Obtain the IP address of the Fiery ES on a Mac OS X v10.11 client computer

When the Bonjour connection is used for the Fiery ES printer driver on a Mac OS X v10.11 client computer, you can
find out the IP address of the Fiery ES from the printer’s Webpage.

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Select the Fiery ES from the list, and then click Options & Supplies.

3 Click the General tab, and then click Show Printer Webpage.

4 Click the Configure tab.

5 Scroll to Network Protocol Setup, locate the IP address for the Fiery ES, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.
For information about Two-Way Communication, see printer driver help.

6 Click the Close button to exit WebTools.

7 Click OK to close the Options & Supplies pane.

8 Close the Printers & Scanners dialog box.
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Add a printer with the IP Printer connection on a Mac OS X v10.11 client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.11 client computer.
1 Click the IP icon in the Add dialog box.

2 Do one of the following:

• For LPD printing, select Line Printer Daemon  -  LPD from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field, and then type the print connection (print or hold) or published virtual printer name
in the Queue field.

• For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field. The Queue field can be left empty.

• For IPP printing, select Internet Printing Protocol - IPP from the Protocol list and type the Fiery ES IP address
or DNS name in the Address field, and then type ipp/ followed by the print connection (print, hold, direct, or
name of virtual printer) in lowercase letters in the Queue field.

Note: The Fiery ES requires a queue name. If the Queue field is left empty, the default queue is used.
The IP address or DNS name appears in the Name field.

3 Choose Select Software from the Use menu.

4 Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

5 Click Add.

6 Specify the installable option settings in the installable options pane in the Printers & Scanners dialog box, and
then click OK.
The Fiery ES with its IP address appears in the list of printers.
For information about configuring installable options, see printer driver help.
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Set up printing on a Mac OS X v10.10 client computer

After you have the Fiery ES printer driver installed, you must set up printing to the Fiery ES on a client computer
running Mac OS X v10.10. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the Fiery ES from the Print dialog box on a Mac OS X v10.10 client computer

1 Open a file in your application.

2 Select File > Print.

3 Select Add Printer from the Printer menu.
In the dialog box that appears, select a printer connection.

Set up the Fiery ES with Printers & Scanners on a Mac OS X v10.10 client computer

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Click the + button to add a printer.
In the dialog box that appears, select one of the printer connections:

• Default

• IP Printer
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Add a printer with the Default connection on a Mac OS X v10.10 client computer

You can add a printer with the Default connection on a Mac OS X v10.10 client computer.
1 Click the Default icon in the Add dialog box.

The names of printers with default connections are listed.
The names of the virtual printers appear as printer name : virtual printer name in the list of printers.
Any published virtual printer is available over LPR and FTP.

Note: SMB printing is not supported for Mac OS X v10.10.

2 Select the Fiery ES from the list.
The information about the selected printer appears at the bottom of the Default pane. The appropriate printer
driver for the Fiery ES is automatically selected.

3 Click Add.
The Fiery ES name appears in the list of printers.

4 Select Fiery ES.

5 Click Options & Supplies, and then click the Options tab.

6 Specify the installable option settings, and then click OK.
For information about configuring installable options, see printer driver help.
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Obtain the IP address of the Fiery ES on a Mac OS X v10.10 client computer

When the Bonjour connection is used for the Fiery ES printer driver on a Mac OS X v10.10 client computer, you can
find out the IP address of the Fiery ES from the printer’s Webpage.

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Select the Fiery ES from the list, and then click Options & Supplies.

3 Click the General tab, and then click Show Printer Webpage.

4 Click the Configure tab.

5 Scroll to Network Protocol Setup, locate the IP address for the Fiery ES, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.
For information about Two-Way Communication, see printer driver help.

6 Click the Close button to exit WebTools.

7 Click OK to close the Options & Supplies pane.

8 Close the Printers & Scanners dialog box.

Add a printer with the IP Printer connection on a Mac OS X v10.10 client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.10 client computer.
1 Click the IP icon in the Add dialog box.
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2 Do one of the following:

• For LPD printing, select Line Printer Daemon  -  LPD from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field, and then type the print connection (print or hold) or published virtual printer name
in the Queue field.

• For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field. The Queue field can be left empty.

• For IPP printing, select Internet Printing Protocol - IPP from the Protocol list and type the Fiery ES IP address
or DNS name in the Address field, and then type ipp/ followed by the print connection (print, hold, direct, or
name of virtual printer) in lowercase letters in the Queue field.

Note: The Fiery ES requires a queue name. If the Queue field is left empty, the default queue is used.
The IP address or DNS name appears in the Name field.

3 Choose Select Software from the Use menu.

4 Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

5 Click Add.

6 Specify the installable option settings in the installable options pane in the Printers & Scanners dialog box, and
then click OK.
The Fiery ES with its IP address appears in the list of printers.
For information about configuring installable options, see printer driver help.

Set up printing on a Mac OS X v10.9 client computer

After you have the Fiery ES printer driver installed, you must set up printing to the Fiery ES on a client computer
running Mac OS X v10.9. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the Fiery ES from the Print dialog box on a Mac OS X v10.9 client computer

1 Open a file in your application.

2 Select File > Print.

3 Select Add Printer from the Printer menu.
In the dialog box that appears, select a printer connection.

Set up the Fiery ES with Printers & Scanners on a Mac OS X v10.9 client computer

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Click the + button to add a printer.
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In the dialog box that appears, select one of the printer connections:

• Default

• IP Printer

Add a printer with the Default connection on a Mac OS X v10.9 client computer

You can add a printer with the Default connection on a Mac OS X v10.9 client computer.
1 Click the Default icon in the Add dialog box.

The names of printers with default connections are listed.
The names of the virtual printers appear as printer name : virtual printer name in the list of printers.
Any published virtual printer is available over LPR and FTP.

Note: SMB printing is not supported for Mac OS X v10.9.

2 Select the Fiery ES from the list.
The information about the selected printer appears at the bottom of the Default pane. The appropriate printer
driver for the Fiery ES is automatically selected.

3 Click Add.
The Fiery ES name appears in the list of printers.

4 Select Fiery ES.

5 Click Options & Supplies, and then click the Options tab.
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6 Specify the installable option settings, and then click OK.
For information about configuring installable options, see printer driver help.

Obtain the IP address of the Fiery ES on a Mac OS X v10.9 client computer

When the Bonjour connection is used for the Fiery ES printer driver on a Mac OS X v10.9 client computer, you can
find out the IP address of the Fiery ES from the printer’s Webpage.

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Select the Fiery ES from the list, and then click Options & Supplies.

3 Click the General tab, and then click Show Printer Webpage.

4 Click the Configure tab.

5 Scroll to Network Protocol Setup, locate the IP address for the Fiery ES, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.
For information about Two-Way Communication, see printer driver help.

6 Click File > Close Window to close WebTools.

7 Click OK to close the Options & Supplies pane.

8 Close the Printers & Scanners dialog box.
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Add a printer with the IP Printer connection on a Mac OS X v10.9 client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.9 client computer.
1 Click the IP icon in the Add dialog box.

2 Do one of the following:

• For LPD printing, select Line Printer Daemon  -  LPD from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field, and then type the print connection (print or hold) or published virtual printer name
in the Queue field.

• For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field. The Queue field can be left empty.

• For IPP printing, select Internet Printing Protocol - IPP from the Protocol list and type the Fiery ES IP address
or DNS name in the Address field, and then type ipp/ followed by the print connection (print, hold, direct, or
name of virtual printer) in lowercase letters in the Queue field.

Note: The Fiery ES requires a queue name. If the Queue field is left empty, the default queue is used.
The IP address or DNS name appears in the Name field.

3 Choose Select Software from the Use menu.

4 Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

5 Click Add.

6 Specify the installable option settings in the installable options pane in the Printers & Scanners dialog box, and
then click OK.
The Fiery ES with its IP address appears in the list of printers.
For information about configuring installable options, see printer driver help.
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Configuring installable options on Mac OS client computers

To use the print options for the printer and Fiery ES appropriately, you must configure the Fiery ES from your
computer for the options that are installed on the printer. Configure the options manually.
For information about configuring installable options, see printer driver help.

Using Desktop Printer

After adding the Fiery ES to the list of printers in the Printers & Scanners (or Print & Scan) dialog box, you can create
and use the Desktop Printer feature.
For information about the Desktop Printer feature, see printer driver help.

Printing from Mac OS client computers

You can print to the Fiery ES just as you would print to any other printer from a Mac OS application.
Select the Fiery ES as the default printer in the list of printers, specify print options, and then print the document
from the application.
The following list includes other methods to print to the Fiery ES and describes where to find information about
these features:

• Downloading files to the Fiery ES with the Docs tab in WebTools. (See Utilities.)

• Printing documents with Fiery Hot Folders. (See Fiery Hot Folders Help or Utilities.)

• Printing documents with Command WorkStation. (See Command WorkStation Help.)

• Achieving optimal printing results from applications. (See Color Printing and Fiery Color Reference.)

• Selecting the Fiery ES in the Printers list. (See Select the Fiery ES as the default printer on a Mac OS client
computer on page 46.)

• Printing jobs from Mac OS applications. (See Set print options and printing from Mac OS applications on page
47.)

• Customizing the Quick Access view. (See Customize the Quick Access pane in the Mac OS printer driver on page
49.)

• Viewing the printer status. (See View the printer status on page 50.)

• Printing custom page sizes. (See Defining and printing custom page sizes on page 98.)

Select the Fiery ES as the default printer on a Mac OS client computer

Before you print a job, you must set the Fiery ES in the Printers list as your default printer.
1 Make sure that the Fiery ES is connected to the network and turned on.
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2 Select Apple menu > System Preferences, and then select Printers & Scanners (or Print & Scan).
The printers that are set up for printing are listed. The virtual printers that are configured at the Fiery ES and set
up for printing are also listed.

3 Select Fiery ES from the Default Printer menu.

4 Close the window.

View queries in the Print Queue on client computers

When the printer driver establishes communication with the Fiery ES on a Mac OS client computer, the queries are
listed as jobs in the Print Queue.
To view the queries, open the Print Queue.

• Select Apple menu > System Preferences > Print & Scanners (or Print & Scan), then select the Fiery ES from the
list of printers, and click Open Print Queue.
The queries are not real jobs and they will disappear from the Print Queue after they are completed.

Set print options and printing from Mac OS applications

To print from Mac OS client computers, install the printer driver that corresponds to your printer.
In Mac OS applications, print options are set from the Print dialog box. (See Installing printer driver on a Mac OS
computer on page 29.)
Some print options that are selectable from an application are similar to print options that are specific to the Fiery
ES and the printer. In these cases, use the print options specific to the Fiery ES and the printer. These options appear
in the Fiery Features pane and/or in the Printing Preferences window. The application may not set up the file
properly for printing on the Fiery ES, resulting in unexpected finishing, printing errors, or longer processing time.
If you specify incompatible print settings when printing a document, the Conflict dialog box provides instructions to
resolve the conflict.
Some print options are available only if Two-Way Communication is turned on or a particular installable option is
configured.
You can retrieve its expert color settings from the Fiery ES when Two-Way Communication is turned on and display
them in the printer driver.
For information about Two-Way Communication, see printer driver help. (See Configuring installable options on
Mac OS client computers on page 46.)
If you select Printer’s default, the job prints according to the settings that the administrator specified in Setup. (See 
Set print options and print a job from a Mac OS client computer on page 47.)

Set print options and print a job from a Mac OS client computer

You use the printer driver to specify print options for a particular job and then print it to the Fiery ES.
1 In your application, select File > Print, and select the Fiery ES as your printer.
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2 Select Fiery Features from the drop-down list.

1 Fiery Features

2 Customize (Shortcuts), see Help

3 Full Properties

4 Presets (Job Templates), see Help

5 Two-Way Communication

When you save the print options in a preset, the following option settings are not reflected:

• Job Info options: Job notes > Secure print, User authentication > Password, Account track > Department name,
Account track > Account password, Server authentication > Authentication server name, Project code, and
Project password

• Layout option: Impose

For information about using presets, see printer driver help.
For a list of print options, see Print options and default settings on page 63.

3 Click Full Properties in the Quick Access pane to specify print options and settings for your job.
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The print options are grouped by categories. Each group or tab contains print options that are similar or
complement one another.

• Quick Access- Contains duplicate print options from the other job properties groups. It is customizable, so any
job override print option can be added or removed from the view. The Quick Access pane lets you find print
options quickly without browsing through all of the Job Properties tabs. (See Customize the Quick Access icon
in the Windows printer driver on page 27.)

• Job Info- All information about the job, including user information that may be required for user
authentication and job handling. (See Job Info options on page 63.)

• Media- Attributes and sources of paper to print and insert. (See Media options on page 68.)

• Layout- Layout defines the imposition of the print job and the booklet process on the media/sheet, except for
positioning that compensates for finishing options, for example, Tray Alignment. (See Layout options on page
70.)

• Color- Color settings and additional features (when optional color features are turned on). (See Color options
on page 77.)

• Image- All Image Quality settings supported by the connected Fiery ES and printer. (See Image options on
page 84.)

• Finishing- Print options related only to finishing equipment on the printer, and also image shifting to
compensate for finishing options. These options override settings in Fiery ES Printer Setup but can be changed
from Command WorkStation. (See Finishing options on page 86.)

• VDP- All Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP settings. (See Finishing
options on page 86.)

• Stamping- All image stamping options that add or hide/remove any image on the job. This also includes
watermark properties that define the placement and style of the watermark. (See Stamping (Watermark)
options on page 89 or printer driver help.)

• Printer- Information about printer status that includes the current paper and toner levels. (See View the printer
status on page 50 or printer driver help.)

4 After you specify the print settings, click OK, and then click Print to send your print job.

Note: When you use the Enable job tracking print option, a window is displayed for your job accounting
information.

Customize the Quick Access pane in the Mac OS printer driver

The Quick Access pane can be customized with print options that you use frequently.
This saves time because you do not have to open all of the other print option icons to set the options that you placed
in Quick Access.
When you place a print option in Quick Access, it still appears under its original print option icon. You can set the
option from either location.

1 In your application, select File > Print and select the Fiery ES as your printer.

2 Select Fiery Features from the drop-down list.

3 Click Customize to specify the options shown in the Quick Access pane.
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4 Add or remove a shortcut by selecting one and moving it from the Available Shortcuts list to/from the Current
Shortcuts list.

5 Click OK to save your changes.
For more information about Quick Access, see printer driver help.

View the printer status

You can retrieve the status and levels of consumable materials of the printer from the Fiery ES and display them in
the printer driver with the Two-Way Communication option.
You can retrieve its color settings from the Fiery ES and display them in the printer driver.
For information about monitoring the status of the printer, see printer driver help.
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Other Printing Methods

You can print jobs with the Fiery ES printer driver to the Fiery ES, as well as other printing methods, such as
Command WorkStation.

E-mail Service

E-mail Service allows you to control the Fiery ES using your current email infrastructure, print to remote locations,
and bypass firewalls.
E-mail Service is not application-specific. You can use any email infrastructure.
The Fiery ES supports internal address books. Administrators can retrieve, add, delete, and clear addresses from
address books by sending requests through email. (See Configuration and Setup.)
To set up E-mail Service, see Configure Help.
Use E-mail Service in the following ways:

• Print a job from an email application.
To print with an email client, you send a file as an email attachment. E-mail Service extracts the file and sends it
to the Fiery ES. The attachment can be in any file format the Fiery ES recognizes (PS, PDF, EPS, VDP, or TIFF).

Note: E-mail Service does not process files with .vbs, .exe, or .bat extensions.

• Manage jobs using an email application.
You can manage your print jobs by submitting email commands to the Fiery ES using email.

Printing using an email client

You can submit print jobs to the Fiery ES in the form of an email attachment using your email application.
When you send an email with an attachment, E-mail Service extracts the file and sends it to the Fiery ES Print queue.
The file format must be one supported by the Fiery ES.
By default, anyone can print with an email client, unless the Print address book has been set up by the administrator.
If the Print address book has been set up and your email address is not in it, you cannot send files to the Fiery ES
using email. (See Configuration and Setup.)
When User Authentication is turned on at the Fiery ES, the email attachment must have the appropriate user name
and password when it is printed through email printing. As part of creating the email attachment with the Fiery ES
printer driver, type the appropriate user name and password on the Job Info tab of the printer driver. The user name
and password must match those defined by the administrator in the Users and Groups section of Configure. For
information about Users and Groups, see Command WorkStation Help.

Note: The Direct connection is not supported by the email client feature.
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When the attached job is printed, the email is also printed, which includes the typical header information, such as
subject, date, sender, and so forth.

Print an email attachment with an email client

You can print an email attachment with an email client.
1 Open your email application.

2 Type the Fiery ES email address in the To: line.

3 Type text in the Subject line or leave the Subject line blank.

4 Attach the file that you want to print.
The attachment can be in any file format the Fiery ES recognizes (PS, PDF, EPS, VDP, or TIFF).

Note: If your attachment exceeds the file size limitation set by your email administrator, the email is not sent.

5 To identify the job or provide further processing instructions, type text in the body of the message.

Note: HTML-formatted email messages are not supported, and might not print as they appear on the remote
workstation. Send email messages in plain text format.
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6 Send the email.
The file is sent to the Fiery ES and the job is printed. After the Fiery ES receives the job, you receive an email
notification that the print job was accepted. The email provides a job identification (ID). Use job IDs to manage
jobs with email commands. The email notification indicates any current error at the printer. (See Manage print
jobs with email commands on page 53.)
After the job is printed, you receive a second email notification that indicates the job printed successfully.

Manage print jobs with email commands

You can manage your print jobs by submitting commands to the Fiery ES using email.
You can cancel a job, check job status, and get help on a job. When you send a command, the Fiery ES sends an email
response.

1 In your email application, type the Fiery ES email address in the To: line.

2 Type one of the following commands in the Subject line:

• To check the status of a job, type #JobStatus<job id> in the Subject line.
You receive a reply to your job status query. You can only get the status of the job if you sent the job or are an
administrator.

• To cancel a job, type #CancelJob<job id> in the Subject line.
You receive a notification indicating that the job has been canceled and did not print to the Fiery ES. You can
only cancel a job if you sent the job.

• To get help, type #Help in the Subject line.
You receive an email response that contains links that allow you to cancel jobs, check job status, and search
and manage address books. Click any of the links to perform a command.

3 Send the email to the Fiery ES.

Printing from a USB flash drive

You can print files from a USB flash drive to the Fiery ES. The Fiery ES supports printing from the USB flash drive
using USB Media Server.
The USB port and automatic printing feature must be enabled in Configure, as described in Configuration and Setup
or Command WorkStation Help.
You can manually print files from a USB flash drive when USB Media Autoprint is disabled in Configure.
Files are automatically processed as soon as you connect the USB flash drive to the Fiery ES. The files can be from
Mac OS or Windows computers, and can be any of the supported file types (DOC, EPS, PCL, PDF, PPT, PS, TIFF, or
XLS).

Note: The Enable Native Document Conversion Using PrintMe option in Configure must be turned on to print DOC,
PPT, and XLS files.
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You can set up folders in the root of the flash drive to correspond to the Fiery ES queues:

• To send files to one of the standard print queues (print, hold, or direct) on the Fiery ES, create folders with those
names in the root of the flash drive, and then drop the files into the folders.

• To print any file from the USB flash drive, manually select the file to print, specify where to send it, and select
print options.

• Files in folders with Fiery ES queue names at the root level of the USB flash drive are copied automatically to the
corresponding Fiery ES queue.

• To send files to a virtual printer that is configured on the Fiery ES, create a folder with the virtual printer name in
the root of the flash drive, and then drop the files into the folder. Verify with your administrator that the virtual
printers are published. For more information about virtual printers, see Command WorkStation Help.

Note: If you have more than 50 published virtual printers, you cannot print from a USB flash drive to a virtual
printer.

Print files automatically from a USB flash drive

You can print files automatically from a USB flash drive only if automatic printing is turned on in Configure.

1 Ensure the USB port and automatic printing are enabled, as described in Configuration and Setup or Command
WorkStation Help.

2 Create folders at the top (root) level of the USB flash drive named print, hold, direct, and the name of any virtual
printer that has been configured and published on the Fiery ES.

3 Save the files (DOC, EPS, PCL, PDF, PPT, PS, TIFF, or XLS) from either the Mac OS or Windows computer to
the USB flash drive, placing the files in the folders that correspond to the action that you want to take.

4 Connect the USB flash drive to the USB port on the Fiery ES.
The files are automatically printed or held according to the folder they are in.
For the location of the USB port, see Configuration and Setup.

5 After the files have arrived in the related queue, remove the USB flash drive from the Fiery ES.

Important: Make sure that the USB flash drive is properly stopped before you disconnect it from the Fiery
ES.

Print files manually from a USB flash drive

You can select files to print from a USB flash drive connected to the Fiery ES.

When USB Media Autoprint is disabled in Configure, you must manually select the files that you want to print from
the USB flash drive and specify where you want to send them

1 Ensure the USB port is enabled, as described in Configuration and Setup or Command WorkStation Help.

2 Insert the USB flash drive into a USB port on the Fiery ES.

3 On the printer control panel, press the Menu button.
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4 Press Fiery.

5 Press the USB Media Server tab.
All the printable files (DOC, EPS, PCL, PDF, PPT, PS, TIFF, or XLS) on the USB flash drive are shown.

6 Navigate to the file that you want to print and select it.
To open a folder, select the folder from the list then press Browse Directory.
To return to a higher-level folder, press Upper Folder.

7 Select a file by pressing on the file name.

8 Specify print options for the file.

• Copies (Default is 1)

• Queue (Hold, Print, Direct, or any published virtual printer set up for the Fiery ES)

• Duplex, Tumble, or One Side

• Page Size (Default, list of available page sizes)

9 Press Print to send the file to the Fiery ES for printing or Cancel to cancel the print request.

10 Remove the USB flash drive from the Fiery ES.

Print and retrieve a secure print job

The Secure Print feature offers a level of security for confidential or sensitive print jobs, which print only when you
are present at the printer control panel.
To use this feature, you first enter an arbitrary password into the Secure print field in the printer driver when you
send your job to the Fiery ES. Then, to print your job, you re-enter the password at the printer control panel.

Send a secure print job

1 In your application, do one of the following:

• On Windows computers: Select File > Print, select the Fiery ES as your printer, click Properties, and then click
the Job Info icon.

• On Mac OS X computers: Select File > Print, select the Fiery ES as your printer, select Fiery Features from the
drop-down list, click Full Properties in the Quick Access pane, and then click the Job Info icon in the Printing
Preferences dialog box.

2 Type an arbitrary password in the Secure print field.

Note: The password requires at least 1 character and can be up to 31 characters long. It is limited to
alphanumeric characters and "-", "_", and "." symbols only.
For more information about typing the password, see Job Info options on page 63.
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3 Make any other required changes to Job Properties.

4 Click OK to close the Fiery ES Properties dialog box.

5 Click OK or Print to close the Print dialog box and send your job to the Fiery ES.
The job is sent to the printer.

Print a secure print job from the printer

1 On the printer control panel, press the Menu button.

2 Press Fiery.

3 Press Secure Jobs.

4 Tap the Secure Code field, use the keyboard to type the same password that you typed in the Secure print field of
the printer driver, and then press OK.
The print jobs that match the password are displayed in the Secure Print screen.

5 Press Show Files.

6 Select your print job or press Print All to print all secure jobs listed.

7 Specify the number of copies to print and then press Print or Delete.

FTP printing

You can send jobs to the Fiery ES using FTP printing if the Fiery ES is set up as an FTP server with FTP Services
configured on it.
For more information about configuring FTP Services, see Command WorkStation Help.
You can use any FTP client application. Before you use FTP printing, the FTP client application requires the
following information (see your administrator):

• IP address or DNS name for the Fiery ES

• Directory or path to send the job to, such as the Print queue, Hold queue, or published virtual printers (if
supported)

Note: You cannot print to the Direct connection with FTP printing.

• User name and password (if required)

You can send the following files to the Fiery ES:

• PostScript (PS)

• Printer Control Language (PCL)

• Tagged Image File Format (TIFF)

• Portable Document Format (PDF)
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Note: Encapsulated PostScript (EPS) files are not supported for FTP printing.

Print files to the Fiery ES with the FTP protocol

You can use the FTP protocol to print files to the Fiery ES.
1 Connect to the Fiery ES with your FTP client application.

Folders corresponding to the Print queue, Hold queue, and any published virtual printers are displayed.

2 Navigate to the folder representing the print connection or published virtual printer.

3 Upload your job to the appropriate folder.
After the job is printed, it is deleted from the Fiery ES.

Direct Mobile Printing

Direct Mobile Printing allows direct printing to the Fiery ES from mobile devices, such as iPad, iPhone, and iPod
touch.
The Fiery ES must have certain networking options turned on in Setup. After Setup is complete, the Fiery ES appears
in the list of available printers on the mobile device.
In addition, observe the following configuration requirements:

• Make sure that the Fiery ES is connected to a wireless access point on the network.

• Make sure that supported mobile devices are connected to the same wireless network as the Fiery ES. The
Printer Default Paper Size is used for all Direct Mobile Printing jobs.

For information about configuring the settings in Setup on the Fiery ES, see Configuration and Setup.
For a list of supported mobile devices, see Configuration and Setup.

Print from a mobile device

You can print files from your mobile device to the Fiery ES.
1 On the mobile device, select the job, and then open the Print window.

For more information, see the documentation that accompanies your device.

2 Select Fiery ES in the list of available printers.

3 Specify print settings, and click Print.
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PrintMe cloud printing

Users with a PrintMe subscription can upload a document to the PrintMe Cloud Service and then print the
document to the printer using the printer control panel.
Before you print:

• Make sure that the Fiery ES has an Internet connection and is connected to the network.

• Turn on PrintMe and related settings on the Fiery ES using Configure.
For information about configuring the settings in Setup on the Fiery ES, see Configuration and Setup.

• Upload the document to PrintMe, either at http://www.printme.com or send by email to print@printme.com.
For more information about using PrintMe, see EFI PrintMe Cloud Service.

• Print directly from a Windows application. To do this, you must first install the PrintMe printer driver. See 
Install the PrintMe printer driver on page 59.

• When you upload or email a document to PrintMe, you receive an email confirmation that contains a unique
document ID. You need this document ID to print, as described in the following procedures.

• Make sure that the printer is not printing or processing any files.

• PrintMe supports the following file types: PDF, XLS, DOC, PPT, GIF, JPG, TIFF, PICT, HTML, TXT, and PS.
The maximum file size is 25MB.

Note: The Enable Native Document Conversion Using PrintMe option in Configure must be turned on to print
DOC, PPT, and XLS files.

In particular, observe the following:

• The PrintMe feature on the Fiery ES requires a subscription to the PrintMe Cloud Service.

• For information or support related to the PrintMe Cloud Service, contact Electronics For Imaging at
printmesupport@efi.com.

• PrintMe availability may vary, depending on the country or region.

Print a PrintMe document from a printer

You can print an uploaded document from the PrintMe Cloud Service to the printer.

1 On the printer control panel, press the Menu button.

2 Press Fiery.

3 Press PrintMe.

4 Type the Document ID and press Next.
Refer to the email confirmation for Document ID.
Jobs associated with the Document ID are displayed.
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5 Select a job to print and then select the print settings:

• Copies (number of copies)

• Duplex, Tumble, or One Side

• Color or B/W (black and white)

6 Press Print to print the job.

7 Press Delete to permanently remove all documents associated with the Document ID from PrintMe.

Install the PrintMe printer driver

You can print to the PrintMe cloud service just as you would print to any desktop printer with the PrintMe printer
driver.

Note: The PrintMe printer driver is supported on client Windows computers that operate in a non-proxy network
environment.

Install the PrintMe printer driver on a Windows client

You can install the PrintMe printer driver on a Windows client.
1 Go to http://www.printme.com/home/index.html and click Downloads from the PrintMe toolbar.

2 Under Desktops and Laptops, click Download for Windows to download the PrintMe printer driver.

3 Click EFI PrintMe Driver.exe, click Run, and follow the on-screen instructions.
If prompted, restart the computer.

4 To verify that the driver is set up correctly, click the Start button on the taskbar in Windows and select Devices
and Printers (or Printers and Faxes or Printers).
The EFI PrintMe printer should be listed. If it is not, reinstall the printer driver.
After the PrintMe printer driver is installed, you can print to the PrintMe cloud service from most Windows
applications.

Note: To uninstall the PrintMe printer driver, open the Devices and Printers (or Printers and Faxes) folder or the
Programs and Features tool in the Windows Control Panel and remove the EFI PrintMe Driver.

Print documents from Windows applications

You can print documents with the PrintMe printer driver.
1 In the Windows application, click File > Print.

2 Select EFI PrintMe from the printer pull-down menu.
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3 Type your email address and click OK.

An email message containing the Document ID is sent to your email address.

Print with Fiery JDF

Fiery JDF allows submission of JDF jobs to a Fiery ES from applications that allow creation of JDF tickets.
Use Configure to specify JDF settings and to view the Fiery JDF version, the JDF Device ID, and the JMF URL. For
more information, see Command WorkStation Help.
This option is available as part of Fiery Productivity Package. For more information, see Fiery Productivity Package.

1 From Configure, choose Job Submission > JDF Settings.

2 Select Enable JDF.

3 If a virtual printer is configured for the Fiery ES, select one from the Use Job Settings from Virtual Printer option.

Note: Specify this option only if it applies to your specific workflow.

4 Specify a default print queue from Job Action.

5 Select Override JDF job with the above settings, if you want to override the settings specified in the JDF ticket.

6 Specify how you want the JDF jobs closed once they are printed.

7 Specify the items required for closing a JDF job. The items you select here must be filled out before the job can
close automatically or manually.

8 Specify the network paths where the Fiery ES searches for common resources.

9 Click Save.
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Web Services for Devices printing

Web Services for Devices (WSD) allows printing from Windows 7 and later computers, and Windows 8 or later
based tablets.
The WSD option on the Fiery ES must be turned on in Setup. After Setup is complete, you can install the WSD
printer driver for the Fiery ES.
For information about configuring the settings in Setup on the Fiery ES, see Configuration and Setup.

Install the WSD printer driver

You can install the WSD printer driver on Windows 7 and later computers, and Windows 8 or later based tablets.
1 Download the printer driver with WebTools.

For instructions on downloading the printer driver with WebTools, see Download printer drivers with WebTools
on page 11.

2 In the Fiery Driver Installer dialog box, select the printer driver language and click Next.

3 Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.

4 Read the license agreement, click I accept the terms of the license agreement and click Next.

5 Select Add a network, wireless or Bluetooth printer.

6 Select the printer from the list of available printers and proceed to step 10.

Note: The WSD printer shows the Fiery ES with the printer in parentheses for the name of the printer.
If the printer is not listed, proceed to step 7.

7 Click The printer that I want isn’t listed.

8 Click Add a printer using TCP/IP address or host name and click Next.

9 Select Web Services Device for Device type, type the IP address of the Fiery ES, and click Next.
Connection to the printer is initiated and the printer driver is installed.

10 Click Next and follow the on-screen instructions.
Do not share the printer and do not print a Test Page at this time.
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Print Options

Print Options describes the Fiery ES printer driver, available print options, and where to set print options to print
your jobs successfully.

About the Fiery ES printer driver

Windows and Mac OS computers communicate with the Fiery ES by means of a printer driver and a PostScript
Printer Description (PPD) file. A PPD file contains information about the features and capabilities of a particular
printer (for example, what paper sizes and media types are supported) and the Fiery ES.
A printer driver manages printing communication between your application and the printer. It interprets the
instructions generated by the application, merges those instructions with printer-specific options you set, and then
translates all information into Adobe PostScript, a language the printer understands. In other words, the printer
driver writes a PostScript file based on your original file and the options you set from the Print dialog box.
The Fiery ES receives files from computers on the network, processes the files, and then sends them to the printer.
For information about the specific print options for the Fiery ES, see Print options and default settings on page 63.

Set print options for the job

Print options give you access to the special features of your printer and the Fiery ES.
You can specify print options in these areas:

• Setup
Some settings are specified during the initial Fiery ES configuration by the administrator. For information about
the current default server settings, contact the administrator or operator.

• Applications
With the printer drivers provided, you can specify job settings when you print a job.

• Color Setup
You can set the default CMYK Source, CMYK rendering intent, Separate RGB/Lab to CMYK source, RGB Source,
RGB rendering intent, Spot color matching, Gray source, Gray rendering intent, Black text and graphics, Black
overprint (for pure black) and Output profile settings. (See Color Printing.)
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• Fiery Hot Folders
You can assign a group of print options to a Hot Folder. When you specify print options for a Hot Folder, the
print options are assigned to all jobs sent through that Hot Folder. These print options override any default
options.
For information, see Fiery Hot Folders Help.

• Overrides in the Job Properties window of Command WorkStation
To change job settings from Command WorkStation, double-click a job to display the Job Properties window.
For more information, see Command WorkStation Help.

Print option override hierarchy

Print option settings that were specified in the printer driver can be overridden either in the Held, Printed or
Archived queue of Command WorkStation.

Note: You can use inline editing in the Job Summary pane as another way to override job properties.
The override hierarchy is as follows:

• Settings from the user’s printer driver override the Fiery ES Setup settings.

• Settings assigned to Fiery Hot Folders override the user’s printer driver settings.

• Settings made from the job management tools (Job Properties window of Command WorkStation) override the
user’s printer driver settings.

Print options and default settings

You can use the printer driver interface to configure a particular print option to print a job. If you choose not to
configure the print option, the Fiery ES prints the job with the default setting.
For the default settings of the Fiery ES, as set in the Default settings window (Server > Set Defaults in Command
WorkStation), choosing Default results in the Fiery ES printing the job with the current server defaults or previously
saved settings.
For options that cannot be configured in Setup, the Fiery ES prints the job with a preconfigured Factory Default
setting. When you select the printer driver for North America, the default Document size is Letter or for
International, the default Document size is A4.
To determine the current Setup defaults, print the Configuration page from Command WorkStation. (See Command
WorkStation Help.)

Note: A job uses the Fiery ES default settings (unless otherwise specified) at the time it is processed for printing, not
at the time it is sent to the Fiery ES Hold queue.
The print options are organized according to the printer driver icons (tabs).

Job Info options

The Job Info tab shows all information about the job, including user information that may be required for user
authentication and job handling.
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Copies

The maximum number of copies is 9999.
The maximum number of jobs in the Printing queue and Archived queue is 9999.

Note: The Copies print option is grayed out and cannot be changed from the Printing Preferences dialog box when
Full Properties is clicked in the Mac OS printer driver. You can specify the number of copies in the application or
Mac OS Print dialog box.

Print Range

The Print Range print option allows you to specify the page range or odd/even pages to print.
For variable data printing jobs, a range of Records is selected for printing. For imposed variable data printing jobs, a
range of Records and Sheets is printed.
For imposed jobs, a range of Sheets is printed.

Note: If you print a page range within a duplex job and the specified range begins on an even-numbered page, the
page range that is actually printed begins on the page before the specified range. The system automatically changes
the page range to preserve the duplex job pagination.
This option is only accessible from the Job Properties window in Command WorkStation.

Accounting: Enable job tracking

The Enable job tracking print option, when selected, turns on job tracking.
To display the job notes and instructions at print time for the job, select Allow entry of account information.
To use the last job account information for the print job, select Show last entered account information.
To save the last entered job account information in the job notes, select Use last entered account information.
This option is not available from the Job Properties window of Command WorkStation.

Account track

Select the Account track check box to assign the Department name and Account password for a print job.

Note: To use this option, you must configure it on the printer.

Account track: Department name

Specify an account identification value for the Department name (up to 8 alphanumeric characters).

Note: To use this option, you must configure Account track on the printer.
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Account track: Account password

Specify the Account password for a job (up to 64 alphanumeric characters).

Note: To use this option, you must configure Account track on the printer.

Destination: Box number

Specify a Box number when using the Copier stored print option.
The Fiery ES sends the print job to the hard disk drive on the printer specified by the Box number.
The Box number is available from 1 to 999999999.

Note: If you specify the reserved number as 0, the printer cancels the job.
For more information, see the documentation that accompanies your printer.

Destination: Copier stored print

The Copier stored print option allows you to store a print job on the hard disk drive of the printer.
Do one of the following:

• Select Off to send the image data as a normal print job.

• Select HDD stored to store the print job on the hard disk drive of the printer.

• Select HDD stored and print to store the print job on the hard disk drive of the printer and to print the job.

The hard disk drive (HDD) must be installed in the printer to select one of the HDD options.
For more information, see the documentation that accompanies your printer.

Job notes: Instructions

The Instructions print option allows you to specify instructions for the operator about the job.
This field accepts alphanumeric and special characters but does have a maximum limit.

Job notes: Notes 1/Notes 2

The Notes print option allows you to specify information about the job.
This field accepts alphanumeric and special characters but does have a maximum limit.

Note: If you enter < or = as the first character, the characters may not be printed in the Job Log, or the application in
use may shut down.

Job notes: Secure print

The Secure print print option should be used to print sensitive or confidential documents.
Specify an arbitrary password and re-enter it when you are present at the printer.
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Print queue action

Select the job action associated with a published queue.
Select Print to send the file directly to printing.
Select Print and hold to save the raster file after printing.
Select Process and hold to process, but not print a job.
Select Hold to spool the job until the operator takes further action. Held jobs can exist in a preprocessed or
processed state.
Select Print and delete to queue a job to be processed, printed, and then deleted. This action ensures that the printed
job is not saved to the Printed list, which is often required for secure printing.

Note: This option is invalid if your job is sent to the Direct connection.

Proof print

Select the Proof print check box to print a single copy of a job(s) to verify output.
When Proof print is selected, it stores a print job and prints only one copy. The remaining copies print after you
enter information from the printer control panel.
This function is available only when you print multiple-copies.
To print the document, release the held document from the printer control panel.
For information, see the documentation that accompanies your printer.

Reporting: Control Bar

The Control Bar feature allows you to add a static color bar and dynamic job information to each printed page at a
user-defined location.
The available settings are:

• Off does not print a control bar for the job.

• Fiery is the default control bar that provides a color bar and dynamic job information for the job.

If you require your own control bar, you can create one by defining custom values in Control Bar under Color Setup
in Device Center of Command WorkStation.
This option is available as part of Fiery Productivity Package. For more information, see Fiery Productivity Package.
Printer’s default reflects the setting specified in Color Setup in Command WorkStation.

Reporting: Postflight

The Postflight print option is a diagnostic tool that allows you to analyze how data is processed by the Fiery ES. You
can choose to print an analytical report for a job.
This option is available as part of the Fiery Productivity Package. For more information, see Fiery Productivity
Package.
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Server authentication: Authentication server name

Specify the Authentication server name for the User Authentication Server (up to 32 byte characters).

Note: To use this option, you must configure User Authentication Server on the printer.
For more information, see the documentation that accompanies your printer.

Server authentication: Project code

Specify the Project code for the User Authentication Server (up to 32 alphanumeric characters).

Server authentication: Project password

Specify the Project password for the User Authentication Server (up to 64 alphanumeric characters).

User authentication: I’m a Guest

The I'm a Guest print option, when selected, allows guest printing.
Guest printing must be turned on at the Fiery ES.
In Command WorkStation, the management of jobs is determined by how you log on to the Fiery ES.
When the printer is accessible to public users (unregistered users), selecting this option enables you to execute
printing without entering the user name and password.
For more information about the user authentication feature on the printer, see the documentation that accompanies
your printer.

User authentication: Password

If user authentication is configured on the Fiery ES, specify your user Password to print a job. Type your local
password or domain password for user authentication.
If user authentication is configured on the printer, type your local password or domain password to print a job. For
more information about the user authentication feature on the printer, see the documentation that accompanies
your printer.

User authentication: User name

If user authentication is configured on the Fiery ES, specify your User name to print a job. Type your user name or
domain\user name for user authentication.
If user authentication is configured on the printer, type your user name or domain\user name to print a job. For
more information about the user authentication feature on the printer, see the documentation that accompanies
your printer.
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User authentication: Use Windows Login

If you are logged on to your Windows computer, select Use Windows Login for user authentication. This option
appears when you log on to your domain on your Windows computer.
For more information, see Configuration and Setup.

Media options

The Media tab shows attributes and sources of paper to print and insert.

Document size

The Document size print option is the page size defined in your application’s Print setup (or Page setup) dialog box.
When printing one document page per sheet of paper, document size is usually the same as output paper size.
However, document size may differ when printing booklets or imposing multiple document pages on a single sheet.
Document size may also differ from output paper size when you use the Scale or Scale to fit options, in which case
the document page size is scaled at a given percent to fit a certain paper size.
To assign document size, do one of the following:

• Select the size from the available list.

• Click Custom to select a non-standard paper size.

Note: The Document size option is grayed out and cannot be changed from the Mac OS printer driver. You can
specify the document size with the Paper size option from the Mac OS printer driver.

Cover options: Back cover

Specify a back cover to print at the end of the print job.
Do one of the following:

• Specify None to print the job without a back cover.

• Specify Blank to print a blank back cover.

• Specify Printed to print on the back cover.

When creating a Saddle Stitch booklet, use the Booklet Maker Define Cover option.

Cover options: Back cover tray

Specify the paper tray to use for the back cover.
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Cover options: Front cover

Specify a front cover to print at the beginning of the print job.
Do one of the following:

• Specify None to print the job without a front cover.

• Specify Blank to print a blank front cover.

• Specify Printed to print on the front cover.

When creating a Saddle Stitch booklet, use the Booklet Maker Define Cover option.

Cover options: Front cover tray

Specify the paper tray to use for the front cover.

Cover options: PI back cover tray

Specify the PI (Post Inserter) back cover tray for the print job.

Cover options: PI front cover tray

Specify the PI (Post Inserter) front cover tray for the print job.

Output paper size

Output paper size defines the size of the sheet of paper on which your job prints. It is the size of the physical sheet of
paper in the printer tray.
To assign paper size, do one of the following:

• Select the size from the available list.

• Click Custom to select a non-standard paper size.

• Select Same as document size to print one document page per sheet of paper.

Paper tray

Use the Paper tray print option to specify the paper tray that contains the paper to use for your print job.
Paper tray allows you to select a specific tray for your job. If you select the Auto tray select setting, the printer prints
from any tray containing the paper size necessary for the job. This setting also allows the printer to automatically
switch between trays, if the current tray becomes empty, while continuing to print.
If you turn on the Tray alignment print option, then Paper tray cannot be set to Auto tray select.
For information about setting your choice of media in one of the trays, see the documentation that accompanies the
printer.
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Paper type

The Paper type print option is used to specify the type of paper used for your print job.
For information about media types and paper specifications, see the documentation that accompanies the printer.

Slip sheets: Transparency interleaving

The Transparency interleaving print option allows you to print multiple transparency sheets separated by slip sheets.
Select Off to not print transparency sheets.
Select On to print multiple transparency sheets separated by blank, plain paper pages.

Note: This option is supported with Letter or A4 size plain paper or transparencies only.

Slip sheets: Interleave tray

Select an input tray for transparency interleaving.

Tray alignment

The Tray alignment print option should be selected when you need to adjust the image on the page to achieve
alignment on both sides of a page when printing duplex.
For more information, see Command WorkStation Help.

Mixed media

The Mixed media print option allows you to specify different media types, paper sizes, and paper source to use
within a print job.
For more information, see printer driver help.
For information about accessing and using Mixed media, see Command WorkStation Help. Features specific to the
Fiery ES are described in Utilities.

Layout options

The Layout tab defines the imposition of the print job and the booklet process on the media/sheet, except for
positioning that compensates for finishing options, for example, Tray alignment.
The printer driver has the following layout modes:

• Normal is used for printing standard documents, from 1 to 16 document pages per sheet. (See Normal layout
options on page 71.)

• Gangup is used for speed printing imposition modes. (See Gangup layout options on page 73.)

• Booklet is used for printing documents in booklet layout. (See Booklet options in the printer driver and Job
Properties on page 74.)

• Impose is used for imposition layouts for custom printing, binding, and trimming. (See Impose layout options on
page 77.)
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Normal layout options

Normal layout options are used for printing standard documents, from 1 to 16 document pages per sheet.

Duplex

The Duplex print option allows you to print a job with duplex (double-sided) pages.
Select Off for single-sided printing.
Specify Right & left binding or Top binding for duplex (double-sided) printing by specifying the orientation of
printed images.

Note: Two-sided tab (index) printing of 9x11 paper size is not supported.
For more information, see Print Duplex (double-sided) pages on page 103.

Mirror

The Mirror print option, when selected, prints the mirror image of the job.
This option is not available from the Mac OS printer driver and the Job Properties window of Command
WorkStation.

Orientation override

The Orientation Override print option is used with jobs that do not have an orientation or that have incorrect
orientation.
It specifies the orientation to use for finishing settings (for example, stapling) that interact with orientation and
for flowing pages on N-up layouts. In some cases, the orientation of a job may be correct in print, but incorrect
in preview.
This option is accessible only from the Job Properties window of Command WorkStation.

Orientation

The Orientation print option allows you to specify Portrait or Landscape page orientation for the document.
This option is not available from the Mac OS printer driver and the Job Properties window of Command
WorkStation.

N-up option: Page Order

Specify the layout direction when the Pages per Sheet option is set to 2-up or greater.

N-up option: Pages per Sheet

Specify the number of document pages per sheet of paper for your print job.
This option cannot be used with the Create master or Use master options.
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Note: This option is invalid if your job is sent to the Direct connection.

N-up option: Print border

Select to turn on Print border to print borders around each page in your print job.

Rotate 180

The Rotate 180 print option, when selected, rotates the pages of a job 180 degrees.

Scale to fit

The Scale to fit option allows you to specify whether to scale your job to fit to a paper size. When using the Scale
to fit option, you cannot use the manual Scale option.
The Scale to fit option allows you to scale a job to a paper size different from the document size. When you turn
on this option, the image is increased or reduced in size to fit the imageable area of the paper size you select
from the Paper size menu. The document size is scaled to the printable imageable area of the paper for edge-to-
edge printing. When you turn off this option, the original document size is printed without any scaling, even if
you select a larger paper size.

Scale to fit option Document size - Letter Output paper size - 11x17

Scale to fit turned on

Scale to fit turned off

Scale

Specify an increase or decrease in the scale of your print job. When using the manual Scale option, you cannot
specify Scale to fit.
The operator can specify a scaling override in Command WorkStation, but the override is applied to any scaling
value already set in the active job. For example, if a user sends a job with a scaling value of 50% and the operator
specifies a Scale override of 300%, the job is printed at 150% of the original document size, that is, 50% of 300%.
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Gangup layout options

Gangup layout options are used for speed printing imposition modes.

Note: The Gang-up feature is not valid if your job is sent to the Direct connection.

Gangup

Select Gangup to specify options for speed printing imposition modes.

Gang-up type

Gangup booklet has two types used for speed printing imposition: Step & repeat and Cut & stack.
Select Step & repeat to speed print a job by printing two document pages on each sheet. When the printed
sheets are cut in half, the result is two complete sets of the same document.
Select Cut & stack to speed print a job by printing two document pages side by side. When the printed sheets are
cut in half and stacked together, the result is one complete set of the document (in faster printing time).
For more information, see Gang-up printing on page 101.

Page Alignment: Duplex

The Page Alignment: Duplex print option allows you to select the duplex (double-sided) setting to specify the
orientation of printed images for gang-up printing.
Select Off for single-sided printing.
Specify Right & left binding for duplex (double-sided) printing to specify the orientation of printed images.
For more information, see Print Duplex (double-sided) pages on page 103.

Page Alignment: Increase gutter by

Increase gutter by controls the amount of space between adjacent pages on a sheet to adjust for trimming or
other finishing options.
You can specify the gutter value from -1.969 to 1.969 inch in 0.001 inch increments (-50.0 to 50.0 mm in 0.1 mm
increments).
Specify a positive value to increase the amount of blank space between adjacent pages.
Specify a negative value to decrease the amount of blank space between adjacent pages.
For more information, see Booklet Maker Help.
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Paper size

The Paper size print option defines the size of the sheet of paper on which your job prints. It is the size of the
physical sheet of paper.
To assign paper size, select one of the following:

• Select the size from the available list.

• Select Custom Paper Size to select a non-standard paper size.

• Select Same as document size to print on a sheet of paper the same size as the original document page size.

For information about Document size and Paper size, see Document size and Paper size on page 99.
For information about printing custom page sizes, see Defining and printing custom page sizes on page 98.

Paper Size: Shrink to fit

The Shrink to fit print option, when selected, automatically scales down or reduces the document page size to fit
the imageable area of the selected paper size specified from the Paper Size menu. Shrink to fit does not scale up
or enlarge.
Select one of the following settings:

• Off - prints the page contents at 100%.

• Sheet size - shrinks the page contents to fit the sheet size.

• Imageable area - shrinks the page contents to fit the imageable area.

Booklet options in the printer driver and Job Properties

Booklet layout options are used for printing documents in booklet layout.
The Booklet Maker print options accessible from the printer driver. For the Booklet Maker print options accessible
from Command WorkStation Job Properties, see Booklet Maker in the printer driver and Command WorkStation
Job Properties on page 94.

Note: The Booklet Maker feature is not valid if your job is sent to the Direct connection.
You can use the Booklet Maker Wizard to specify booklet options by clicking Launch Wizard.

Booklet

Select Booklet to specify options for printing documents in Booklet layout.
Click Launch Wizard to specify how to arrange the pages of the job in special layouts for folding or cutting after
printing.

Booklet Type

Booklet Type is a combination of binding method, which determines how the signatures of the booklet are
folded and imposed, and binding edge, which determines the location of the spine of the booklet.
For information about Booklet printing, see Booklet Maker Help.
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Cover: Back cover

When Front & Back Separately is selected for the Cover: Content input print option, use the Back cover option to
define how the content of the back cover is printed.
Select Print on outside to print only on the outside of the back cover (the inside of the back cover is blank).
Select Print on inside to print only on the inside of the back cover (the outside of the back cover is blank).
Select Print on both sides to print on both the inside and outside of the back cover.
Select Do not print if you do not want any content printed on the back cover.
When you add a cover, blank pages may be inserted, depending on the allocation of pages to signatures in the
job. For more information, see Booklet Maker Help.

Cover: Content input

The Content input print option provides cover type settings for your Saddle booklet.
Select Front & Back Separately to include cover content (individual pages in your document) as part of your
booklet print job.
Select Pre-Printed (use insert) to insert a pre-printed cover that is added to the body pages from an inserter tray.
For more information, see Booklet Maker Help.

Cover: Define Cover (for Saddle books only)

Click Define Cover to specify the cover options.

Cover: Front cover

When Front & Back Separately is selected, use the Front cover option to define how the content of the front
cover is printed.
Select Print on outside to print only on the outside of the front cover (the inside of the front cover is blank).
Select Print on inside to print only on the inside of the front cover (the outside of the front cover is blank).
Select Print on both sides to print on both the inside and outside of the front cover.
Select Do not print if you do not want any content printed on the front cover.
When you add a cover, blank pages may be inserted, depending on the allocation of pages to signatures. For
more information, see Booklet Maker Help.

Page Alignment: Centering adjustment

Centering adjustment positions page content in relation to the center of one-half the paper size or the spine, the
center of the sheet where the fold occurs.
At the center positions page content in the center of one-half the specified paper size.
At the spine aligns page content with the spine or center fold of your booklet.
For more information, see Booklet Maker Help.

Printing

Print Options

75



Page Alignment: Compensate creep

Compensate creep adjusts the position of the page content to counteract the shift that occurs when sheets are
folded and combined to create Saddle and Nested Saddle booklets.
Select Plain when printing Saddle or Nested Saddle booklets with a large number of pages.
Select Thick when printing Saddle or Nested Saddle booklets on heavyweight paper.
For information about printing booklets, see Booklet Maker Help.

Page Alignment: Increase gutter by

Increase gutter by controls the amount of space between adjacent pages on a sheet to adjust for trimming or
other finishing options.
You can specify the gutter value from -1.969 to 1.969 inch in 0.001 inch increments (-50.0 to 50.0 mm in 0.1 mm
increments).
Specify a positive value to increase the amount of blank space between adjacent pages.
Specify a negative value to decrease the amount of blank space between adjacent pages.
For more information, see Booklet Maker Help.

Paper Size: Paper Size for 2-up

The Paper Size for 2-up print option defines the size of the sheet of paper (unfolded) on which a booklet is
printed. It is the size of the physical sheet of paper.
To assign a paper size for a booklet, select one of the following:

• Select the size from the available list.

• Select Custom Paper Size to select a non-standard paper size.

• Select Same as document size to print on a sheet of paper the same size as the original document page size.

For information about Document size and Paper size, see Document size and Paper size on page 99.
For information about printing custom page sizes, see Defining and printing custom page sizes on page 98.
For more information about printing booklets, see Booklet Maker Help.

Paper Size: Shrink to fit

The Shrink to fit print option, when selected, automatically scales down or reduces the document page size to fit
the imageable area of the selected paper size specified from the Paper Size menu. Shrink to fit does not scale up
or enlarge.
Select one of the following settings:

• Off - prints the page contents at 100%.

• Sheet size - shrinks the page contents to fit the sheet size.

• Imageable area - shrinks the page contents to fit the imageable area.
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Subset Size: Number of sheets in a subset (saddle) (for Nested Saddle books only)

When Nested Saddle is selected for booklet type, use the Number of sheets in a subset (saddle) print option to
specify the number of sheets in each subset.

Impose layout options

Fiery Impose provides several pre-defined imposition templates used for custom printing, binding, and trimming.
Impose is an option on the Fiery ES.
The Impose option is only accessible from Command WorkStation Job Properties.
For more information, see Command WorkStation Help.

Impose

Select Impose to specify an imposition layout for a job.

Templates

Specify an imposition layout template for a job.
The available templates are as follows:

• Normal: Default Template and 1-up full bleed

• Booklet: 2-up perfect, 2-up saddle, and 4-up head to head

• Gangup: 3-up trifold brochure, 4-up gate fold, and 4-up z fold

Edit Impose Template

You can edit the imposition template in Fiery Impose.
Click Edit Impose Template to open a template in Fiery Impose for editing.
For information about Impose, see Utilities. For information about using Impose, see Command WorkStation
Help.

Color options

The Color tab shows color settings and additional features (when turned on).

Color mode

Select the color mode for the current print job.
Specify the color mode for the print job by doing one of the following:

• Select CMYK for a color document.

• Select Grayscale for a grayscale or black-and-white document.
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Calibration

Calibration shows the last date and time the calibration was updated for the printer.

Output profile

The Default output profile print option specifies the output profile used to process a job. Color data in a print job is
converted to the color space of the printer, which is described by the output profile.
For more information, see Color Printing.

Color input options

RGB source

The RGB source print option allows you to specify a source color space definition for printing RGB images,
graphics, and text.
For more information, see Color Printing.

Use RGB embedded profiles

When the Use RGB embedded profiles option is selected, the Fiery ES ignores the RGB Source option and uses
the RGB profile embedded in the print job as the RGB source profile.
For more information, see Color Printing.

RGB rendering intent

Specify a RGB rending intent for the print job.
Specify a default CRD (color rendering dictionary) for color conversion when printing RGB images, graphics,
and text.
Do one of the following:

• Select Presentation to print files with artwork, graphics, and text. The result is similar to Photographic, with
well-rendered in-gamut colors, such as flesh tones, and more saturated colors.

• Select Photographic to print photographs, including scanned and digital camera images. The result is less
saturated than Presentation style.

• Select Relative Colorimetric when color matching is important, but you also want to print white as paper
white. The white point transformation eliminates borders between blank spaces and white objects.

• Select Absolute Colorimetric when exact colors are required and visible borders are not distracting. There is
no white point transformation.

Note: If you experience tone reproduction problems, set this option to Photographic.
For more information, see Color Printing.
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Print RGB gray using black only

The Print RGB gray using black only print option provides settings to print an RGB grayscale job using black
instead of process black.
This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale using K-only
black. (Graphics refer to vector graphics; Images refer to raster images.)
This option is designed to use black efficiently, by using only black (rather than four-color process black). (See
Color Printing).

CMYK source

The CMYK source print option specifies the simulation profile for the print job.
For more information, see Color Printing.

Use CMYK embedded profiles

When the Use CMYK embedded profiles option is selected, the Fiery ES ignores the CMYK source option and
uses the CMYK profile embedded in the print job as the CMYK source profile.
For more information, see Color Printing.

CMYK rendering intent

The CMYK rendering intent print option allows you to specify a default CRD (color rendering dictionary) for
color conversion when printing CMYK images, graphics, and text.
Do one of the following:

• Select Relative Colorimetric when color matching is important, but you also want to print white as paper
white. The white point transformation eliminates borders between blank spaces and white objects.

• Select Photographic to print photographs, including scanned and digital camera images. The result is less
saturated than Presentation style.

• Select Absolute Colorimetric when exact colors are required and visible borders are not distracting. There is
no white point transformation.

• Select Presentation to print files with artwork, graphics, and text. The result is similar to Photographic, with
well-rendered in-gamut colors, such as flesh tones, and more saturated colors.

• Select Pure primaries to use one-dimensional transfer curves to adjust density output of individual color
channels.

Note: If you experience tone reproduction problems, set this option to Photographic.
For more information, see Color Printing.
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Black point compensation

The Black point compensation option lets you control the output quality of shadow areas for CMYK source
colors.
Use Black point compensation to enhance details in shadows when the CMYK source space is larger than the
gamut of the printer. In proofing applications, when the CMYK source space is smaller than the gamut of the
printer, do not use this option.

Note: For RGB source colors, black point compensation is always applied.
Black point compensation works by scaling the source colors so that the darkest point in the source profile maps
to the darkest point in the output profile.
For more information, see Color Printing.

Print CMYK gray using black only

The Print CMYK gray using black only print option provides settings to print a CMYK grayscale job using black
instead of process black.
This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale using K-only
black. (Graphics refer to vector graphics; Images refer to raster images.)
This option is designed to use black efficiently, by using only black (rather than four-color process black). (See
Color Printing).

Grayscale source

The Grayscale source print option defines the source color space for all grayscale objects.

Use Gray embedded profiles

When the Use Gray embedded profiles option is selected, the Fiery ES ignores the Grayscale source option and
uses the Gray profile embedded in the print job as the Grayscale source profile.
For more information, see Color Printing.

Grayscale rendering intent

The Grayscale rendering intent print option allows you to specify a default CRD (color rendering dictionary) for
color conversion when printing grayscale images, graphics, and text.
Do one of the following:

• Select Photographic to print photographs, including scanned and digital camera images. The result is less
saturated than Presentation style.

• Select Presentation to print files with artwork, graphics, and text. The result is similar to Photographic, with
well-rendered in-gamut colors, such as flesh tones, and more saturated colors.
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• Select Absolute Colorimetric when exact colors are required and visible borders are not distracting. There is
no white point transformation.

• Select Relative Colorimetric when color matching is important, but you also want to print white as paper
white. The white point transformation eliminates borders between blank spaces and white objects.

Note: If you experience tone reproduction problems, set this option to Photographic.
For more information, see Color Printing.

Print gray using black only

The Print gray using black only print option provides settings to print a grayscale job using black instead of
process black.
This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale using K-only
black. (Graphics refer to vector graphics; Images refer to raster images.)
This option is designed to use black efficiently, by using only black (rather than four-color process black). (See
Color Printing).

Spot color matching

Clear the Spot color matching check box to print specified PANTONE colors in your job using the alternate
color space and values for the spot color specified in the source application.
Select to activate the PANTONE Lookup Table. The Fiery ES uses a built-in table to generate the closest CMYK
matches of spot colors. (See Color Printing.)

Use spot group

The Use spot group print option uses the default spot color group for the print job.

Color settings options

Auto trapping

Trapping is a technique to print some objects slightly larger or smaller than specified in an application, in order
to prevent white edges around the objects.
These white edges, or “halos,” can be caused by factors such as misregistration, the physical properties of the
inks, and the stiffness of the media. The Auto trapping feature provides you with advanced trapping settings and
gives you full control over their values.
Select this option if the job should automatically reduce white gaps for text and graphics.
Turning on this option may result in graphics or text surrounded with borders.
For more information, see Color Printing.
This option is available as part of Fiery Productivity Package. For more information, see Fiery Productivity
Package.
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Auto Trapping customization feature is available as part of Fiery Productivity Package. For more information,
see Fiery Productivity Package.

Black overprint (for pure black)

The Black overprint (for pure black) print option provides settings for text or text/graphics to overprint in the
job.
Do one of the following:

• Select Off to use conventional processing by knocking out. May produce white halos around objects.

• Select Text to overprint black text.

• Select Text/Graphics to overprint black text and graphics.

For more information, see Color Printing.

Black text and graphics

The Black text and graphics print option specifies how to print black text and graphics in the print job.
Do one of the following:

• Select Normal to print black text and graphics as a four-color black using C, M, Y, and K, and to use normal
PostScript rendering.

• Select Pure Black On to print black text and graphics as a one-color black, using black only.

• Select Rich Black On to print black text and graphics as richer looking black, by layering a small amount of
Cyan underneath the black to make the black even darker.

This option is automatically set to Pure Black On if the Black overprint (for pure black) option is set to Text or
Text/Graphics. (See Color Printing.)

Combine separations

You can print the color separations in the job as a single page or as four individual pages.
When printing separations from supported desktop publishing applications, do one of the following:

• Select the Combine separations check box to combine separations on a single page.

• Clear the check box to view separations as individual black-and-white pages, each representing one color
plate.

For more information, see Color Printing.

Composite overprint

Design applications are typically set to knock out objects.
To overprint, you must first change the settings in the source application. When the Composite overprint option
is turned on, the overprinting attribute specified in the source application takes place, provided the output is in
composite mode (not printed in separations) and/or is printed with CMYK or Grayscale color mode. (See Color
Printing).
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Select this option to overprint objects that are specified in the source PostScript or PDF file.

ImageViewer Curves

The ImageViewer Curves print option lets you apply color curve edits from ImageViewer that have been saved
on the server as a preset.
ImageViewer in Command WorkStation can be used to edit the CMYK curves of a job on the Fiery ES. These
curve edits can be saved as a preset and applied to other jobs. Use the ImageViewer Curves option to select a
preset for your job.
Factory-supplied curve edits apply some typical color corrections:

• Lighter highlights

• Midtone boost

• No correction

• Shadow detail

• Reduce C (cyan) cast

• Reduce M (magenta) cast

• Reduce Y (yellow) cast

After the job is processed, the edits become part of the job and are no longer visible as edits when you view the
job in ImageViewer.
For more information, see Color Printing.

Optimize RGB transparency

You can use the Optimize RGB transparency option to achieve correct color output for areas of overlapping
transparent RGB or Lab colors (such as a drop shadow) in a PDF job.
Turn on to achieve correct color output for areas of overlapping transparent RGB or Lab colors (such as a drop
shadow) in a PDF job.
If you turn on Optimize RGB Transparency, the Fiery ES uses the correct RGB source profile and rendering intent
when converting the overlapping RGB colors to CMYK during the PDF-to-PostScript conversion. If you turn off
Optimize RGB Transparency, the area of overlapping colors might print with incorrect color or undesirable
artifacts.
This option is only accessible from the Job Properties window of Command WorkStation, Fiery Hot Folders,
and Virtual Printers. (See Color Printing).

Paper simulation

Select the Paper simulation check box to adjust the color according to the shade of the paper stock specified in
the selected CMYK/Grayscale source profile.
This option is available as part of Fiery Productivity Package. For more information, see Fiery Productivity
Package.
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Separate RGB/Lab to CMYK source

Select the Separate RGB/Lab to CMYK source option for RGB jobs to simulate an output printer other than the
printer to which you are printing.
For more information, see Color Printing.

Substitute colors

The Substitute colors print option, when selected, uses the substitute color values defined in Spot-On.
For more information, see Color Printing.

Image options

The Image tab shows all image quality settings supported by the connected Fiery ES and printer.
For information about options specified in Setup, see Configuration and Setup.

Brightness

The Brightness print option allows you to specify the image brightness for the print job.
Select 85% lightest for a substantially lighter image, 115% darkest for a substantially darker image, or one of the
settings in between.

Edge enhancement

When the Edge enhancement print option is set to On, it smooths the edges of text and graphics and reduces the
appearance of jagged edges.

Gloss print

Select the Gloss print check box to gloss the print job like a photograph.
This feature is available when the Paper type option is set to Plain paper and the Duplex option is set to Off.

Image enhance: Apply image enhancement

The Apply image enhancement option, when selected, applies photo enhancement to the job.
The supported file formats are PDF, PS, TIFF, and EPS.
This option is not valid for images under 72 dpi. Also, it is not applied to pages with a large number of images.
For more information, see Image Enhance on page 102.

Image enhance: Image enhancement range

Specify all pages, specific page(s), or sheets of the document to apply photo finishing enhancement.
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Image smoothing

Select the Image smoothing option to minimize grainy output when printing low-resolution (up to 300 dpi) images.
This option is valid for images less than or equal to 150 dpi when the Resolution option is set to 600 dpi, and for
images less than or equal to 300 dpi when the Resolution option is set to 1200 dpi. This option improves graphic and
image types of gradients.

Image quality

The Image quality print option allows you to specify the type of image quality for the job.
This option affects the fineness of images in the job; there is a trade-off with processing speed.
Choose one of the following for the print job:

• Normal - to print quality images.

• Best - to print the highest quality for text and images.

Resolution

The Resolution print option allows you to specify the resolution of the print job (specified in dots-per-inch).

Note: Calibration is affected by the resolution setting. When you create a custom calibration setting, be sure the
resolution setting is the same setting that is used in jobs that are printed with the calibration setting. For more
information, see Color Printing.

Screen pattern

Specify a halftone screen pattern for the print job.
Select one of the following:

• Gradation priority for gradation-optimized halftone screening.

• Resolution priority for resolution-optimized halftone screening.

• High-resolution priority for high resolution-optimized halftone screening.

The Screen pattern settings are affected by the resolution. The screens used at 600 dpi are generally smoother in
gradation than those used at 1200 dpi. Set the Resolution print option to 600 dpi if your job contains images and
gradations. Set the Resolution print option to 1200 dpi if your job contains mostly line art and text.

Use maximum printer density

The Use maximum printer density option is designed to create solid, saturated colors. It is typically used to print text
and graphics, not photographic images.
Select this option to print 100% C, M, Y (or R, G, B) at the maximum density that the printer is capable of printing,
regardless of calibration. C, M, Y (or R, G, B) values less than 100% still print at the calibrated density value.
For best results printing CMYK color, set CMYK Source to Bypass conversion. For best results printing RGB color,
make sure the Use RGB embedded profiles option is selected.
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Finishing options

The Finishing tab shows print options related only to finishing equipment on the printer, and also image shifting to
compensate for finishing options.
These options override settings in Fiery ES Printer Setup but can be changed from Command WorkStation.

Delivery Option: Collate

The Collate print option allows you to specify how to output multiple-page/multiple-copy jobs.

• Collate: Copies of a complete job are sorted as 1-N, 1-N.

• Uncollate: Copies of a complete job are sorted as 1,1, 2,2, 3,3.

• Offset collate: Copies of a complete job are sorted as 1-N, 1-N with offset stacking.

• Offset uncollate: Copies of a complete job are sorted as 1,1, 2,2, 3,3 with offset stacking.

Note: This option is invalid if your job is sent to the Direct connection.

Note: The collation of Mixed Media and Variable Data Printing (VDP) jobs is handled differently. For Mixed Media
jobs, copies of a complete job are sorted according to finishing set. For VDP jobs, copies of a complete job are sorted
per record.
For information about VDP, see Variable Data Printing.
For information about Mixed Media, see Utilities.

Delivery option: Output tray

The Output tray print option allows you to specify the output tray for the job.

Fold

Specify a fold style for the print job.
For more information, Fold options on page 101.

Fold: Tri-fold type

The Tri-fold type print option allows you to specify the number of pages to be tri-folded at a time.
The printer can tri-fold all pages together, each page one-by-one, or a specific number of pages.

Note: This option is available when Tri-fold is selected for the Fold option.

Fold: Tri-fold number

The Tri-fold number print option allows you to specify the number of pages to be tri-folded.

Note: This option is available when the Tri-fold type option is set to Page unit.
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Image shift

The Image shift print option check box, when selected, adjusts an image for duplex printing by shifting the image
horizontally, in the direction of paper travel, relative to the leading edge.
This option affects the offsetting of the image for the entire job, not on a per-page-basis. However, you can specify
alignment settings for the front (odd) and back (even) pages.
Image Shift settings are not available from inside Mixed Media.
Image Shift is not supported for Booklet Maker and Gang-up printing.
For more information, see printer driver help.

Punch: Punch edge

The Punch edge print option allows you to specify the location of punched holes.
To use this option, you must install a finisher with hole punching functionality.
For information about installing finishers and other installable options, see printer driver help.

Punch: Punch holes

The Punch holes print option allows you to specify the number of holes to punch for your job.
To use this option, you must install a finisher with hole punching functionality.
For information about installing finishers and other installable options, see printer driver help.
For more information, see Punch position and hole punching on page 103.

Stapler: Staple

The Staple print option allows you to specify the number of staples and their positions.
Staple positions vary according to paper size, paper type, number of pages, and feed direction.
To use this option, you must install a finisher with stapling functionality.

Variable Data Printing (VDP) options

The VDP tab shows all Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP settings.
The Fiery ES is compatible with the following variable data printing languages:

• FreeForm and FreeForm 2

For more information about VDP languages, see Variable Data Printing.
VDP documents using FreeForm must have the following settings for the master document and variable document
match:

• Color mode

• Combine separations
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• Duplex

• Orientation

• Paper size

• Staple

The following setting for the variable document overrides the corresponding settings in the master document:

• Paper tray

• Paper type

Cache PDF and PS objects

The Cache PDF and PS objects print option, when selected, recognizes objects (text, images, vectors) within a
PostScript or PDF file. PDF objects must be tagged as XObjects and PS objects must be in PS form to be cached,
which reduces the need to re-process image data for faster printing.
This option is only accessible from Command WorkStation Job Properties.
For more information, see Variable Data Printing.

Create master

To create a FreeForm master from this job, specify a number to assign to the FreeForm master file.
Command WorkStation allows you to select up to 100 FreeForm masters.
For more information, see Variable Data Printing.

Enable enhanced FreeForm

Select to turn on Enable enhanced FreeForm to allow the mapping of select pages from the FreeForm master file in
the desired order and merge with the variable file when the job is processed.
You cannot apply FreeForm settings to an imposed job.
For more information, see Variable Data Printing.

Preview Master

The Preview Master print option, when selected, generates a low-resolution image of your master page.
This option is not available for the Mac OS X v10.9 or later printer drivers.

Print master

The Print Master print option, when selected, allows you to verify or confirm your Master page.
Select Printer’s default to use the setting specified in Fiery ES Setup.
For more information, see Variable Data Printing.
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Remove white PPT background

Select to turn on Remove white PPT background when using Microsoft Office PowerPoint to create variable data in
conjunction with FreeForm.
This option removes the white background from PowerPoint files.

Use master

For variable data print jobs, specify a FreeForm master number to be used for the job.
Command WorkStation allows you to select up to 100 FreeForm masters.
For more information, see Variable Data Printing.

Define record length: Define record length

Process a PDF or PostScript file like a variable data print job, and apply record-based finishing.
This option is used in connection with the Pages Per Record option.
For more information, see Variable Data Printing.

Define record length: Pages per record

Define record-based (rather than job-based) finishing, based on the number entered.
This option is used with the Define Record Length option.
For more information, see Variable Data Printing.

Stamping (Watermark) options

The Stamping tab shows all image stamping options that add or hide/remove any image on the job.
The watermark features are available from the printer driver only.
This also includes watermark properties that define the placement and style of the watermark. For information, see
printer driver help.

Copy security

The Copy security print option allows you to use security settings to identify and prevent unauthorized copies.
Choose one of the following:

• Off - to not use security settings.

• Copy protect - to include a pattern that is faintly visible (background) on printed document, however when the
document is photocopied, the imprint is darker and distinctly visible.
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• Stamp repeat - to add a watermark/overlay that is clearly visible in both print and copies.

• Copy guard - to embed the copy guard information into the printed paper to prevent copying the printed paper
on the printer.

Angle

The Angle print option allows you to specify an angle for Copy security stamping. Four lines or less can be printed
when the angle is not “0 degrees.”
The option is valid when the Copy security print option is set to Copy protect or Stamp repeat.

Characters

The Characters print option allows you to select the characters (text) when using a watermark.

Color contrast

The Color contrast print option allows you to specify pattern color contrast for text/background color for Copy
protect and Copy guard.

Color density

The Color density print option allows you to select a pattern color density for text/background color for Copy
protect, Copy guard, and Stamp repeat.

Copy protect color

The Copy protect color print option allows you to specify the pattern color to use with the Copy security print option
settings.

Text size

The Text size print option allows you to specify the text size for the Copy security print option settings.

Copy security numbers: Distribution control number

The Distribution control number print option when turned on allows you to include the Distribution control number
when using the Copy security print option settings.
To assign a specific start number, use the separate Start number print option.

Copy security numbers: Job number

The Job number print option when turned on allows you to include the job number (printer-defined) when using the
Copy security print option settings.
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Copy security numbers: Serial number

The Serial number print option when turned on allows you to include the printer serial number when using the Copy
security print option settings.

Copy security numbers: Start number

The Start number print option allows you to specify a starting copy number when using one of the Copy security
print options.

Copy security numbers: Start number type

The Start number type print option allows you to specify the numbering format type when using the Copy security
print option settings.

Copy security pattern: Background pattern

The Background pattern print option allows you to select the Copy protect or Copy guard patterns from the
background patterns registered with the printer.

Copy security pattern: Pattern

The Pattern print option allows you to specify how to print the Copy security stamping pattern.

Copy security pattern: Pattern overwrite

The Pattern overwrite print option allows you to select whether the pattern is combined in the background or
foreground of the document for Copy security stamping options.

Copy security timestamp: Date

The Date print option allows you to select the Copy security date format.

Copy security timestamp: Time

The Time print option allows you to select the Copy security time format.

Watermark

The Watermark print option allows you to select standard text for your watermark from the pull-down menu.
To create your own watermark, click New.
To modify a standard watermark, select it from the pull-down menu and click Edit.
To remove a watermark from the list, select it from the pull-down menu and click Delete.
For more information about using watermarks, see printer driver help.

Note: For Windows, do not select these fonts: AdobeSansMM and AdobeSerifMM.
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Print Watermarks: First Page Only

The First Page Only print option check box, when selected, to specify how to print the watermark for the print job.
Select to turn on First Page Only to print a watermark only on the first page.
For more information about using watermarks, see printer driver help.

Override print option settings in Job Properties

Print option settings that were specified in the printer driver can be overridden in the Job Properties window of
Command WorkStation.
1 In Command WorkStation, right-click a job in the Held or Printed queue.

2 Select Properties.

3 Specify the print option settings, and then click Print.

Exceptions to overriding print option settings in Job Properties

You can override most print options in the printer driver and Command WorkStation Job Properties.
The exceptions are listed in the table.

Printer driver tab Option Driver Win Driver Mac CWS

Job Info Print Range X

Print queue action X X

Secure print X X

User Authentication: User name X X

User Authentication: Password X X

User Authentication: Use Windows Login X

User Authentication: I'm a Guest X

Media Document size X

Layout: Normal Mirror X

Orientation X

Orientation override X

Color Optimize RGB transparency X

Variable Data Printing (VDP) Cache PDF and PS objects X
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Printer driver tab Option Driver Win Driver Mac CWS

Enable enhanced FreeForm X X

Stamping (Watermark) Watermarks X X

Print Watermarks: First Page Only X X

Booklet Maker layouts in the printer driver and Command WorkStation Job Properties

Booklet Maker is the imposition tool that allows you to quickly print documents in booklet format, without the need
for more involved page imposition programs.
Booklet Maker provides advanced settings, while streamlining the booklet-making process by displaying only the
options and controls relevant to your selections. Booklet Maker is capable of imposing jobs from nearly any
application.
Access Booklet Maker in the printer driver when you print a job, or in Command WorkStation Job Properties.

Note: Mixed Media jobs and variable data printing jobs are not supported by Booklet Maker.
The following booklet layouts are available:

• Saddle binding: Signatures are folded together as a group, and then stapled or stitched along the center fold,
which forms the spine of the booklet.

1 Saddle (left) binding

2 Saddle (right) binding

3 Saddle (top) binding

• Nested Saddle binding: Combines saddle and perfect binding methods by stacking two or more saddles (also
called “groups” or “subsets”) together along the common fold, then gluing them together at the fold to form the
spine.
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1 Nested Saddle (left) binding

2 Nested Saddle (right) binding

3 Nested Saddle (top) binding

• Perfect binding: Separate, folded pages are printed and stacked in booklet order. Finished pages are stitched
adjacent to one another for trimming or gluing.

1 Perfect booklet

2 Front (2, 3, 6, 7) and Back (4, 1, 8, 5)

For more information, see Booklet Maker Help.
For more information, see Booklet options in the printer driver and Job Properties on page 74.

Booklet Maker in the printer driver and Command WorkStation Job Properties

You can access Booklet Maker from the Layout tab in the printer driver and Command WorkStation Job Properties
when you print a job.
You can work with Booklet Maker as follows:

• Using the Booklet Maker wizard.
Recommended for first-time or novice users.

• Specifying settings in the main Booklet pane.
Recommended for experienced or advanced users.

For more information, see Booklet options in the printer driver and Job Properties on page 74.

Access Booklet Maker from the Windows printer driver

1 In your application, select File > Print.
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2 Select the Fiery ES as your printer and click Properties.

3 In the printer driver, click Layout and then select the Booklet option.
For more information, see Booklet Maker Help.

Access Booklet Maker from the Mac OS printer driver

1 In your application, select File > Print.

2 Select the Fiery ES as your printer, and select Fiery Features from the drop-down list.

3 Click Full Properties in the Quick Access pane.

4 In the printer driver, click Layout and then select the Booklet option.
For more information, see Booklet Maker Help.

Access Booklet Maker from Command WorkStation

1 Double-click your print job in the Held or Printed queue, or right-click the job and select Properties.

2 Click Layout in the Job Properties window.

3 Select the Booklet option.

4 Specify the Booklet Maker settings or click Launch Wizard to specify the settings graphically.
For more information, see Command WorkStation Help.

About Booklet Maker imposition

Imposition is the process of printing multiple pages on single sheets of paper.
When imposed sheets are folded together as signatures, the pages follow in sequential, or reading, order. Booklet
Maker is designed for 2-up imposition, which imposes four individual pages from your document on a single sheet
that is printed duplex.
The order in which pages are imposed is determined by the binding method that you select.

Booklet Maker and Impose

Booklet Maker settings are supported by Impose, if turned on.
You can open a job with Booklet Maker settings in Impose to preview the imposition layout or further modify the
imposition layout, if necessary.
Impose translates and maps all Booklet Maker settings to Impose commands.

Note: When a job with Booklet Maker settings has been edited in the Impose window, the job can no longer be
edited in Booklet Maker. Impose offers more settings that cannot be mapped to Booklet Maker settings.
For more information about Impose, see Utilities.
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Create a booklet with the booklet options in the printer driver or Job Properties

Booklet Maker dynamically displays all of the controls applicable to creating a booklet in the main Booklet Maker
window.
1 Select a Booklet Type: Saddle, Nested Saddle, or Perfect.

2 Select a binding edge: Left, Top, or Right.

3 Specify a Paper size.

4 Select Shrink to fit, if required.

5 Specify Page alignment.

6 Specify Creep compensation, if required.
Creep compensation is available for saddle and nested saddle booklets.

7 Specify cover settings, if you selected a saddle booklet.

Note: Cover settings are only available for saddle booklets. (See Adding a cover to a Saddle booklet on page 96).

8 Click OK to save your settings, Cancel to cancel the job, or Print to print your job.

Create a booklet with the Booklet Maker wizard

In the Booklet Maker wizard, accessed by clicking Launch Wizard, the windows display the steps in the booklet-
making process.
1 Click Launch Wizard.

2 Specify the Booklet Type (binding method) and binding edge.

3 If Saddle was selected for Booklet Type, specify cover and content settings, and then click Next.

4 Specify paper size and media settings, and then click Next.
If Saddle was selected for Booklet Type, specify the paper settings for the cover, and then click Next.
If Nested Saddle was selected for Booklet Type, specify number of sheets in a subset.

5 Specify layout settings, and then click Next.
If Saddle or Nested Saddle was selected for Booklet Type, specify creep compensation.

6 View the settings summary.

7 Click Finish to save your booklet, Back to change any settings, or Cancel to cancel the job.

Adding a cover to a Saddle booklet

You can add covers (optional) for Saddle booklets.

Printing

Print Options

96



Add a pre-printed cover to a Saddle booklet

1 In the main Booklet Maker window, select Saddle for Booklet Type and a binding edge.

2 Specify the required settings for Paper Size and Page Alignment for the body of the booklet.

3 Select Pre-Printed from the Cover: Content input menu.

4 Click Define Cover and specify the cover media settings.

5 Click OK.

Add an inline cover to a Saddle booklet

1 In the main Booklet Maker window, select Saddle for Booklet Type and a binding edge.

2 Specify the required settings for Paper Size and Page Alignment for the body of the booklet.

3 Select Front & Back Separately from the Cover: Content input menu.

4 Specify the Front cover and Back cover settings.

5 Click Define Cover and specify the cover media settings.

6 Click OK.

Note: When you print an inline cover with top-edge binding, the outside back cover automatically rotates 180
degrees to match the orientation of the front cover.

Booklet Maker cover options for Saddle booklets

For Saddle only, Booklet Maker includes two cover options: pre-printed or inline, for which you can specify media.
You can specify additional options for an inline cover by specifying the following cover options:

• Content input: Select from Front & Back Separately or Pre-Printed.

• Front & Back Separately: Select this option to specify an inline cover that prints the cover pages and body pages as
a single job. Separate pages from your document are imposed on a single sheet that forms the cover pages of your
booklet.
You can specify an inline cover when your original document includes the cover pages and/or cover artwork for
your booklet. The cover content may be the first and last pages of your document, or the first two and last two
pages of your document, or any combination.
If you select this option, you can specify the Front cover and Back cover options.

• Pre-Printed: Select this option to insert a pre-printed cover that will be merged with the body pages of your
booklet, which print separately.
If you select this option, the Front cover and Back cover options are disabled.
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• Front cover and Back cover: These options allow you to quickly decide whether your front and back covers print
duplex, single-sided, or both sides blank, without needing to add blank pages in your original document.
With top-edge binding that includes a cover, the outside of the back cover automatically rotates 180 degrees to
match the orientation of the front cover.

• Define Cover: This option allows you to select cover media settings for your cover pages, which may be trimmed.
This option is available for both pre-printed and inline covers.

Printing Booklet Maker jobs

Booklet Maker does not support jobs sent to the Direct connection. Booklet Maker print jobs must be sent to the
Print queue or Hold queue.

Set measurement units in Command WorkStation

You can change the default unit of measurement for all input fields in the Command WorkStation Preferences
window.
Units specifies the units of measurement used to display attributes, such as page sizes and custom sizes, that you
enter in the Job Properties window. This setting does not affect predefined page-size values.

1 In Command WorkStation, select Edit > Preferences.

2 Click Region to access Regional Settings.

3 Select the unit of measurement (millimeters, points, or inches).

4 Click OK.
The changes are not effective until Command WorkStation is restarted.

Defining and printing custom page sizes

With custom page sizes, you define the dimensions of a printed page. After you define a custom page size, you can
use it from within an application without redefining it each time you print.
When you create custom page sizes, specify width dimensions to correspond with the shorter side of your job and
specify height dimensions to correspond with the longer side of your job. Set custom page sizes in this way,
regardless of the orientation settings in the application.
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1 Portrait orientation

2 Landscape orientation

3 Height

4 Width

Note: Custom page sizes are not supported with Imposition jobs.
For information about defining and printing custom page sizes, see printer driver help.

Document size and Paper size

Document size is the page size defined in your application’s Print setup (or Page setup) dialog box.
Paper size is the size of the actual sheet of paper on which your job is printed. It may be useful to think of Document
size as digital input (the page size defined in your original document) and Paper size as the physical output (the
actual size of the paper in the printer tray).
In cases when you print one document page per sheet of paper, Document size is usually the same as the Paper size.
However, Document size may differ from Paper size when you print booklets or impose multiple document pages on
a single sheet.
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The illustrations show examples of possible relationships between Document size and Paper size. Note that the
orientation of all pages shown is landscape.

Description Document size (input) Paper size (output)

Document size is the same as Paper size. Scaling is 100%. Letter Letter

Tabloid Document size scaled to fit on Letter Paper size. Scaling is 50%. Tabloid 11x17 Letter

A4 Document size scaled to fit on A3 Paper size. Scaling is 141%. A4 A3

Document size may also differ from Paper size when using the Scale or Scale to fit options. The Scale option reduces
or enlarges the document page at a specified percent. The Scale to fit option automatically reduces or enlarges the
document image to fit the selected paper size.
For information about Document size and Paper size in booklet printing, see Booklet Maker Help.
For more information, see Scale on page 72.
For more information, see Scale to fit on page 72.
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Fold options

The Fold style specifies how the folded job is printed.
You can specify whether the pages of your folded job print with the imageable area on the inside or outside of the
folded sheet.

Fold style Fold illustration

Half-fold

Tri-fold

Z-fold (A3, B4, 11x17, 8K)

Z-fold (8 1/2x14)

A finisher capable of folding must be installed on the printer to use the Fold print option.
For information about finishers and other installable options, see printer driver help.

Gang-up printing

Gangup layout options are used for speed printing imposition modes.
The Fiery ES includes two speed-printing options for gang-up printing:

• Step & repeat - Select this option to speed print a job so that the first page of your document is printed twice on
the first sheet. The next sheet duplicates the data on the second page, the next sheet duplicates the data on the
third page, and so on. When the printed sheets are cut in half, the result is two complete sets of the same
document.

2 2

2 2

1 1

3 3

1 1

4 4

1 Single-sided, front only

2 Duplex (double-sided), front (1, 3) and back (2, 4)
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• Cut & stack - Select this option to speed print a job so that when the sheets are stacked and cut from the central
position, the job is numbered in order and separated as two stacks. The print order is such that when the sheets
are cut in half, you can combine them to form a single complete set of the document, in faster printing time.

2 6

2 4

1 3

3 7

1 5

4 8

1 Single-sided, front only

2 Duplex (double-sided), front (1, 3, 5, 7) and back (2, 4, 6, 8)

For more information, see Gangup layout options on page 73.

Access Gang-up print from the Windows printer driver

1 In your application, select File > Print.

2 Select the Fiery ES as your printer and click Properties.

3 In the printer driver, click the Layout icon and select the Gangup option.

Access Gang-up print from the Mac OS X printer driver

1 In your application, select File > Print.

2 Select the Fiery ES as your printer and select Fiery Features from the drop-down list.

3 Click Full Properties in the Quick Access pane.

4 In the printer driver, click the Layout icon and select the Gangup option.

Image Enhance

The Image Enhance feature lets you apply photo finishing enhancement to color images on specified pages or sheets
of a job. This feature affects only photographic images, not graphics such as logos or charts.
To turn on this feature, select the Apply image enhancement check box for a job and specify the pages or sheets to
be affected. This option is located in the Image tab of the printer drivers and in the Job Properties window of
Command WorkStation. You can customize Image Enhance settings from Command WorkStation.
For more information, see Command WorkStation Help.
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Print Duplex (double-sided) pages

1 In your application, do one of the following:

• On Mac OS X computers: Select File > Print, select the Fiery ES as your printer, select Fiery Features from the
drop-down list, click Full Properties in the Quick Access pane, and then select Normal on the Layout tab.

• On Windows computers: Select File > Print, select the Fiery ES as your printer, click Printer Properties or
Properties, and then click the Layout icon.

2 Select one of the Duplex settings:

• Right & left bind: Prints the top of the image on Side 1, on the same edge of the page as the top of the image on
Side 2.

• Top bind: Prints the top of the image on Side 1, on the opposite edge of the page from the top of the image on
Side 2.

Orientation Right & Left binding Top binding

Portrait 1 2 1

2

Landscape 1 2 1
2

3 Print the job.

Punch position and hole punching

You can specify the number of holes to punch and the location of the punched holes.
A finisher capable of punching must be installed on the printer.

Note: Punch positions vary according to paper size, paper type, number of pages, feed direction, and original
orientation.

Punch
setting

Portrait: Left Portrait: Right Portrait: Top Landscape: Left Landscape:
Right

Landscape: Top

2-holes

3-holes
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Punch
setting

Portrait: Left Portrait: Right Portrait: Top Landscape: Left Landscape:
Right

Landscape: Top

4-holes

The number of holes differs depending on the finisher destination:

• US, 2-holes or 3-holes

• EU, 2-holes or 4-holes

For information about finishers and other installable options, see printer driver help.

User Authentication

If Users and Groups user authentication is configured in Fiery ES Setup, you must enter a valid user name and
password to send a print job to the Fiery ES.
In Command WorkStation, the management of jobs is determined by how you log on to the Fiery ES.
The print options associated with Users and Groups user authentication are as follows:

• On Mac OS computers: Click Job Info and type logon information in the User name and Password fields.

• On Windows computers: Set the following:

• Use Windows Login - Select this option if you are already logged on to a Windows computer. Otherwise, type
your Windows network logon information in the User name and Password fields.

• Validate - Click to validate user authorization and to confirm printing privileges. To validate, Two-Way
Communication must be turned on. For information on establishing Two-Way Communication, see printer
driver help.

• I’m a guest - Select this option to activate guest printing privileges. By default, guest printing is turned on.

For information about turning on Users and Groups user authentication in Configure, see Configuration and Setup
and Command WorkStation Help.
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Introduction

This document explains how to manage color output on the Fiery® ES IC-418 and provides information about color
conversion and other color operations.
This document is part of a set that includes documentation for users and system administrators. For more
information about supported operating systems and system requirements, see Configuration and Setup.

Terminology, conventions, and documentation resources

This document uses the following terminology and conventions to refer to the Fiery® ES IC-418, printer, and
supported operating systems.

Term or convention Refers to

Aero Fiery ES (in illustrations and examples)

Command WorkStation Fiery Command WorkStation

Printer MFP

Fiery ES Fiery® ES IC-418

Mac OS All supported Mac operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Windows All supported Windows operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Warning: A warning concerning operations that may lead to death or injury to persons if not performed
correctly. To use the equipment safely, always pay attention to these warnings.

Caution: A caution concerning operations that may lead to injury to persons if not performed correctly. To
use the equipment safely, always pay attention to these cautions.

Important: Operational requirements and restrictions. Be sure to read these items carefully to operate the
equipment correctly, and avoid damage to the equipment or property.

The following documentation resources are available for the Fiery® ES IC-418.

Resource Description

User documentation Documents in this set: Color Printing, Configuration and Setup, Fiery Productivity Package,
Printing, Utilities
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Resource Description

Online help • Help can be accessed directly from each Fiery application or by going to help.efi.com.

• Each help system is available as a printable PDF, accessed from the PDF icon in the upper right
corner of the Help window.

Additional reference
material • Fiery Color Reference - help.efi.com/ref/colorref/en-us/

• Variable Data Printing - help.efi.com/ref/vdp/en-us/

• Workflow Examples - help.efi.com/ref/workflows/en-us/

• Configure Help - help.efi.com/configure/3.0/en-us/

Key features of ColorWise

ColorWise is the color management system (CMS) built into the Fiery ES and designed to provide both casual and
expert users with the best color output for a variety of purposes. The ColorWise default settings provide
high‑quality, out-of-box color from many applications.
ColorWise default settings allow casual users to achieve quality output without knowing about or changing any color
settings on the Fiery ES. ColorWise also provides controls to allow expert users to obtain the best color output.
Depending on your particular needs, you can:

• Set the behavior of CMYK printing to emulate offset press standards.

• Match PANTONE and other spot colors for the best match when printing using four-color press conditions or
presses with extra colorants.

• Select a rendering intent for RGB printing. Rendering intents allow for rich, saturated printing of presentation
graphics, smooth, accurate printing of photographs, and relative or absolute colorimetric rendering for
specialized needs.

• Define the source of incoming RGB color data for better color conversion of RGB data with no source
information.

• Determine whether RGB data is converted into the full gamut of the printer or is first converted into the gamut
of another device, such as a press standard. This feature is useful for making one device behave like another for
RGB data. It also allows you to evaluate the appearance of an RGB file under different printing conditions
without having to convert the RGB file to CMYK first.

ColorWise color management (ColorWise) offers an open color architecture, allowing users to customize the Fiery
ES to meet new printing needs as they arise. ColorWise supports ICC profiles, which are industry-standard color
profiles that describe the color behavior of a device. Note that ICC specification version 4 profiles (profile version
4.2.0.0) are supported as well as version 2. Downloading ICC profiles to the Fiery ES enables the Fiery ES to simulate
a custom press (or another printer), as well as accurately print colors from a particular monitor or scanner. In
addition, you can create customized ICC profiles for the Fiery ES.
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Color features in Command WorkStation

Command WorkStation includes color-management tools and color-related features.

• Color management
Command WorkStation allows you to set the default settings of the ColorWise print options for the Fiery ES.
These default settings are applied to all print jobs sent to the Fiery ES, unless a user overrides them for an
individual job.

• Profiles
Command WorkStation allows you to manage all of the ICC profiles used in Fiery ES workflows. You can also
create custom profiles by editing existing CMYK source or output profiles and saving them as new profiles.
The AutoGray feature allows you to adjust the gray balance of output profiles.

• Calibrator
For consistent color, calibrate the Fiery ES on a regular basis. Command WorkStation includes an easy-to-use
calibrator, which allows you to calibrate using a measurement instrument.
Command WorkStation also allows you to use any Status T densitometer by importing data in a standard file
format. In this case, it is important to note that the quality of the instrument used determines the quality of the
calibration.

Color features in Fiery Productivity Package

If Fiery Productivity Package is activated on the Fiery ES, additional color features are available in Command
WorkStation.
For more information, see Fiery Productivity Package.

• Spot-On (spot colors)
Spot-On is a spot color (named color) manager. You can adjust and manage lists of spot colors and their CMYK
equivalents. The matching lists of spot colors and CMYK values are known as spot color dictionaries. Spot-On
allows you to edit spot color definitions on the Fiery ES and create custom spot color definitions and dictionaries.
Spot-On is also required for spot color overprinting, when a job contains overlapping spot-color objects.

• Configurable auto trapping
Trapping is a technique where the size of objects is modified so that colors printed next to each other overlap
slightly, to prevent white spaces between two colors. The Fiery ES has default trapping values that are optimized
for the printer using regular paper.
The configurable auto trapping feature provides you with advanced settings for the Auto trapping print option. If
the default trapping values do not provide the results necessary for the media that you use, you can modify the
values to meet your requirements.

• ImageViewer
ImageViewer allows you to soft proof and adjust colors in a job before it is printed. You can use the preview in
ImageViewer to verify job placement, orientation, and content, as well as general color accuracy.
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• Image Enhance Visual Editor (IEVE)
IEVE is an image-editing application that provides users with a visual workspace to adjust individual images in a
job. With IEVE, you can see the effects of your adjustments and fine-tune the appearance of an image.

• Control bar
The control bar feature allows you to add a static color bar and dynamic job information to each printed page at
a user-defined location. The feature can be set as a server default or overridden on a per‑job basis.

• Postflight
Postflight is a diagnostic tool that helps you determine why some printed jobs do not deliver the expected color
output.
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Color print options

The Fiery ES provides print options that affect the output of color objects in various color spaces. By specifying the
appropriate settings for each print option, you can obtain the expected results for your jobs.
Color management determines how color data in a job is converted to the color data that is sent to the printer. Some
color print options affect the color management applied to a job. Other color print options are not related to color
management.

Color management on the Fiery ES

The color management system on the Fiery ES determines how the color data in a document is converted from
source to output.
Applications allow you to generate color data in different color spaces. The most common type of color data
produced from office applications is RGB, while prepress applications generally produce CMYK data. Desktop
applications also generate spot colors, such as PANTONE colors. A single page of a document may contain a mix of
RGB, CMYK, grayscale, and spot colors.
Through print options that apply specifically to RGB, CMYK, grayscale, or spot color data, you specify the color
management of a job.

Note: Before you set these color management options, you must set the Color mode option, which specifies the
output color space (CMYK, for example). If you change the Color mode setting, color management options are reset
to the server default settings.

Print options that affect CMYK
data

Print options that affect RGB
data

Print options that affect
grayscale data

Print options that
affect spot-color
data

CMYK source RGB source Grayscale source Spot color
matching

Use CMYK embedded profiles Use RGB embedded profiles Use Gray embedded
profiles

Use spot color
group

CMYK rendering intent RGB rendering intent Grayscale rendering
intent

Black point compensation Separate RGB/Lab to CMYK
source

Black text and graphics Black text and graphics
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Print options that affect CMYK
data

Print options that affect RGB
data

Print options that affect
grayscale data

Print options that
affect spot-color
data

Black overprint Black overprint

Print CMYK gray using black only Print RGB gray using black only Print gray using black
only

Output profile Output profile Output profile

RGB Source applies strictly to RGB color data. The other options that affect RGB color also affect Lab, XYZ, and
other calibrated color spaces, which are more rarely used.
If a job contains calibrated CMYK (CIEBasedDEFG) data, the CMYK processing options are not used. Instead, the
RGB/Lab Rendering Intent print option, which normally affects only RGB data, is used to process the calibrated
CMYK data.

Auto trapping

Trapping is a technique where the size of objects is modified so that colors printed next to each other overlap
slightly, to prevent white spaces between two colors. These white spaces can be caused by factors such as
misregistration, the physical properties of the ink or toner, and the stiffness of the media.

Figure 1: Auto trapping off Figure 2: Auto trapping on

If you turn on the Auto trapping option, trapping is applied to all of the objects in a job.
The Fiery ES has default trapping values that are optimized for a Fiery-driven print device using regular paper.
If the default trapping values do not provide the results necessary for the media that you use, you can modify the
values to meet your requirements in Command WorkStation with the configurable auto trapping feature.
Configurable auto trapping is part of Fiery Productivity Package. For more information about configurable auto
trapping, see Fiery Productivity Package.
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Black overprint

The Black overprint (for Pure Black) option specifies whether black text, or black text and vector graphics (where
black is defined as RGB=0, 0, 0, or as CMYK=0%, 0%, 0%, 100%) print over colored backgrounds. If you turn off this
option, black text, or black text and graphics knock out colored backgrounds. Knocking out can create a white edge
around objects, or a white space, caused by the misalignment of color plates.

Note: You can set Black overprint (for Pure Black) only if Black text and graphics is set to Pure Black On.
The Black overprint (for Pure Black) option has the following settings:

• Text - Black text overprints colored backgrounds, eliminating white gaps and reducing the halo effect from
misregistration of colors.

• Text/Graphics - Black text and graphics overprint colored backgrounds, eliminating white gaps and the halo
effect from misregistration of colors.

• Off - Black text and graphics knock out colored backgrounds.

Note: PostScript applications may perform their own black overprint conversions before printing.
An example of how you might use this setting is a page that contains black text on a light blue background. The
background blue is CMYK=40%, 30%, 0%, 0%. The black text is CMYK=0%, 0%, 0%, 100%.

• With Black overprint (for Pure Black) set to Text or Text/Graphics, the final text or graphic portions of the page
are overprinted, or combined with the underlying color. Black colors generated by applications (for example,
RGB=0, 0, 0 or CMYK=0%, 0%, 0%, 100%) are printed using black only. This means that black text and line art do
not exhibit halftone artifacts (as long as the printer is calibrated correctly). No transition in cyan and magenta
occurs and the quality of the output is improved, because it does not show artifacts near the edges of text.

• With Black overprint (for Pure Black) set to Off, the border of the text or graphic is on an edge that has cyan and
magenta on one side (outside the object) and black on the other side (inside the object). This transition may
cause visible artifacts due to the practical limitations of the printer.

Note: The reproduction of CMYK components is affected by the CMYK Source setting and calibration when CMYK
is not 0%, 0%, 0%, 100%.

Black point compensation

The Black point compensation option lets you control the output quality of shadow areas for CMYK source colors.
Black point compensation works by scaling the source colors so that the darkest point in the source profile maps to
the darkest point in the output profile. Use Black point compensation to enhance details in shadows when the
CMYK source space is larger than the gamut of the printer. In proofing applications, when the CMYK source space
is smaller than the gamut of the printer, do not use this option.

Note: For RGB source colors, black point compensation is always applied to Relative Colorimetric. Black point
compensation does not apply to Absolute Colorimetric. Photographic already scales the saturated colors and shadow
detail to the color capabilities of the output device, so black point compensation is not relevant.
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Black text and graphics

The Black text and graphics option affects black text and vector graphics. When you set this option to Pure Black On,
the black generated by applications (RGB=0, 0, 0 or CMYK=0%, 0%, 0%, 100%) is printed using black only.
With Black text and graphics set to Pure Black On, black text and line art are not misregistered, since only one
colorant is used. This setting also eliminates blasting, which is an undesirable effect that occurs when excess
amounts of ink or toner, combined with certain types of paper stock, cause objects to spread beyond their defined
boundaries.
For some jobs, we recommend setting Black text and graphics to Normal. For example, if a job includes gradient fills
that use black, the Normal setting gives the best result.
If you set Black overprint (for pure black) to Text or Text/Graphics, Black text and graphics must be set to Pure Black
On.

Note: Use Black text and graphics only when printing composites, not separations.
The following table describes the behavior of Black text and graphics with black defined in different color spaces.

Color Black text and graphics = Normal Black text and graphics = Pure Black On
or Rich Black On

RGB=0,0,0 (all other RGB
values are unaffected by Black
text and graphics)

Printed according to the definition for
RGB=0,0,0 in the output profile. This may
be a rich black (one that uses multiple
colorants) if the output profile specifies a
rich black, or K-only if the output profile
specifies K-only for RGB=0,0,0. The output
is affected by calibration.

Printed as 100% K (Pure Black On) or 100%
K plus 50% Cyan (Rich Black On) using
black and cyan.

CMYK=0%,0%,0%,100% (all
other CMYK values are
unaffected by Black text and
graphics)

Printed as K-only or as a rich black using all
colorants, depending on the CMYK source
and CMYK rendering intent settings.

If CMYK rendering intent is set to Pure
Primaries, or if CMYK source is set to Bypass
Conversion, CMYK=0%,0%,0%,100% prints
as 100% K and the amount of black is
limited by the CMYK source profile and
calibration.

If CMYK rendering intent is set to Relative
Colorimetric, CMYK=0%,0%,0%,100% is
printed as a rich black using all colorants
according to the output profile. The output
is affected by calibration.

Note: Setting CMYK source to ColorWise
OFF disables the CMYK Source profile and
calibration. In this case, the black is not
limited by calibration.

Printed as 100% K (Pure Black On) or 100%
K plus 50% Cyan (Rich Black On) using
black and cyan, regardless of the CMYK
source and CMYK rendering intent settings.
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Color Black text and graphics = Normal Black text and graphics = Pure Black On
or Rich Black On

Spot colors (unaffected by Black
text and graphics)

Standard spot color processing Standard spot color processing

Note: PostScript applications may convert elements defined as RGB=0, 0, 0 to four-color CMYK black before
sending the job to the Fiery ES. These elements are not affected by the Black text and graphics option.

CMYK rendering intent

The CMYK rendering intent option specifies a rendering intent for color conversion. This conversion can be
optimized for the type of color image being printed.
To control the appearance of content in CMYK colors, select the appropriate rendering intent. The Fiery ES allows
you to select from the four rendering intents currently found in industry-standard ICC profiles, and provides support
for a fifth rendering intent, Pure Primaries, that is exclusive to the Fiery ES.

Note: If you experience tone reproduction problems, use the Photographic setting.

Rendering intent Best used for Equivalent ICC rendering intent

Photographic - Typically
results in less-saturated output
than presentation rendering
when printing out-of-gamut
colors. This style preserves
tonal relationships in images.

Photographs, including scans and images
from stock photography CDs and digital
camera images.

Image, Contrast, and Perceptual

Presentation - Creates
saturated colors but does not
match printed colors precisely
to displayed colors. In-gamut
colors, such as flesh tones, are
rendered well. This style is
similar to the Photographic
rendering intent.

Artwork and graphs in presentations. This
style can be used for mixed pages that
contain presentation graphics and
photographs.

Saturation, Graphics

Relative Colorimetric - Provides
white point transformation
between the source and
destination white points. For
example, the bluish-white color
(gray) of a monitor is replaced
by paper white. This style
avoids visible borders between
blank spaces and white objects.

Advanced use when color matching is
important, but you prefer white colors in the
document to print as paper white. This style
may also be used with PostScript color
management to affect CMYK data for
simulation purposes.

Relative Colorimetric
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Rendering intent Best used for Equivalent ICC rendering intent

Absolute Colorimetric -
Provides no white point
transformation between the
source and destination white
points. For example, the bluish-
white color (gray) is not
replaced by paper white.

Situations when exact colors are needed and
visible borders are not distracting. This style
may also be used with PostScript color
management to affect CMYK data for
simulation purposes.

Absolute Colorimetric

Pure Primaries - Uses pure
colorants, free from
contaminating colorants that
are introduced when color
management tries to match the
appearance of a color on image
systems with different color
capabilities.

When source content is made up of one or
two process colorants, they remain as one or
two process colorants in the final print. This
rendering intent does not achieve
colorimetric accuracy, and content is not
expected to match that of other print
systems.

Pure Primaries

Device link profiles

To be selected for a print job, a device link profile must reside on the Fiery ES and be associated with a specific
source profile and output profile.
When you select the source profile and output profile settings associated with a device link profile, the Fiery ES
bypasses its normal color management and applies the device link conversion to the color data in the job. The source
profile and the output profile are not used.
Profiles that do not reside on the Fiery ES do not appear as settings. A device link profile that is not associated with a
source profile setting and an output profile setting cannot be selected for a job. Therefore, even though the source
profile and output profile that are associated with a device link profile are not used to calculate color conversions,
they must reside on the Fiery ES.
Device link profiles are disabled when certain Color input settings have been specified. See the table below:

RGB-CMYK device link CMYK-CMYK device link

Use RGB embedded profile Use CMYK embedded profile

RGB rendering intent CMYK rendering intent

Note: In Fiery system software FS200/200 Pro and earlier, CMYK Processing Method

Print RGB gray using black only Print CMYK gray using black only

Black point compensation
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Combine separations

The Combine separations option specifies how to print separated CMYK data.
You can combine Cyan, Magenta, Yellow, and Black separations.

• Off - Prints each separation individually.

• On - Combines separations as a single, composite-color document, and automatically sets the following print
options: Color mode (CMYK) and Black overprint (Off).

The results of combining the multiple plates are predictable and accurate, regardless of the original application used.
This feature also fully supports DCS 2.0 file formats when included in a PostScript print job from a page-layout
application.
The following applications have been tested with Mac OS and Windows for compatibility with the Combine
separations option:

• Adobe Illustrator

• Adobe InDesign

• Adobe PageMaker

• QuarkXPress

Note: You cannot use Combine separations at the same time that you use the following features: Substitute colors,
Composite overprint, Postflight, or Black overprint.

Composite overprint

The Composite overprint print option allows you to print overprinted objects as specified in the source file.
When overlapping objects are printed, the foreground object can either overprint or knock out the background
object. With overprinting, the color of the background object shows through the foreground object where they
overlap, and the resulting color is a combination of the colors of the two objects. With a knockout, the foreground
object hides the background object where they overlap.

• Off - An overprinted object knocks out a background object.

• On - The area of overlap between two overprinted objects is a blend of the two colors.

Note: The Composite overprint option does not overprint the foreground object if it is an RGB object.
The Composite overprint print option is supported for PostScript and PDF jobs produced by the following
applications:

• Adobe Acrobat

• Adobe Illustrator

• Adobe InDesign

• QuarkXPress

• CorelDRAW

You cannot use Composite overprint at the same time that you use Combine separations.
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If Composite overprint is turned on for a job that contains spot colors, Spot-On must be activated on the Fiery ES.

Grayscale rendering intent

The Grayscale rendering intent option specifies a rendering intent for color conversion. This conversion can be
optimized for the type of gray objects being printed.
To control the appearance of text, graphics, and images in grayscale, select the appropriate rendering intent. The
Fiery ES allows you to select from the four rendering intents currently found in industry-standard ICC profiles.

Note: If you experience tone reproduction problems, use the Photographic setting.

Rendering intent Best used for Equivalent ICC rendering intent

Photographic - Typically
results in less-saturated output
than presentation rendering
when printing out-of-gamut
colors. This style preserves
tonal relationships in images.

Photographs, including scans and images
from stock photography CDs and digital
camera images.

Image, Contrast, and Perceptual

Presentation - Creates
saturated colors but does not
match printed colors precisely
to displayed colors. In-gamut
colors, such as flesh tones, are
rendered well. This style is
similar to the Photographic
rendering intent.

Artwork and graphs in presentations. This
style can be used for mixed pages that
contain presentation graphics and
photographs.

Saturation, Graphics

Relative Colorimetric - Provides
white point transformation
between the source and
destination white points. For
example, the bluish-white color
(gray) of a monitor is replaced
by paper white. This style
avoids visible borders between
blank spaces and white objects.

Advanced use when color matching is
important, but you prefer white colors in the
document to print as paper white.

Relative Colorimetric

Absolute Colorimetric -
Provides no white point
transformation between the
source and destination white
points. For example, the bluish-
white color (gray) is not
replaced by paper white.

Situations when exact colors are needed and
visible borders are not distracting.

Absolute Colorimetric
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ImageViewer Curves

The ImageViewer Curves print option lets you apply color curve edits from ImageViewer that have been saved on the
server as a preset.
ImageViewer in Command WorkStation can be used to edit the CMYK curves of a job on the Fiery ES. These curve
edits can be saved as a preset and applied to other jobs. Use the ImageViewer Curves option to select a preset for
your job.
Factory-supplied curve edits apply some typical color corrections:

• No correction

• Lighter highlights

• Midtone boost

• Shadow detail

• Reduce C (cyan) cast

• Reduce M (magenta) cast

• Reduce Y (yellow) cast

After the job is processed, the edits become part of the job and are no longer visible as edits when you view the job in
ImageViewer.

Optimize RGB transparency

The Optimize RGB transparency option corrects color errors that can occur in jobs that contain transparent RGB or
Lab objects.
Optimize RGB transparency affects jobs with the following characteristics:

• The job is in PDF format (submitted to the Fiery ES as a PDF file, not submitted by printing from an application).

• The job contains transparent RGB or Lab objects. They might be objects that you specified as transparent using
an application that supports this capability, or they might be objects with a special effect, such as a drop shadow,
that uses transparency to achieve the effect.

• The transparent objects overlap, creating an area of mixed color.

If you turn on Optimize RGB transparency, the Fiery ES uses the correct RGB source profile and rendering intent
when converting the overlapping RGB colors to CMYK during the PDF-to-PostScript conversion. If you turn off
Optimize RGB transparency, the area of overlapping colors might print with incorrect color or undesirable artifacts.
Optimize RGB transparency can result in a longer processing time, especially for variable data printing (VDP) jobs
that contain multiple individual PDF pages. We recommend that you turn on Optimize RGB transparency only when
necessary to achieve correct color output.
You can specify Optimize RGB transparency for a job in Job Properties in Command WorkStation, Hot Folders, or a
virtual printer.
When you print from the printer driver, the Optimize RGB transparency option does not appear because jobs printed
from the printer driver are always submitted to the Fiery ES as PostScript jobs, which are not affected by Optimize
RGB transparency.
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Output profile

The Output profile print option specifies the output profile used to process a job. Color data in a print job is
converted to the color space of the printer, which is described by the output profile.
In addition, the calibration that is associated with the output profile is applied to the job before printing.
The Fiery ES includes one or more default output profiles, each created for a specific media type. You can also
import your own output profiles to the Fiery ES.

Use job defined settings

Rather than select a specific output profile for your job, you can let the Fiery ES determine the output profile
automatically. The color mode and media type used in the print job determine the profile, or if the job uses media
from Paper Catalog, the output profile specified in Paper Catalog is used.

Note: Because only one output profile is supported for the Fiery ES, all available media are tied to the one available
profile. The Use job defined settings option is not available.

Device link profiles

If a CMYK-to-CMYK or RGB-to-CMYK device link profile is available for the specified output profile and source
profile, Device link profile selected is displayed below the Output profile drop-down list box. When a device link
profile has been selected, the specific device link profile name is displayed below the Source profile drop-down list
box. The other source settings in the area are disabled as they are not applicable in the device link profile workflow.
In this case, the selected output profile is not used for color management, since the device link profile is used.

Print RGB/CMYK using gray only

When the Print RGB gray using black only option is turned on, any RGB color that has equal R, G, and B values is
printed as K-only black instead of CMYK black. Similarly, when Print CMYK gray using black only is turned on, any
CMYK color where C, M, and Y are 0 (zero), and K is any value is printed as K-only black instead of CMYK black.
You can turn on Print RGB gray using black only or Print CMYK gray using black only for either Text/Graphics or
Text/Graphics/Images. "Graphics" refers to vector graphics. "Images" refers to bitmap images.

Note: You can also turn on Print gray using black only for the Grayscale source profile, with the same options of
Text/Graphics and Text/Graphics/Images.
The following limitations apply:

• The Print RGB gray using black only and Print CMYK gray using black only options have no effect on a job that is
sent as separations.

• If CMYK rendering intent is set to Pure Primaries, Print CMYK gray using black only does not affect the output.

• If Separate RGB/Lab to CMYK source is turned on, Print RGB gray using black only is turned off. Likewise, if Print
RGB gray using black only is turned on, you cannot turn on Separate RGB/Lab to CMYK source.

• If Black Text and Graphics is set to Pure Black On or Rich Black On, it takes precedence over Print RGB gray using
black only and Print CMYK gray using black only for 100% black text and graphics.

• If a gray is specified as a spot color, Print RGB gray using black only and Print CMYK gray using black only do not
affect that gray.
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RGB rendering intent

The RGB rendering intent option specifies a rendering intent for RGB/Lab-to-CMYK color conversion. This
conversion can be optimized for the type of color image being printed.
To control the appearance of images, such as prints from office applications or RGB photographs from Adobe
Photoshop, select the appropriate rendering intent. The Fiery ES allows you to select from the four rendering intents
currently found in industry-standard ICC profiles.

Note: If you experience tone reproduction problems, use the Photographic setting.

Rendering intent Best used for Equivalent ICC rendering intent

Photographic - Typically
results in less-saturated output
than presentation rendering
when printing out-of-gamut
colors. This style preserves
tonal relationships in images.

Photographs, including scans and images
from stock photography CDs and digital
camera images.

Image, Contrast, and Perceptual

Presentation - Creates
saturated colors but does not
match printed colors precisely
to displayed colors. In-gamut
colors, such as flesh tones, are
rendered well. This style is
similar to the Photographic
rendering intent.

Artwork and graphs in presentations. This
style can be used for mixed pages that
contain presentation graphics and
photographs.

Saturation, Graphics

Relative Colorimetric - Provides
white point transformation
between the source and
destination white points. For
example, the bluish-white color
(gray) of a monitor is replaced
by paper white. This style
avoids visible borders between
blank spaces and white objects.

Advanced use when color matching is
important, but you prefer white colors in the
document to print as paper white. This style
may also be used with PostScript color
management to affect CMYK or RGB data
for simulation purposes.

Relative Colorimetric

Absolute Colorimetric -
Provides no white point
transformation between the
source and destination white
points. For example, the bluish-
white color (gray) is not
replaced by paper white.

Situations when exact colors are needed and
visible borders are not distracting. This style
may also be used with PostScript color
management to affect CMYK or RGB data
for simulation purposes.

Absolute Colorimetric
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RGB source, CMYK source, and Grayscale source

The RGB source, CMYK source, and Grayscale source print options allow you to define the color spaces of the RGB,
CMYK, and grayscale data, respectively, in your document so that the appropriate color conversion occurs on the
Fiery ES.
Commonly used color spaces are available on the Fiery ES. For others, you can import CMYK and RGB custom
profiles to the Fiery ES. Custom grayscale profiles cannot be imported.

RGB/Lab source

When you specify a profile for RGB source, the Fiery ES overrides source color space definitions or profiles that other
color management systems may have specified. For example, if your document contains an embedded RGB profile,
the RGB source setting overrides it.
When you specify an RGB source profile, the output from the Fiery ES is consistent across platforms. The RGB
source options are as follows:

• EFIRGB - Specifies an EFI-defined color space recommended for users who have no detailed information about
their RGB data.

• sRGB (PC) - A Microsoft and Hewlett-Packard recommended color space designed for typical home and office
applications.

• Apple Standard - Specifies the color space of an older Mac OS computer monitor.

• Adobe RGB (1998) - An Adobe-defined color space, used in some prepress workflows as the default working
space for Adobe Photoshop.

• eciRGB v2 - The European Color Initiative (ECI) recommended space for use as an RGB working color space and
color data exchange format for ad agencies, publishers, reproduction, and printing houses.

• Fiery RGB v5 - An EFI-defined color space recommended for users of office applications. This color space is
similar to EFIRGB but is larger and can provide a more desirable blue output.

In cases where you do not want RGB source to override another specified source color space, select the Use RGB
embedded profile option.
If the Use RGB embedded profile option is enabled, the Fiery ES honors objects in the document with RGB profiles,
and objects without profiles are color managed with the RGB source profile from Job Properties.

CMYK source

The CMYK source option can be set to any CMYK source profile that is present on the Fiery ES.
To properly manage color in a printed image that was separated using an ICC profile, the same profile must be
specified for printing the image.
The CMYK source profile setting you specify depends on the CMYK profile or press standard for which the CMYK
data was separated. This option affects CMYK data only.

• For images that were separated using a custom separation (such as a separation produced with an ICC profile),
select the profile used for RGB to CMYK conversions in the prepress workflow on the Fiery ES with the CMYK
source setting.

• For images that were separated for a press standard, select the press standard as the CMYK source setting.

If the job contains an embedded CMYK profile, select the Use CMYK embedded profile option. The embedded
profile is applied to CMYK data.
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The CMYK source option can be set to any CMYK source profile that is present on the Fiery ES.
If you do not want CMYK data in a job to be converted to the output color space, you can select one of the following
settings:

• Bypass conversion - This setting sends the original CMYK data in the job to the printer without conversion, but
with calibration applied.

• ColorWise OFF - This setting sends the original CMYK data in the job to the printer without calibration applied
and without converting the CMYK data. The CMYK data is still subject to the total ink or toner limit, however.
The ColorWise OFF setting is available for a specific job but it cannot be the default setting on the Fiery ES. You
select this setting for a specific job.

Note: When you print with the ColorWise OFF setting, make sure that the options you choose in your application
do not cause the application to modify CMYK data. You must specify no color management in the application
when you print with the ColorWise OFF setting.

Grayscale source

The Fiery ES supports separate processing of jobs with Device Gray and ICC Based Grayscale through their own
color conversion. For FS200/FS200 Pro and earlier, the grayscale color spaces were processed through the CMYK
color path.
The Grayscale source profile setting provides factory-installed grayscale profiles to use for source-to-output profile
color conversion. Users cannot import their own grayscale ICC profiles.
If the job contains an embedded profile associated to grayscale objects in the document, select the Use Gray
embedded profile option.
The Grayscale source option can be set to any of the factory-installed grayscale source profiles that are present on
the Fiery ES.

Separate RGB/Lab to CMYK source

The Separate RGB/Lab to CMYK source option determines how RGB colors (as well as Lab and XYZ colors) are
converted to CMYK. This option defines the color spaces that are used by the Fiery ES to separate the RGB data into
CMYK values.

• When Separate RGB/Lab to CMYK source is turned on, all RGB colors are first converted to the CMYK color
space defined by the CMYK source print option before being converted to the CMYK color space of the printer
(as defined by the Output profile print option). The result is a simulation of the RGB colors that would be output
from a printer with the characteristics defined by the CMYK source profile.
With Separate RGB/Lab to CMYK source, for example, if a high-quality ICC profile is available for another
printer, your printer can simulate the behavior of that other printer.

• When Separate RGB/Lab to CMYK source is turned off, all RGB colors are converted directly to the CMYK color
space of the printer (as defined by the Output profile print option).
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Spot color matching

The Spot color matching option provides automatic matching of spot colors with their best CMYK equivalents.

• On - The Fiery ES uses a built-in table to generate the closest CMYK matches of spot colors your printer can
produce. (New tables are generated when you add new output profiles.)
With Spot-On, the Fiery ES uses the CMYK matches determined through Spot-On.

• The Use spot group menu allows you to select a spot color group that Fiery ES searches first for spot color
definitions during file processing. When new spot color groups have been created in Device Center > Resources >
Spot Colors, the new groups are listed in the Use spot group menu. If a spot color is not found in the selected list,
the Fiery ES searches all other spot color groups for a matching spot color name. If the name is not found, the
spot color is rendered with the alternate color in the document.

• Off - The Fiery ES processes spot colors as CMYK data and uses the alternate color space provided by the spot
color. By default, most applications use the CMYK equivalents defined by the spot color manufacturer, such as
PANTONE. These are the same CMYK equivalents used by applications that include spot color libraries.

Note: Spot colors that are not included in the built-in table are processed with the Alternate Color Space.
For jobs that include spot colors, turn Spot color matching on unless you are printing press simulations. In that case,
turn Spot color matching off and select the appropriate CMYK source.
For PDF and PostScript jobs that include spot colors that are not in the built‑in table, turning Spot color matching
on causes the alternate color space to be used. The Fiery ES references the built‑in table to generate the closest
CMYK matches of the original spot color.

Note: Use Spot color matching only when printing composites, not when printing separations.

Substitute colors

Substitute colors are colors that, when called for in a document by their RGB or CMYK values, are substituted with a
different color that is defined in the Spot-On color dictionary. This permits exact color control and overrides
individual RGB and CMYK colors.
Spot-On allows you to create a list of substitute colors. To enable substitute colors for a job, turn on the Substitute
colors option.

Note: You cannot use Substitute colors at the same time that you use Postflight.
When you use Substitute colors at the same time that you use Spot color matching, be sure that the CMYK color
that you want to replace with a substitute color is not a CMYK color that is also defined as a spot color. Otherwise,
the spot color may be replaced with the substitute color, which may not be the result that you expect.
For more information about creating and using substitute colors, see Command WorkStation Help.
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Use embedded profile

You can specify whether the Fiery ES uses the source profile (either RGB or CMYK or grayscale) that is embedded in
the print job rather than the source profile specified in the print settings.

RGB

If you turn on Use RGB embedded profile, the Fiery ES ignores the RGB source option and uses the RGB profile
embedded in the print job (if any) as the RGB source profile. If you turn off this option, the Fiery ES uses the profile
specified in the RGB source option.

CMYK

If you turn on Use CMYK embedded profile, the Fiery ES ignores the CMYK source option and uses the CMYK profile
embedded in the print job (if any) as the CMYK source profile. If you turn off this option, the Fiery ES uses the
profile specified in the CMYK source option.

Grayscale

If you turn on Use Gray embedded profile, the Fiery ES honors the embedded grayscale profile information for
objects tagged with a grayscale profile and uses the source grayscale profile for gray objects without a grayscale
profile.

Where to specify color print options

You can set color print options for all jobs by setting the default values on the Fiery ES. You can set the color print
options for a specific job to different values if the default values are not what you want for the job.
You specify default values for color print options in Color Setup in Command WorkStation. You can also set default
values from Fiery ES Setup, as described in Configuration and Setup. The defaults apply to all subsequent print jobs
unless you override them.

Note: A job uses the Fiery ES default settings at the time it is sent to the Fiery ES Hold queue, not at the time the job
is processed for printing.
How you set specific color print options for a particular job depends on how you submit the job to the Fiery ES.

• When you print a job from an application through the printer driver, specify color print options using the
settings that appear in the printer driver.
The printer driver sends a PostScript file to the Fiery ES that incorporates the settings for the color print options
you selected.

• When you print a job through Hot Folders or a virtual printer, specify color print options in the Job Properties
settings. These settings override the default settings on the Fiery ES.

• When a job is in the Hold queue of the Fiery ES, specify color print options through the Job Properties settings in
Command WorkStation. These settings override the default settings on the Fiery ES.
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The following color print options are located in both (1) the Color tab of the printer driver or Job Properties and (2)
in Color Setup in Device Center:

• Auto trapping

• Black overprint (for pure black)

• Black point compensation

• Black text and graphics

• CMYK rendering intent

• CMYK source or device link

• Combine separations

• Composite overprint

• Grayscale rendering intent

• Grayscale source

• Optimize RGB transparency (Job Properties only)

• Output profile

• Print CMYK gray using black only

• Print gray using black only

• Print RGB gray using black only

• RGB rendering intent

• RGB source or device link

• Separate RGB/Lab to CMYK source

• Spot color matching

• Substitute colors

• Use CMYK embedded profiles

• Use Gray embedded profiles

• Use RGB embedded profiles

Print from an application

To print from an application, you use the printer driver for your operating system (Windows or Mac OS).

• For information about how to install the printer driver, set up the Fiery ES for printing, and set print options
with the printer driver, see Printing.

• When you print a job from a Mac OS application using the printer driver, you must also set color-management
print options appropriately.
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Print with color settings in Mac OS

When you print a job from a Mac OS application using the printer driver, you must set color-management print
options appropriately.

1 Select Print in your application.

2 Expand the dialog box, if necessary, by clicking the arrow next to the Printer name.

3 Click Preview, select Color Matching from the drop-down list, and then click In Printer.

4 Set other print options as needed, and then click Print to send your job.
For information about how to set print options with the printer driver for Mac OS, see Printing.
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Color profiles

The Fiery ES includes by default a number of RGB and CMYK profiles that you can use for printing through the RGB
Source, CMYK/Grayscale Source, and Output Profile settings for a job.
You can manage the profiles on the Fiery ES with Profile Manager in Command WorkStation, which allows you to
import ICC profiles to the Fiery ES, export profiles, delete profiles (except for default profiles), and set the properties
of profiles. You can also create custom CMYK source or output profiles by editing an existing profile and saving it as
a new profile.
You can install (copy) additional ICC profiles from the User Software DVD to your computer. Use the ICC profiles
with applications that support ICC standards, such as Adobe Photoshop.

ICC profiles in the user software package

The user software package contains additional ICC profiles that you can install (copy) to your computer.

Adobe ICC Profiles folder

The Adobe ICC Profiles folder is located inside the Windows Color Files\Legacy\ICC Profiles folder or Mac Color Files/
Legacy/ICC Profiles folder.
The profiles in this folder were created by Adobe Systems, Inc. For more information, see the documents included in
the folder.
CMYK Profiles:

• CoatedFOGRA27.icc

• CoatedFOGRA39.icc

• CoatedGRACoL2006.icc

• JapanColor2001Coated.icc

• JapanColor2001Uncoated.icc

• JapanColor2002Newspaper.icc

• JapanColor2003WebCoated.icc

• JapanWebCoated.icc

• UncoatedFOGRA29.icc

• USWebCoatedSWOP.icc

• USWebUncoated.icc

• WebCoatedFOGRA28.icc
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• WebCoatedSWOP2006Grade3.icc

• WebCoatedSWOP2006Grade5.icc

RGB Profiles:

• AdobeRGB1998.icc

• AppleRGB.icc

• ColorMatchRGB.icc

• PAL_SECAM.icc

• SMPTE-C.icc

• VideoHD.icc

• VideoNTSC.icc

• VideoPAL.icc

ECI folder

The ECI folder is located inside the Windows Color Files\Legacy\ICC Profiles folder or Mac Color Files/Legacy/ICC
Profiles folder.
The profiles were created by the European Color Initiative (ECI). For more information, see the documents included
in the CMYK Profiles and RGB Profiles folders, as well as the ECI web site at www.eci.org.
CMYK Profiles:

• ISOcoated_v2_300_eci.icc

• ISOcoated_v2_eci.icc

• ISOuncoatedyellowish.icc

• PSO_Coated_300_NPscreen_ISO12647_eci.icc

• PSO_Coated_NPscreen_ISO12647_eci.icc

• PSO_LWC_Improved_eci.icc

• PSO_LWC_Standard_eci.icc

• PSO_MFC_Paper_eci.icc

• PSO_SNP_Paper_eci.icc

• PSO_Uncoated_ISO12647_eci.icc

• PSO_Uncoated_NPscreen_ISO12647_eci.icc

• SC_paper_eci.icc

EFI Support folder

The EFI Support folder is located inside the Windows Color Files\Legacy\ICC Profiles folder or Mac Color Files/
Legacy/ICC Profiles folder.
These profiles were created by EFI. For more information, see the General Requirements for Applications in
Commercial Offset Lithography (GRACoL) website at www.gracol.org, the Fogra website at www.fogra.org, and the
Specifications Web Offset Publications (SWOP) website at www.swop.org.
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CMYK Profiles:

• EFIEURO.icc

• EFISWOP.icc

• Enterprise CMYK.icc

• GRACoL2006_Coated1_EFI.icc

• ISOCoated.icc

• ISOCoated_FOGRA39L_EFI.icc

• ISOUncoated_FOGRA29L_EFI.icc

• SWOP2006_Coated3_EFI.icc

• SWOP2006_Coated5_EFI.icc

RGB Profiles:

• EFI Fiery RGB Chroma.icc

• EFI Fiery RGB Chroma+.icc

• EFI Fiery RGB Chroma++.icc

Note: The EFI Fiery RGB Chroma profiles are designed to provide saturated colors, especially in nighttime images,
while maintaining photographic detail. Of the three profiles, EFI Fiery RGB Chroma.icc has the least effect and EFI
Fiery RGB Chroma++.icc has the greatest effect.

• EFIRGB.ICC

• Fiery RGB v2.icc

• Fiery RGB v4.icc

• Fiery RGB v5.icc

• RGB D65 (Splash).icc

Japan Profiles:

• EFIDIC.ICC

• EFIJMPA2.icc

• EFIJMPA3.icc

• JapanColor2011Coated.icc

• JC2001_type1_EFI.icc

• JC2001_type2_EFI.icc

• JC2001_type3_EFI.icc

• JC2001_type4_EFI.icc

• TOYO Offset Coated 2.0.icc
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Add ICC profiles from the user software package

The user software package includes a number of ICC profiles that you can add to the Fiery ES:
For most ICC-aware applications, you must install the files in the Color folder (Windows) or the Library/ColorSync/
Profiles folder (Mac OS). For use with the Fiery ES, you can copy the files to a folder of your choice.

Note: On Mac OS, see the ColorSync documentation for setting ColorSync profiles, such as EFIRGB.

1 Install the profiles on your computer.

2 Use Command WorkStation to import the files to the Fiery ES.

Install ICC profiles on a Windows computer

1 Insert the User Software DVD into the DVD drive.

2 Open the folder (Windows Color Files) containing the profile.

3 Right-click the profile that you want and click Install Profile.

The profiles are installed automatically to the Windows\System32\spool\drivers\color folder on your computer.

Install ICC profiles on a Mac OS computer

You must log on with Administrator privileges.

1 Insert the User Software DVD into the DVD drive.

2 Open the folder (Mac Color Files) containing the profile.

3 Copy the profiles into Library/ColorSync/Profiles.

Color Bars folder

The Color Bars folder is located inside the Windows Color Files folder or Mac Color Files folder. These files are used
for the Control Bar feature.
The Control Bar feature is available with the optional Fiery Productivity Package.
You can copy these additional color files from the User Software DVD to your computer.

• FieryColorBar.eps

• Ugra Fogra-MediaWedge V2.2x_EFIv1.eps

• Ugra Fogra-MediaWedge V3.0a_EFIv1.eps
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Calibration

Calibrating the Fiery ES ensures consistent and reliable color output. Calibration adjusts the ink or toner densities of
a job to compensate for the difference between the expected (target) densities of the printer and the actual
(measured) densities that the printer outputs.
Periodic calibration is necessary to monitor the actual output of the printer. To calibrate the Fiery ES, you measure
the densities of printed color patches on a page.
Calibration is applied to all jobs, but you can disable it for a specific job. The ColorWise Off setting for the CMYK/
Grayscale Source option disables calibration (and color management) for CMYK data in a job. You might want to
disable calibration for testing purposes, for example.
Changing calibration has the potential to affect all jobs for all users, so consider limiting the number of people
authorized to perform calibration. Set an Administrator password to control access to calibration (see Configuration
and Setup).

Check calibration status

You can check when the Fiery ES was last calibrated in Command WorkStation.

Check the calibration status for a job

• In Command WorkStation, in Job Center, select the job.
The time of the most recent calibration is displayed in the lower-right corner.

Check the status of a specific calibration

1 In Command WorkStation, in Device Center, click the General tab, click Tools, and then click Manage (under
Calibrate).
The list of calibration settings on the Fiery ES appears in Calibrator.

2 Find the calibration in the list and check the Last calibrated value.
Default measurements indicates the factory settings, which means that the Fiery ES has not been calibrated.
You can configure Command WorkStation to optionally display a warning or suspend printing if the calibration
of a job is out of date. For more information, see the online help.
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Calibrator in Command WorkStation

You can calibrate the Fiery ES with Calibrator in Command WorkStation.
Calibrator provides a choice of measurement methods depending on the methods supported by your Fiery ES:

• ColorCal (in Command WorkStation) - Calibration method that uses the built-in scanner of the printer to
measure toner densities.
For more information about this method, see the online help.

• EFI ES-1000 or ES-2000 hand-held spectrophotometer
For more information about this method, see the online help.

• KonicaMinolta FD-5BT - KonicaMinolta FD-5BT hand-held spectrodensitometer
This method is not supported for calibrating the Fiery ES.

Multiple users can connect to one Fiery ES with Command WorkStation, but only one user at a time can use
Calibrator. If you try to calibrate when another user is using Command WorkStation to calibrate, an error message is
displayed.
Before you save calibration measurements, you can check the calibration by printing a test page to see if it prints as
you expect. It may also be helpful to print your own test page with the colors and job settings that are important to
you.
Calibrator allows you to view the calibration measurements as a graph of input versus output curves for C, M, Y, and
K.

• If the maximum measured density of a colorant is less than the target value, print a test page to check the output,
especially areas with a lot of that particular colorant.

• If the maximum measured density is greater than or equal to the target value, this is usually not a problem.

If the curves are not smooth, it may be because the printer does not print uniformly across the page. The calibrated
output may still be acceptable.
One way to check uniformity is to print a test job that covers the page with a single colorant (C, M, Y, or K) at the
percentage that you want to check. Lack of uniformity is usually visible with values between 15% and 30%. This page
must be printed without color management (CMYK Source set to Bypass Conversion). If lack of uniformity is visible,
we recommend that you calibrate using one of the sorted patch layouts, which helps to minimize banding in
gradients. However, calibration cannot fix the lack of uniformity of the printer.

Calibrate the Fiery ES with Command WorkStation

1 Start Calibrator by doing one of the following:

• In Command WorkStation, in Job Center, click the Calibrate icon.

• In Command WorkStation, in Device Center, click the General tab, click Tools, and then click Calibrate.

• In Command WorkStation, in Job Center, right-click a held job and select Calibrate job.
In this case, Calibrator automatically selects the calibration setting used by the job.
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2 Follow the procedure for your measurement instrument.
For more information, see the online help.

Calibration from the printer control panel

You can calibrate the Fiery ES from the printer control panel with ColorCal, without using Command WorkStation.
When you calibrate from the printer control panel, the measurements are applied to the calibration setting
associated with the default output profile that is selected in Color Setup.
If an Administrator or Operator password has been set, you will need it to perform calibration from the printer
control panel.
It is also possible to remove calibration measurements (and restore the default measurements) from the Fiery ES
using the printer control panel. In general, it is not necessary, because any new calibration replaces the existing one if
the same calibration setting is selected. Removing calibration affects all calibration settings.

Calibrate the Fiery ES from the printer control panel

To calibrate the Fiery ES, you print a page that contains color patches and use the printer's scanner to measure the
color patches. The measured values are saved and used for the calibration setting associated with the media that the
page was printed on.

1 When the printer is Idle, press Controller on the Machine tab to enter the Fiery Color Server display.

2 Log in as an administrator.

3 Press the Tools tab, and then press Calibrate.

4 Choose the paper source for the measurement page and press Print.
The ColorCal Calibration page is comprised of swatches of color that are measured by the printer’s scanner and
then compared to the target color values.
If scanner calibration is enabled for the Fiery ES in Calibrator preferences (in Command WorkStation), a
ColorCal Scanner page is printed as well as the ColorCal Calibration page.
We recommend that you always calibrate the scanner before calibrating the Fiery ES.

5 Retrieve the printed pages.

6 If a ColorCal Scanner page was printed, place the grayscale strip and Color Control patches according to the
instructions on the page, and press Measure to initiate the scan.

7 When the display indicates that the measurement was successful, press Continue.

8 Follow the instructions on the screen and on the ColorCal Calibration page to place the page on the glass platen
along with the grayscale strip, and press Measure to initiate the scan.

9 When the display indicates that the measurement was successful, press Continue.

10 Optionally, press Test Print to print a test page.
You can examine the test page to decide if the calibration is successful.
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11 If the calibration is successful, press Apply to save the measurements.

Managing calibration settings

Every output profile on the Fiery ES must be associated with a calibration setting. The calibration setting provides
the Fiery ES with density measurements of each of the printed colorants, for specific printing conditions (for
example, media type). This data, along with the expected density response of the printer, allows the Fiery ES to apply
corrections to color values that are sent to the printer, to achieve the calibrated output.
An output profile can be associated with only one calibration setting, but the same calibration setting can be used by
more than one output profile.
A calibration setting must be associated with at least one output profile, otherwise the calibration setting will never
be used for printing.

Output profiles and calibration settings

The Fiery ES has one or more factory-supplied output profiles. These output profiles and their associated calibration
settings may produce acceptable color quality. However, you may need to create custom calibration settings and
output profiles, depending on your situation.

Your paper Action Notes

1 Recommended paper for a factory-
supplied output profile (the paper
that the profile is based on)

Printing with the output profile
produces acceptable color. You do not
need to create a calibration setting or
custom profile.

You can find the recommended paper
for an output profile in Calibrator.

2 Paper similar to a factory-supplied
profile’s recommended paper

You might be able to use the output
profile. The print settings required for
your paper (for example, media type
and media weight) must match the
print settings required by the
recommended paper. If the color
quality is acceptable, you do not need
to create a calibration setting or
custom profile.

The output profile name usually
indicates the general type of paper (for
example, plain, coated, or heavy). You
can find the print settings required for
the recommended paper in Calibrator.

3 Paper that is similar to a factory-
supplied profile’s recommended
paper, but uses different print
settings

You might still be able to use a factory-
supplied output profile, if you create a
custom calibration setting and use it to
calibrate the Fiery ES with your paper.

You can create a custom calibration
setting in Calibrator.

4 Paper that does not yield
acceptable color with any factory-
supplied profile

You must create a custom calibration
setting and custom profile.

Use profile-generating software to
create a custom profile.

Color Printing

Calibration

33



Note: Recommended papers are chosen for color quality, as well as other factors, such as feeding reliability and
quality of transfer.

Find recommended paper and print settings

You can find the recommended paper and print settings for a particular output profile in Calibrator.

1 In Command WorkStation, in Device Center, click the Color Setup tab and click Color Management.

2 Select the output profile and note the name of the calibration setting displayed to the right.

3 In Device Center, click the General tab, click Tools, and then click Manage under Calibrate.
The list of calibration settings on the Fiery ES appears in Calibrator.

4 Select the calibration setting from the list.
The recommended paper is shown in the list and the required print settings are displayed in the calibration-
related properties.

5 Click Close to close the window.

Custom calibration settings

If you are printing on a paper that is similar to the recommended paper, but uses different print settings, you might
still be able to use the output profile, but you must create a custom calibration setting. If the color quality is
acceptable, you do not need to create a custom profile.
You can add a new calibration setting that you can then select when performing calibration. You can delete a custom
calibration setting. You cannot delete a factory-supplied calibration setting.
For information about adding a custom calibration setting, see the online help.

Custom calibration settings and output profiles

If you determine that none of the factory-supplied output profiles produces acceptable color with your paper, you
must create a custom calibration setting in Calibrator and a custom profile using profile-generating software.
To create a custom calibration setting, you print a page of color patches on the Fiery ES using your paper and
measure the page with Calibrator.
If Fiery Color Profiler Suite is installed on your computer, you can start it from within Calibrator to create a custom
output profile immediately after creating a custom calibration setting.

Note: Before creating a custom calibration setting and custom output profile, make sure that the printer is calibrated
(if calibration is supported on the printer). For information about performing printer calibration, see the
documentation that accompanies the printer.

Color Printing

Calibration

34



Understanding calibration

Calibration generates adjustments to ink or toner densities that account for the difference between the actual
densities (measurements) and the expected response (target).

• Measurements represent the actual color behavior of the printer.

• Calibration settings contain sets of measurements that represent the output for specific printing conditions, such
as media and print options.

• Each calibration setting is associated with a calibration target that describes the expected behavior of the printer.

After you calibrate the Fiery ES for a specific calibration setting, the measurements are stored. These measurements
are used to adjust output densities when you print with the output profile associated with the calibration setting.
Although the needs of most users are met by the default calibration setting, the Fiery ES allows you to select a
calibration setting to customize calibration for specialized jobs.
Every output profile has an associated calibration setting. If you have not specified one, the calibration setting
associated with the default output profile is used.

How calibration works

Success in obtaining satisfactory print quality from the Fiery ES depends on many factors. Among the most
important are establishing and maintaining optimal ink or toner densities. The density is the measure of the light
absorbed by a surface. By carefully regulating densities, you obtain consistent printed color from print run to print
run.
Calibration allows you to:

• Maximize the color reproduction capabilities of the Fiery ES.

• Ensure consistent color quality from print run to print run.

• Produce consistent output across more than one Fiery ES.

• Achieve better color matches when reproducing spot colors, such as PANTONE colors or other named color
systems.

• Optimize the Fiery ES for using ColorWise rendering intents, CMYK simulations, and ICC profiles.

Even with a calibrated system, ink or toner density is affected by the settings of the printer, humidity, and
temperature. Density also tends to drift over time. Uneven density on paper affects calibration results. Regular
measurement detects day-to-day variations in density, gradation, and color reproduction, and calibration corrects
them.
Calibration works by calculating adjustments that compensate for the difference between actual (measured) and
desired (target) density values. These calibration adjustments are often depicted as mathematical curves for each of
the colorants.

When to calibrate

Calibrate the Fiery ES at least once a day, depending on the volume of print jobs. If it is very important to maintain
consistent color, or your printer is subject to wide fluctuations in temperature or humidity, calibrate every few hours.
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For optimal performance, calibrate whenever there is a noticeable change in print quality or printing results are not
as expected.
If you must split a print job into two or more batches to print at different times, it is important to calibrate before
you print each batch. You should also calibrate the Fiery ES after printer maintenance or printer calibration.
However, because the printer may be less stable immediately after maintenance, wait until you have printed
approximately 50 pages before you calibrate.

Note: Because output from the printer is very sensitive to changes in temperature and humidity, do not install the
printer near a window, in direct sunlight, or near a heater or air conditioner. Paper is also sensitive to climate
changes. Store it in a cool, dry, stable environment, and keep reams sealed until they are used.
To monitor print quality, print a color reference page. A good reference page includes fully saturated color patches
and pale tints of cyan, magenta, yellow, and black. Images with skin tones offer a good basis for comparison. Save and
periodically compare the pages you print. If a noticeable change in appearance occurs, calibrate the Fiery ES.
When you examine the reference page, all color patches should be visible, even though they may be very faint in the
five to two percent range. Each patch set should show uniform gradation from patch to patch as the color lightens
from 100% to zero.
If the solid density patches (100% cyan, magenta, yellow, or black) look less saturated over time, show the pages to
your service technician to determine whether adjusting the printer can improve output.
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Spot-On

The Spot color matching print option automatically matches spot colors with their best CMYK equivalents so that
spot colors can be simulated using the CMYK colors. However, you may want to adjust the default CMYK
equivalents to achieve a better match for your specific printing conditions. You can modify spot colors with the
Spot-On spot color editor (Spot Colors in Command WorkStation).

Note: Spot colors are also called "named" colors because a color name is used to represent a specific CMYK value.
Spot Colors comes pre-loaded with libraries of named colors such as those from PANTONE, HKS, TOYO, and DIC.
The spot color libraries store the original colors with their device-independent definitions (Lab values). For each
output profile on the Fiery ES, the Fiery ES computes the best available CMYK reproduction of each spot color. Each
time a new profile is generated or updated, the Fiery ES automatically recalculates the best CMYK equivalents.
Spot-On supports other features related to spot colors:

• In Spot Colors, you can create a list of “substitute” colors. These are colors that, when called for in a document by
their RGB or CMYK values, are substituted with a different color having the CMYK values from the Spot Colors
color definition. This permits exact color control and overrides individual RGB and CMYK colors.
For more information, see Substitute colors on page 22.

• When a job that specifies overprinting for spot-color objects is printed with the Composite overprint print
option, Spot-On enables the correct color processing.
For more information, see Composite overprint on page 15.

Spot Colors in Command WorkStation

The Spot Colors feature is a spot color (named color) manager in Command WorkStation that allows you to edit
spot color definitions on the Fiery ES and create custom spot color definitions. Spot Colors is a part of the Spot-On
feature. If Spot-On is available for your Fiery ES and is activated on the Fiery ES, you can adjust and manage lists of
spot colors and their CMYK equivalents.
The Spot-On feature is in Command WorkStation, in Device Center, in the Spot Colors window under the Resources
tab.
You can create a list of "substitute" colors. These are colors that, when called for in a document by their RGB or
CMYK values, are substituted with a different color having the CMYK values from the Spot Colors color definition.
This permits exact color control and overrides individual RGB and CMYK colors.
For more information about Spot Colors and Substitute Colors, see Command WorkStation Help.
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How Spot-On works

Spot-On allows you to adjust and manage lists of spot colors and their CMYK equivalents. The matching lists of spot
colors and CMYK values are known as spot color dictionaries. Spot-On allows you to maintain multiple spot color
dictionaries for each output profile on the Fiery ES.
In Spot-On, you specify the job properties that you use to print a job. Based on the settings, Spot-On determines the
output profile and its associated spot color dictionary.
If you select Output profile X and redefine PANTONE 123 from 30%M to 50%M using Spot-On, the output will
reflect 50%M when you print a job with Output profile X. If you print a job with Output profile Y, you will get the
original value.
If you select Output profile X and create a custom color named "My Purple" and define it as 80%C 40%M, the Fiery
ES automatically calculates the Lab values using Output profile X and creates new CMYK values for use with Output
profile Y.
To use the Spot-On features with named colors, you must enable the Spot Color Matching print option.

Note: Spot colors that are identified by name are printed with their defined CMYK values. Edits to an output profile
made in Command WorkStation do not affect how spot colors are printed.
Any edits made to a job with the color adjustment features in ImageViewer affect all of the colors in the job,
including spot colors.

Monitor settings

This feature requires that a job be displayed with correct colors on your monitor. To display the colors correctly on
your monitor, you must set up the monitor according to the manufacturer’s recommendations, and specify the
correct monitor profile for your monitor.
Specify the following settings for the monitor:

• On the monitor: Brightness, Contrast, and Color Temperature

• In the operating system: Resolution, Refresh rate, and Number of colors

For more information about setting up the monitor and the monitor profile, see the documentation that
accompanies the monitor.
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Introduction

The Fiery® ES IC-418 includes a set of software utilities that allow you to manage the Fiery® ES IC-418, as well as the
print workflow and content of jobs on the MFP.
This document provides an overview of how to install, configure, and use the following Fiery® ES IC-418 utilities:

• Fiery Command WorkStation monitors and manages the print workflow of jobs on the Fiery® ES IC-418.

• Fiery Preview provides a soft proof of each sheet surface of a job before it is processed. The visual interface
changes dynamically to display any changes made in preparing documents for printing.

• Fiery JobMaster provides advanced PDF-based tools for tab insertion, scanning, page numbering, chapter
creation, and late stage editing.

• Fiery Impose applies imposition layouts to jobs for custom printing, binding, and trimming.

• Fiery Compose defines the chapter divisions of a job, specifies ranges of pages on varying types of media, inserts
blank media between pages, and inserts tab media containing text labels.

• Fiery Productivity Package offers additional color and production features for operators (or users with Operator
or Administrator privileges) to monitor and manage the print workflow of jobs.

• Fiery Remote Scan retrieves a scan on the printer from a remote computer on the network. Includes the Scan
TWAIN plug-in module.

• Fiery Hot Folders provide a simple and automated method of sending print jobs to the Fiery® ES IC-418 across
the network by allowing documents to be dropped into a folder associated with preset print options.

• Fiery JobFlow provides a browser-based prepress workflow that allows operators to define and automate
repetitive tasks such as PDF conversion, preflight, correction of PDF files, image enhancement, document
imposition, job ticketing, and approval.

• WebTools manages your Fiery® ES IC-418 remotely from the Internet or your company intranet.

For information about using color management, see Color Printing.

For information about Fiery Productivity Package, see Fiery Productivity Package.

Terminology, conventions, and documentation resources

This document uses the following terminology and conventions to refer to the Fiery® ES IC-418, printer, and
supported operating systems.

Term or convention Refers to

Aero Fiery ES (in illustrations and examples)

Command WorkStation Fiery Command WorkStation
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Term or convention Refers to

Printer MFP

Fiery ES Fiery® ES IC-418

Mac OS All supported Mac operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Windows All supported Windows operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Warning: A warning concerning operations that may lead to death or injury to persons if not performed
correctly. To use the equipment safely, always pay attention to these warnings.

Caution: A caution concerning operations that may lead to injury to persons if not performed correctly. To
use the equipment safely, always pay attention to these cautions.

Important: Operational requirements and restrictions. Be sure to read these items carefully to operate the
equipment correctly, and avoid damage to the equipment or property.

The following documentation resources are available for the Fiery® ES IC-418.

Resource Description

User documentation Documents in this set: Color Printing, Configuration and Setup, Fiery Productivity Package,
Printing, Utilities

Online help • Help can be accessed directly from each Fiery application or by going to help.efi.com.

• Each help system is available as a printable PDF, accessed from the PDF icon in the upper right
corner of the Help window.

Additional reference
material • Fiery Color Reference - help.efi.com/ref/colorref/en-us/

• Variable Data Printing - help.efi.com/ref/vdp/en-us/

• Workflow Examples - help.efi.com/ref/workflows/en-us/

• Configure Help - help.efi.com/configure/3.0/en-us/

Utilities
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Installing user software

You can install Fiery ES user software on Windows and Mac OS computers.
Install user software:

• From the User Software DVD

• From the Fiery ES, using the Internet or intranet

Note: Fiery JobFlow is supported on Windows computers only.
If earlier versions of Fiery ES user software are installed on your computer, the installer allows you to uninstall those
applications before installing new software.

Note: When you upgrade user software, use the Fiery User Software Installer and follow the instructions by selecting
Modify.
For more information, see Modify user software from media on page 8.
If you do want to uninstall an earlier version of user software, you may want to back up your settings. Back up and
restore of Fiery ES resources and settings is available from Command WorkStation. For more information, see
Configuration and Setup and Command WorkStation Help.
After first-time installation of Fiery ES user software, updates are managed by the Fiery Software Manager
application. For information, see Using Fiery Software Manager on page 10.

Note: Before installing Fiery ES user software, you must disconnect any measurement instrument from the
computer. Otherwise, after installation the instrument may not be recognized by the software.

Installing user software on a Windows computer

Before installing the software, ensure that your computer meets the minimum system requirements. For system
requirements, see Configuration and Setup.
The only applications that are not installed by the Fiery User Software Installer are Adobe Acrobat and Enfocus
PitStop, for use with Fiery Impose/JobMaster/Compose. For more information, see Fiery make-ready applications on
page 20.
Procedures describe installing from the User Software DVD, or over the Internet, and also modifying the user
software.

Install user software on a Windows computer from media

1 Insert the User Software DVD into the DVD drive of your computer.

Utilities

Installing user software

7



2 Follow the on-screen instructions.

Important: Do not attempt to install user software by opening the individual folders for the applications. To
modify or remove user software after you install it on your computer, use the Fiery User Software Installer.

Modify user software from media

1 Insert the User Software DVD into the DVD drive of your computer.

2 In the window that appears, select Modify, Repair, or Remove.

• Modify: Allows you to add new program features or remove currently installed features.

• Repair: Reinstalls all currently installed program features.

• Remove: Removes all currently installed program features.

3 Follow the on-screen instructions.
You can also install the user software from the Fiery ES over the Internet or your company intranet, using
WebTools. Ask your network administrator for the IP address of the Fiery ES.
Use your Internet browser to access WebTools. For complete information about browser and system
requirements, see Configuration and Setup.

Install user software on a Windows computer from WebTools

1 Start your Internet browser.

2 Type the IP address or DNS name of the Fiery ES.
If the home page for the printer appears instead of the WebTools page, click the WebTools link.

3 Click SOFTWARE DOWNLOADS.

4 Click the link for the software that you want to install.

5 Choose Run to open the file or choose Save to save it to your computer.
a) If you choose Save, browse to the location where you want to save the USERSWMI.exe file, and then click

Save.

b) Double-click the USERSWMI.exe file.

6 Type the Fiery ES URL, http://<IP address>, when prompted.

7 Follow the on-screen instructions.
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Uninstall user software on a Windows computer

To remove user software after you have installed it on a Windows computer, use the Fiery User Software Installer.

Note: Do not attempt to uninstall user software from the Windows Control Panel.
For information, see Modify user software from media on page 8.

Installing user software on a Mac OS computer

Installation of user software on a Mac OS computer is done separately for each application.
Note the following:

• When you initiate installation of an application, any previous version installed on the client computer is
automatically removed.

• All applications must be from the same package of software. When you initiate installation of one application
from a package, all applications on the client computer from a different package are removed. You are prompted
to re-install the applications from the new package. If necessary, you can manually uninstall the user software
using the Fiery Software Uninstaller.

Adobe Acrobat and Enfocus PitStop, for use with Fiery Impose/JobMaster/Compose are supplied with your Fiery
Impose/JobMaster/Compose kit and are installed in a separate operation. For more information, see Fiery make-
ready applications on page 20.

Note: Fiery JobFlow is not supported on Mac OS computers.
Installing and uninstalling user software on a Mac OS computer can be done from the User Software DVD, or over
the Internet or your company intranet. Ask your network administrator for the IP address of the Fiery ES.
Use your Internet browser to access WebTools on the Internet. For complete information about browser and system
requirements, see Configuration and Setup.
For information about installing printer drivers, see Printing.

Install user software on Mac OS from media

1 Insert the Fiery ES User Software DVD into the DVD drive of your computer.

2 In the User Software window, open the Mac_User_SW folder.

3 Double-click the Fiery Applications.dmg icon.

4 Double-click the icon for the application that you want to install.

5 Follow the on-screen instructions.
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Install user software on Mac OS from WebTools

1 Start your Internet browser.

2 Type the IP address or DNS name of the Fiery ES.
If the home page for the printer appears instead of the WebTools page, click the WebTools link.

3 Click SOFTWARE DOWNLOADS.

4 Click the link for the software that you want to install.

5 Double-click Fiery Applications.dmg.

6 Double-click the icon for the application that you want to install.

7 Follow the on-screen instructions.

Uninstall user software on Mac OS

1 Insert the User Software DVD into the DVD drive of your computer.

2 Double-click the icon for the Fiery Software Uninstaller.

3 Drag the Fiery Software Uninstaller icon to your Applications folder.

4 Choose Go > Applications > Fiery Software Uninstaller.

5 Select the software that you want to uninstall and follow the on-screen instructions.

Using Fiery Software Manager

Fiery Software Manager is installed automatically by the Fiery User Software Installer and manages any available
updates of the Fiery User Software.
After installation, the Fiery Software Manager icon is displayed by default on:

• Windows: In the computer system tray and also in Start > All Programs  > Fiery.

• Mac OS: In the menu bar and also in Applications.

Fiery Software Manager displays the versions of the Fiery workflow applications that are installed and a list of
available user software that can be downloaded.
You can Check for updates of the user software and specify a number of preferences for managing updates.
To specify preferences:

1 Right-click the Fiery Software Manager icon from the computer system tray (Windows) or the Menu bar (Mac
OS) and select Open Fiery Software Manager.

2 Click the Preferences icon at the bottom left of the Fiery Software Manager window.

Utilities

Installing user software

10



3 Select one of the following:

• Launch at Login (default setting): Fiery Software Manager automatically checks for updates and notifies you if
any are available.

• Show additional features:

• Install server updates for Fiery JDF (service technicians only).

• Download server language packages for additional language support.

• To install the Fiery API, download the Fiery Integration Package.

• Help EFI improve its software: Allows EFI to collect anonymous usage data from Fiery applications.
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Command WorkStation

Command WorkStation is a cross-platform application that gives operators the tools to manage jobs on the Fiery ES,
and administrators the tools to configure the Fiery ES for printing.
On the main Command WorkStation window, you can access:

• Home: A high-level status overview of your connected Fiery servers and a snapshot of print production statistics.

• Job Center: Displays the Servers list showing every Fiery ES that you are connected to. You can switch between
servers, and add or remove them from the list. Information is available about consumables on the printer and the
media loaded in each tray. Errors and alerts are also displayed.
You can view the status of jobs, preview processed jobs, and use tools for managing jobs in the print queues. You
can also search for jobs and access features from the customizable toolbar.
To access Job Center, either click the Job Center icon on the Command WorkStation sidebar or click Job Center
on the Command WorkStation View menu.

Note: When Command WorkStation is launched, Job Center is the default view.

• Apps and Resources: displays the list of installed Fiery applications, applications available for download, and
resources for the Fiery server.

Command WorkStation also includes:

• Device Center: Access all the resources of the Fiery ES. From Device Center, you can access Server
Configuration, perform Color Setup, manage VDP Resources, access presets, and view Fonts installed on the Fiery
ES.
To access Device Center, either right-click the Fiery ES in the Servers list and select Device Center or click
Device Center on the Command WorkStation Server menu.

• Fiery make-ready applications: license-protected features of Command WorkStation that include Fiery Impose,
Fiery Compose, and Fiery JobMaster.

For more information about the Command WorkStation workspace and features, see Fiery Command WorkStation
Help.

Installing Command WorkStation

Install Command WorkStation on a Windows or Mac OS computer with a network connection to the Fiery ES.
For a complete list of system requirements, see Configuration and Setup.
The Installer is provided on the User Software DVD as part of the Fiery User Software Installer (Windows
computers) or as a separate application (Mac OS X). To install Command WorkStation, see Installing user software
on page 7.
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Connecting Command WorkStation

To use Command WorkStation, you must configure the connection to the Fiery ES.
The first time you start Command WorkStation, you are prompted to configure the connection to the Fiery ES. You
can also edit the configuration whenever a change to your Fiery ES or network occurs, such as a changed server
name or IP address. If you change Fiery ES Setup information, do so before you reconfigure the connection.

Note: You can connect up to as many as ten different Fiery ES servers in Command WorkStation. If you try to
connect to more than ten, Command WorkStation may stop responding.
The Fiery ES Configuration page contains information you need when configuring the connection, such as the IP
address of the Fiery ES. For TCP/IP installations, you can use the DNS name instead of the IP address. Make sure
that the Fiery ES is registered in a Domain Name Server (DNS) on your network. For more information, contact your
network administrator.

Configure the connection to the Fiery ES

Configure the connection from Command WorkStation to the Fiery ES.
Before configuring the connection, you must obtain the IP address or DNS name of the Fiery ES. Ask your network
administrator for this information.

1 Start Command WorkStation:

• Windows: Click the Windows icon or Start and choose All Programs > Fiery > Fiery Command WorkStation.

• Mac OS: Choose Go > Applications > Fiery > Command WorkStation > Command WorkStation.

2 Type the DNS name or IP address and click Add to add the server.

3 Choose the username from the User menu and type the appropriate password, if required.
Ask your administrator for the password for the Fiery ES that you want to connect to.
You have the option to save your password by selecting Save password. The next time you log on as that user, the
password is automatically entered. Command WorkStation saves one password per Fiery ES at any one time.
For information about setting passwords and the default Administrator password for the Fiery ES, see
Configuration and Setup.

Note: In addition to the two default user names of administrator and operator, users can login with their own
user names if the network administrator has set them as a member of one of the groups in Configure > User
Accounts.

4 Click Login.

Command WorkStation is now connected to the Fiery ES. You can begin using Command WorkStation to monitor
and manage jobs on the Fiery ES.
For information about managing and connecting another Fiery ES, see Fiery Command WorkStation Help.
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Using Command WorkStation

For instructions on using Command WorkStation features, see the Online help.
The Help menu offers access to the following resources:

• Help provides detailed procedural information.

• How To accesses the EFI web page, which provides demo scripts and sample files.

• Start Tour provides a quick demo of the enhanced features of Command WorkStation.

• Check for updates determines whether you are running the latest versions of Command WorkStation and
associated applications.

• Online Resources includes product downloads, training, support, and additional resources such as newsletters,
case studies, and white papers.

Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a job, print ranges of pages on varying types of
media, and insert blank media between pages.
If tab printing is supported, you can insert tab media containing text labels.
The following guidelines and restrictions apply to Mixed Media settings:

• The Mixed Media dialog box restricts you from specifying settings that conflict with any media, page size, or
finishing settings that have been specified for the job in the Job Properties dialog box or printer driver.

• When two or more Mixed Media settings are in conflict with each other, the Mixed Media dialog box highlights
the setting names in red, signaling you to resolve the conflict.

• When you specify print options (in the Job Properties dialog box or printer driver) after specifying Mixed Media
settings, certain print options may conflict with the page-specific Mixed Media settings. You must resolve the
conflict by choosing different print options or removing certain Mixed Media specifications.

• Mixed Media settings can affect the use of output color profiles in some cases. For more information, see Color
Printing.

Define media for selected pages

You can define different media for selected pages, or a range of pages.
1 Select a job in the Held list in Job Center. Do one of the following:

• Click Properties in the Actions menu.

• Right-click and select Properties.

• Click the Properties icon in the Job Center tool bar.

• Double-click the job.
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2 Click the Media icon in Job Properties and scroll down to Mixed Media.

3 In the Mixed Media dialog box, click New Page Range.

4 In the Page/Page Range Media dialog box, type pages and page ranges as comma-separated values (for example:
3,9–14,18) in the Define Media for Page(s) field.

5 Specify media or output paper size as required. To specify a custom output paper size, click the Custom button
and specify a custom paper size in the Custom Paper Size dialog box.

6 Choose other settings, as required.
If you assign new settings to the back side of a duplexed sheet, a blank page is inserted to force the assigned page
content to the front side of the next sheet.

7 Click Add Definition after each media setting that you define.

8 Click Close to return to the Mixed Media dialog box.

Insert blank pages

You can insert blank pages in your job and assign different media for them.
1 Select a job in the Held list in Job Center. Do one of the following:

• Click Properties in the Actions menu.

• Right-click and select Properties.

• Click the Properties icon in the Job Center tool bar.

• Double-click the job.

2 Click the Media icon in Job Properties and scroll down to Mixed Media.

3 Click New Insert in the Mixed Media dialog box.

4 Indicate whether to insert the blank before or after the target page. Define the target page as the first or last page
in the document, or as a specific numbered page.

5 Specify media or output paper size as required. To specify a custom output paper size, click the Custom button
and specify a custom paper size in the Custom Paper Size dialog box.

6 Choose other settings, as required.

7 Click Insert after each blank page that you define.

8 Click Close to return to the Mixed Media dialog box.

Insert tabs

The Insert Tab feature allows you to automatically insert tab pages throughout a job.
The Insert Tab feature accommodates various sizes and types of tab media stock. You can insert the tab text and
override text attributes on a per-job basis.
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Note: When you configure counters for the printer, printed tab pages count as black-and-white pages, provided the
tab text color is set to the default (Black). Expelled tabs are not counted as printed pages.

1 Select a job in the Held list in Job Center. Do one of the following:

• Click Properties in the Actions menu.

• Right-click and select Properties.

• Click the Properties icon in the Job Center tool bar.

• Double-click the job.

2 Click the Media icon in Job Properties and scroll down to Mixed Media.

3 Click New Tab in the Mixed Media dialog box.

4 In the Insert Tab dialog, type the number of tab positions included in a complete tab set in the Number of tabs
in a set field.
This specification ensures that tab text is printed in the correct tab positions. For example, tab positions in a set
consisting of ten tabs are distinct from tab positions in a set consisting of five tabs.

5 Specify other settings as required for the tab stock.
Paper size values refer to the dimensions of the stock, including the tabbed portion.

6 To specify attributes for the tab text, type the number of tabs in the Number of tabs to insert field, and then click
Insert.

Specify tab text

You can specify what text you want on inserted tabs, and also specify styles.
1 If you want all the tabs to use the same text attributes, select the Apply the same text attributes for all tabs option

in the Tabs Text area of the Insert Tab dialog box.

2 Click Insert.

3 In the Text Attributes column, click the arrows to display the menus for font, size, color, text rotation, and text
alignment, and choose the attributes that you want from each menu.

4 Indicate where you want each tab inserted in the document.
a) In the Page field, type the page number where you want the tab inserted.

b) Select Before to insert the tab before the page number, or clear this check box.

Note: If you define a tab to be inserted between an odd-numbered page and an even-numbered page in a duplex
job, the tab is inserted after the odd-numbered page on the first sheet, and the even-numbered page is printed
on the next sheet.

5 Type the desired tab text for each tab in the Tab Text field.
To define text attributes for each tab individually, click Text Attributes for that tab.

6 After you type the tab text, click OK to close the Insert Tab dialog box.

Utilities

Command WorkStation

16



7 To modify media settings for the tabs, select the tab description in the Mixed Media Definition list, and then click
Edit.

8 To apply your Insert Tab settings to the document, click OK to close the Mixed Media dialog box and Job
Properties.

Soft proofing

The Soft Proof feature allows you to preview general color accuracy of print jobs on a monitor.
Use soft proofs to adjust colors in a processed job before it is printed. You can also use the preview to verify job
placement, orientation, and content. Soft Proof is available through Fiery ImageViewer in Command WorkStation.
Fiery ImageViewer displays the job with the actual CMYK values that are sent to the printer and therefore provides
an accurate soft proof of color and grayscale values.
To access soft proofing, select a processed, held job in Command WorkStation and do one of the following:

• Right-click the job and select ImageViewer.

• Click ImageViewer in the Actions menu.

• Click the Preview icon on the toolbar. In the Preview window that appears, choose File > Launch ImageViewer.

Image Enhance

Use the Image Enhance print option to apply photo enhancement to photographic color images on specified pages
or sheets of a job.

Important: This feature is not used on graphics such as logos or charts.

This option is located in the Image tab of the printer driver and Job Properties.
To turn on this feature, select the Apply Image Enhancement option for a job and specify the pages or sheets to be
affected. You can customize Image Enhance settings from Command WorkStation.
For more information about the Image Enhance print option and how to configure it, see Fiery Command
WorkStation Help.

Image Enhance Visual Editor

Image Enhance Visual Editor (IEVE) is an image editing application that provides users with a visual workspace to
adjust individual images in a job.
IEVE is available with Fiery Productivity Package.
You can adjust tone, color, and sharpness, and perform red-eye correction. You can apply the same adjustments to
all images on a page or a range of pages. You can see the effects of your adjustments and fine-tune the appearance of
an image. When you save a set of adjustments as a preset, you can easily apply the same adjustments in the future.

Important: Adjustments made in IEVE affect the job on the Fiery ES and cannot be applied to the original
source document.
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For information about using IEVE, see Fiery Productivity Package.

ImageViewer

ImageViewer allows you to soft proof and adjust colors in a job before it is printed.
Use the preview in ImageViewer on a job to verify job placement, orientation, and content, as well as color accuracy.
If the job contains halftone screened settings, the preview shows a composite view of all separations at the dot level.
You can select to display the plate data for each process color independently or in combination with the other colors,
allowing inspection of individual plate data or a combination of any range of plates. The job must be processed and
held.
ImageViewer is available with Fiery Productivity Package. For information about using ImageViewer, see Fiery
Productivity Package and Fiery Command WorkStation Help.

Troubleshooting connections

If you cannot connect to the Fiery ES or locate the Fiery ES from your computer, contact the network administrator.
The administrator may need to troubleshoot your network connections and check settings on the servers that you
print to. If settings have changed, it may be necessary to reconfigure the Fiery ES (see Configuration and Setup).
If you can connect to the Fiery ES with another utility, you may need to reconfigure the Command WorkStation
connection to the Fiery ES.
If you configured the Fiery ES and set up client computers and network servers according to the instructions in
Configuration and Setup, print a Test Page. If you can print the Test Page but still cannot print a document from a
remote computer, contact your network administrator to troubleshoot the network connection.
If you cannot connect and cannot print a Test Page, check the printer control panel for error messages.

Command WorkStation does not respond

You can try different actions when Command WorkStation does not respond.
If the Command WorkStation windows do not update:

• Log off and then quit Command WorkStation.

• Restart Command WorkStation or restart the computer.

If the Command WorkStation windows do not update or no jobs are displayed, and the mouse has no effect (you
cannot select a job or a window, use a right mouse command, or select a menu item), the Fiery ES is offline or
network communication has failed.
To force an exit from Command WorkStation:

• Windows: Press Ctrl-Alt-Delete and use the Task Manager to close Command WorkStation.

• Mac OS X: Choose Apple menu > Force Quit, select Command WorkStation, and then click Force Quit. Or, press
Command+Option+Esc, select Command WorkStation, and then click Force Quit.
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• At the Fiery ES, disconnect and reconnect the network cable, and then try printing a Test Page or Configuration
page.

• If printing fails, restart the Fiery ES.

Create a job error report

If you encounter any errors while processing or printing a job, you can create a job error report in Command
WorkStation for troubleshooting purposes.
The job error report can be sent to technical support.

1 Select a job in the Printed or Held list in Command WorkStation.
Only one job error report can be created at a time. If multiple jobs are selected in Job Center, the Create Error
Report button is not available.

2 On a Windows computer, press Ctrl and right-click the job. On a Mac OS computer, press Command (Mac OS)
and right-click the job.

3 Click Create Error Report.

4 Enter the information in the Create Error Report dialog.

Note: See the "Troubleshooting" chapter in Configuration and Setup for information that we recommend you
provide.
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Fiery make-ready applications

Fiery make-ready applications integrate labor-intensive document preparation activities at both the sheet level and
page level in one visual interface.
These integrated job preparation tools offer the following modes, depending on what client license is available:

• Preview provides a preview of a job before it is processed and is a standard feature of Command WorkStation.
Users can do a soft proof of each sheet surface of a job before it is processed. The visual interface changes
dynamically to display any changes made in preparing documents for printing.

• Fiery JobMaster provides advanced PDF-based job preparation tools for scanning, tab creation and insertion,
page numbering, chapter creation, and late stage editing. It includes all functions of Fiery Compose.

• Fiery Compose allows you to define the chapter divisions of a job, print ranges of pages on varying types of
media, insert blank media between pages, and insert tab media containing text labels (if the printer supports tab
printing). 

• Fiery Impose applies imposition layouts to jobs for custom printing, binding, and trimming. Fiery Impose also
applies impositions to variable data jobs and saves imposed jobs as PDF files.

The Fiery make-ready applications are supported on both Windows and Mac OS computers. For information about
system requirements, see Configuration and Setup.

Fiery make-ready software kits

The Fiery make-ready applications are available in several different kit configurations.
You must have the software kit-specific licenses installed on your computer to use the full functionality of the
software. If you choose not to activate the license for any of the components, Fiery Impose runs in Demo mode, and
Fiery JobMaster and Fiery Compose settings are not displayed. In Impose Demo mode, imposed jobs print with a
watermark, and you can save imposed jobs in .dbp format to the Fiery ES. You can save imposed jobs in Adobe PDF
format to a hard drive and the Fiery ES when you are in Demo mode, but they are saved with a watermark.
The available kits are:

• Fiery JobMaster kit (includes the Adobe Acrobat/Enfocus PitStop DVD and a License Activation Code)

• Fiery Impose kit (includes the Adobe Acrobat/Enfocus PitStop DVD and a License Activation Code)

• Fiery Compose kit (includes the Adobe Acrobat/Enfocus PitStop DVD and a License Activation Code)

• Fiery Impose-JobMaster kit, which includes both Fiery Impose and Fiery JobMaster (includes the Adobe
Acrobat/Enfocus PitStop DVD and a License Activation Code)

• Fiery Impose-Compose kit, which includes both Fiery Impose and Fiery Compose (includes the Adobe Acrobat/
Enfocus PitStop DVD and a License Activation Code)
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Enabling Fiery make-ready applications

Fiery make-ready applications are license-protected features of Command WorkStation that work in conjunction
with Adobe Acrobat and the Enfocus PitStop plug-in.
Fiery make-ready applications include Fiery Impose, Fiery Compose, and Fiery JobMaster.
You must install a special license on each computer that runs the software. This section explains how to install the
license and the required software. Note the following:

• The License Activation Code is provided on a card in your kit.

• Adobe Acrobat must be installed on the same computer as the Fiery make-ready application to preview .ps files.
You do not need Adobe Acrobat or Enfocus PitStop to preview .pdf files.

Note: If you are enabling Fiery make-ready software on the Fiery ES, you must log on to the Fiery ES with
administrator privileges and type the appropriate password. To ensure network security, the system administrator
may change this password frequently. Consult your administrator to obtain the password.

Install a license for your software option

A special license is required to use your software option.
You can install a license in the following ways:

• Automatically, if you are connected to the internet, as described below.

• Manually, if you are not connected to the internet. See Activate a Fiery option manually on page 22.

You can de-activate the license and re-activate it on a different computer. See Fiery Options Help, accessed from the
License Activation window.

1 In Command WorkStation, right-click a spooled job and choose JobMaster, Impose, or Compose.

2 If you are asked whether to activate the option, click Yes.
If you selected Impose, you can select Use Demo or Yes.
To open the License Activation window, you can also select Preview in step 1, and choose Help > Manage License.

3 In the License Activation window, click Activate.

4 To agree to the terms and conditions of the license agreement, click Continue.

5 For License Activation Code, type the LAC you received in your kit, and click Continue.

6 If the Fiery option name is correct, click Activate.

7 Click Finish.
For more information about the activation process, click the Help icon in the License Activation window.
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Activate a Fiery option manually

If the computer is not connected to the Internet, you must manually transfer data between the computer and the EFI
licensing website. You will generate a request file, submit it to the EFI licensing website to obtain a license file, and
then use the license file to activate the option.
1 In the License Activation window, click Activate.

2 Click Continue to agree to the terms and conditions of the license agreement.

3 Type the LAC in the License Activation Code field, and then click Continue.

4 Click Continue to proceed with the manual process.

5 Click Create Request File and save the file.

6 Copy the request file to a computer that is connected to the Internet.

7 Open a browser and go to licensing.efi.com.

8 Click Browse, select the request file, and then click Upload.

9 Click Continue.

10 Click Download License File and save the file.

11 Copy the license file to the computer where you first entered the License Activation Code.

12 Return to the Generate License window and click Yes.

13 Click Browse, select and open the license file, and then click Activate.

14 If the activation requires a restart, you can either click Restart to restart now or click Finish if you want to activate
additional options before restarting. If the activation does not require a restart, just click Finish.

Install Adobe Acrobat and Enfocus PitStop Edit

Install Adobe Acrobat and Enfocus PitStop Edit from your software option kit.
To complete installation and activation of Adobe Acrobat and Enfocus PitStop Edit on your client computer, make
sure the computer is connected to the Internet.

1 If the most recent versions of Adobe Acrobat and Enfocus PitStop Edit are not installed, uninstall the versions
that are currently resident on the computer.
a) Close all open applications.

b) Follow the instructions for your computer for removing programs.

c) After you finish uninstalling earlier versions of Adobe Acrobat and Enfocus PitStop, restart the computer.

2 Close all software applications that are currently running on the computer.

3 Insert the Adobe Acrobat/Enfocus PitStop DVD (Windows or Mac OS) into the DVD drive of your computer.
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4 If the installer does not start automatically, navigate to the root level of the DVD and double-click Setup.exe
(Windows) or Setup.app (Mac OS).

• Windows: Select the language and click Next.

• Mac OS X: Click Install and follow the on-screen instructions.

The software option that you purchased is now fully enabled.

Fiery make-ready applications help

Fiery make-ready applications help is accessed from the application window.
Fiery make-ready applications include Fiery Impose, Fiery Compose, and Fiery JobMaster.
The Help menu provides procedural information.
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Scan

Scan is a collection of software components that allow you to scan documents from the printer glass (platen) or
through the automatic document feeder (ADF) on the printer and send the scanned images to specific destinations.
Scan consists of the following:

• Fiery Remote Scan includes the TWAIN plug-in module. Fiery Remote Scan allows you to retrieve a scan from a
printer.

• Scan to Mailbox allows you to send the scan to a mailbox on the Fiery ES, from where it can be retrieved. You
can also save the scan to any folder on the network or on the client computer.

• WebTools Docs allows you to retrieve scanned jobs from mailboxes on the Fiery ES.

User Box feature on the printer

The User Box feature on the printer allows you to scan documents from the printer glass or through the printer’s
automatic document feeder (ADF) and save the scanned images to mailboxes on the printer hard disk.
After scanning a document to a User Box on the printer, you can send the scans to specific destinations, such as a
local drive, and also retrieve them using WebTools Mailbox and Fiery Remote Scan. To save data to a User Box,
create the box, and then scan the data to the specified box. Each user can have access to multiple boxes: Public,
Personal, and Group boxes.
Public User Boxes are accessible to everyone, Personal User Boxes are assigned to a single user, and Group User
Boxes can be used by the users who are logged in as members of that User Box group account.
Different levels of authentication are supported on the printer. User authentication may be enabled to access the
printer, as well as mailboxes, depending on the type of mailbox and the environment. Public boxes are accessible in
any scenario, with user authentication turned on or off. For Personal boxes, user authentication is turned on, and
then users create their own personal boxes by entering a box/name and an optional password. For Group boxes, the
account track feature must be enabled on the printer, and a password and user name are required to access each box.
To find out what levels of user authentication have been set on the printer, ask your system administrator.
The printer supports the following file formats: PDF, Compact PDF, TIFF, JPEG, XPS, and Compact XPS. The
default file type for scanning is PDF, which is supported in Command WorkStation. If a job is scanned in a format
that is not supported in Command WorkStation, it is still possible to print the file using the Fiery ES printer driver or
third party application printer driver.
The printer also supports producing multiple page files or single page files for all file formats supported, except for
JPEG, which supports only single page files. To scan a multiple-page job in JPEG format, you must scan each page
separately.
See Scan to a User Box on page 25 for an overview of scanning to a User Box. More information about setting up
User Boxes on the printer is provided in the manual that accompanies your printer.
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Scan to a User Box

This procedure provides an overview of scanning to a User Box from the printer control panel.
1 If user authentication is enabled, enter the user name and password.

Ask your system administrator for the log in information.

2 Press Fax/Scan on the printer control panel.

3 Press Direct Input.

4 Press User Box.

5 Select a User Box.
You can also create a User Box by entering a User Box number.

6 Enter the document name.

7 Specify scan settings.

8 Press Start.

For more information, see the guide that comes with your printer.

Installing Fiery Remote Scan

To install and use Fiery Remote Scan, either as a separate application or as a plug-in module, you must have a
Windows or Mac OS computer with a network connection.
For detailed system requirements, see Configuration and Setup. The installer for Fiery Remote Scan is located on the
User Software DVD. To install Fiery Remote Scan, see Installing user software on page 7.

• Access Fiery Remote Scan in the following ways:

• The Remote Scan application is a separate application started from your desktop. The Remote Scan application
allows you to retrieve scan files from a mailbox.

• The Remote Scan TWAIN plug-in module is used with compatible TWAIN compliant applications, such as
Adobe Photoshop or Adobe Acrobat. You can directly acquire the scan into the application.

Multiple Fiery Remote Scan TWAIN users can simultaneously access the same Fiery ES.

Configuring Fiery Remote Scan

When you open Fiery Remote Scan for the first time, you must configure the connection to the Fiery ES. You can
add more than one Fiery ES to the Fiery Server list in Fiery Remote Scan and select the required one from the list.
To configure the connection, you need the name or IP address of the Fiery ES. If you do not have the name or IP
address, use the Search function to find the Fiery ES on your network.

Utilities

Scan

25



After first use, Fiery Remote Scan automatically attempts to connect to the last Fiery ES used in the previous session.
You can immediately start to retrieve any scans initiated at the printer control panel, and use Fiery Remote Scan
Help.
Instructions for configuring and modifying the connection to the Fiery ES are also provided in Fiery Remote Scan
Help.

1 Open Fiery Remote Scan.

2 Click the Choose a Fiery icon (magnifying glass) to open the Connect to Server dialog box.

3 Type the name or IP address in the Connect to a server field.
If you do not have the name or IP address, see To perform an advanced search on page 26.

4 Click the plus sign icon to add it to the server list.
When you click the plus sign, you add the Fiery ES to the list, but do not connect to it. This operation is useful
when you want to add more than one Fiery ES in a session. You can then switch between any Fiery ES in the Fiery
Remote Scan window without opening the Connect to Server dialog box.

5 Click Connect or Cancel.
Clicking Connect adds the Fiery ES to the list at the same time as connecting to it. If the connection was
successful, the Fiery Remote Scan window opens.
If you clicked Cancel, all operations that you did to add or remove the Fiery ES are cancelled. Any server list
changes are discarded.
If you do not have the specific name or IP address of the Fiery ES, you can search by IP ranges or by subnet.

To perform an advanced search

You can search for a Fiery ES in different ways.
1 In the Connect to Server dialog box, click the Choose a Fiery icon (magnifying glass) to open the Search dialog

box.

2 Select Auto Search or select IP Range or Subnet to specify the range to search, and then click Go.
Any available Fiery ES that matches the search criteria is shown. You can filter the search result list by typing a
keyword in the Filter by keyword field.

3 Select the Fiery ES from the results list and click Add.

4 To add another Fiery ES to the list for later use, click the plus sign in the Connect to Server dialog box.

5 In the Connect to Server dialog box, click Connect to add the Fiery ES to My Fiery List and connect to it.
If you clicked Connect and the connection was successful, the Fiery Remote Scan window opens.
If you clicked Cancel, all operations that you did to add or remove any Fiery ES are canceled. Any server list
changes are discarded.
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Using Fiery Remote Scan

The Fiery Remote Scan standalone application and the Fiery Remote Scan TWAIN plug-in module manage scanning
on the printer from the Fiery ES.
With Fiery Remote Scan or the TWAIN plug-in module, you can retrieve files from the mailbox. If you are using
Fiery Remote Scan, you can choose where to save the scanned file on the computer. If you are using the TWAIN
plug-in module, you can open the scan file in a host application for editing purposes.
Instructions for using the Fiery Remote Scan application and plug-in module are provided in Fiery Remote Scan
Help, accessed by clicking the Help icon in the Fiery Remote Scan window.

Retrieving scans using Docs

You can retrieve scan jobs in the Fiery ES mailboxes to your remote workstation using WebTools Docs.
Before sending a scan to a mailbox, you must first set up the mailbox in the User Accounts area of the Configure
application, available from WebTools > Configure or from Command WorkStation. If desired, set a predefined user
name and password for the mailbox.
For instructions on using WebTools, see Using WebTools on page 30.
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Fiery Hot Folders

Fiery Hot Folders provides a simple and automated method of sending print jobs to the Fiery ES across the network.
You drag documents to a folder that stores and reuses preset print options for printing PostScript and PDF files on
the Fiery ES.
With Hot Folders, you can do the following:

• Create special folders (hot folders) that assign specific print settings and print queues to jobs.

• Print jobs to the Fiery ES by dragging and dropping them onto hot folders on your computer's desktop.

• Monitor the status of jobs sent to hot folders.

Note: Hot Folders is installed by default with Command WorkStation. For information about installing Command
WorkStation, see Installing Command WorkStation on page 12.

Using Hot Folders

For instructions on how to use Hot Folders features, see the Help provided with the software.
After Hot Folders is installed, a Hot Folders icon appears on the desktop of the client computer.
You can use file format filters with Hot Folders. For information, see Hot Folders Help.
If the Fiery Productivity Package is installed and enabled on the Fiery ES, you can use additional file format filters
with Hot Folders. For information about using these file format filters, see Fiery Productivity Package.
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WebTools

WebTools consists of several utilities that allow you to manage your Fiery ES from the Internet or your company
intranet.
From WebTools, you can access:

• Home provides current information about the jobs processing and printing on the Fiery ES. Home also allows
you to download software updates, manage installed Fiery options, and check for product updates.

• Docs allows remote users to access jobs on the Fiery ES over the Internet or intranet.

• Mailbox allows remote users to access jobs on the printer over the Internet or intranet. You can also create, edit,
and delete User Boxes on the printer.

• Configure allows the Fiery ES administrator to view and modify Setup options remotely from a Windows or Mac
OS computer.

• Fiery System Restore allows you to back up the Fiery ES manually, schedule automatic backups, and restore the
Fiery ES from a backup file.

Pop-up Blocker with WebTools

Pop-up Blocker is turned on by default in some versions of Internet Explorer on Windows computers. With this
function turned on, a warning message appears when you attempt to access WebTools, and access to WebTools is
denied.
To gain access to WebTools, do one of the following:

• Change the Pop-up Blocker setting by clicking the warning message and choosing one of the selections that
appears.

• Turn off Pop-up Blocker in the Internet Explorer Tools menu.

If your browser has the advanced Internet option enabled to display notifications about script errors, it might display
a warning window before displaying a Help file. To avoid the warning window, clear the “Display a notification about
every script error” option on the Advanced tab in the Internet Options dialog box. A warning message might also
appear in the Status bar, but the content of the Help file is not affected by this error.
For more information, see Internet Explorer Help, or the documentation that accompanies the Windows operating
system.
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Accessing the WebTools home page

Use your Internet browser to access WebTools.
For complete information about browser and system requirements , see Configuration and Setup.

1 Start your Internet browser.

2 Type the IP address or DNS name of the Fiery ES.

3 Click the WebTools tab that you want to use.

Using WebTools

The following sections describe how to use the WebTools.

Home

Home lets you:

• View processing and printing status on the Fiery ES.

• Manage Fiery options.

• Check for Product Updates for the Fiery ES.

• Access Software Downloads that allow you to download installers for user software directly from the Fiery ES.

Docs

Docs allows you to access jobs on the Fiery ES over the Internet or intranet.
You can:

• Manage and distribute jobs in your mailbox, if scanning to mailboxes is supported on your printer.
Mailboxes are set up with the Configure application (accessible from WebTools or Command WorkStation).

• Import and print jobs to the Fiery ES depending on access privileges defined by the administrator.

Configure

Configure allows the Fiery ES administrator to view and modify Setup options remotely.
The Configure application is available from WebTools > Configure and from within Command WorkStation.
For instructions on how to use Configure, see Configuration and Setup.

Fiery System Restore

Fiery System Restore allows the administrator to back up the Fiery ES manually, schedule automatic backups, and
restore the Fiery ES from a backup file.
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Use Mailbox to retrieve scans

When you have scanned a job to the User Box on the printer, you can access it from WebTools.
1 Start your Internet browser.

2 Type the IP address or DNS name of the printer.

3 Click the Mailbox tab.

4 Choose whether to log in to the Public boxes or as Administrator.
If LDAP has been enabled on the printer, your user name would consist of “domain name\user name”. When you
have logged in, you can choose to edit and delete existing mailboxes and also create new mailboxes.

5 Click the mailbox Number-Name link to open it.

6 Click Download if you wish to download the file to your computer.
You can choose the file format for downloading the file.
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Customer Release Notes
Fiery® ES IC-418 version 1.0

This Customer Release Notes document provides information about the Fiery® ES IC-418 version 1.0 software.
Before using the Fiery ES, make copies of the Customer Release Notes and distribute to all users.
This document uses the following terms:

Term Description

Fiery ES Fiery® ES IC-418

printer MFP

Installation

Fiery icon on printer control panel

The first time the Fiery ES is powered on after it is installed, it may take a few minutes for the Fiery icon to show on
the printer control panel.

Fiery menu

In order to display the Fiery menu on the printer panel, connect the LAN cable to a working hub. Also, the Fiery
menu on the printer panel does not function if SSLv3 or TLSv1.0 is enabled in the SSL/TLS settings on the printer.
In that case, enable TLSv1.1 and TLSv1.2.

Color Printing

Substitute Colors

For some documents, the Substitute Colors option does not work properly if there are objects that include a
transparency background.

© 2017 Electronics For Imaging, Inc.

24 October 2017

45174759
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Fiery Command WorkStation

A4 tab paper on Bypass tray

In Tray Alignment, if you choose A4 paper on the Bypass tray, it is displayed as simply A4.

Printing

Displaying very long document names

Very long document names are not displayed completely on the printer panel.

5.5x8.5 job not stapled

If you send a 5.5x8.5 SEF job to be stapled, an error message states that it is not possible. You can send the job as LEF
instead, and it will be stapled.

Printing preference window

For the Fiery Driver for Mac OS, if the Printing Preference window is opened for a Microsoft Office document and
then another application is opened and minimized, the Printing Preference window becomes hidden behind the Print
window. This occurs only for the combination of 64-bit Mac OS and 32-bit Microsoft Office.
As a workaround, click Cancel on the Print window then reopen the Printing Preference window.

Grayscale and Black Printing

Mottling may be seen on printed output when you print a job with Grayscale and Pure Black.

Other applications

Printing JDF files

When you print a JDF job from an application, such as Adobe Acrobat, to the Fiery ES with Command WorkStation,
you may encounter a JDF ticket error. As a workaround, right-click the job in the Command WorkStation Held list,
select Ignore JDF ticket conflicts, and then print it. Resolve any runlist errors. All other print settings are preserved.
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Legal Notices

This product documentation is protected by copyright, and all rights are reserved. No part of it may be reproduced or transmitted in any form or by 
any means for any purpose without express prior written consent from Electronics For Imaging, Inc. (“EFI”), except as expressly permitted herein. 
Information in this document is subject to change without notice and does not represent a commitment on the part of EFI.
This product documentation is provided in conjunction with the EFI software (“Software”) and any other EFI product described in this 
documentation. The Software is furnished under license and may only be used or copied in accordance with the terms of the EFI Software End User 
License Agreement set forth below. 

Patents
This product may be covered by one or more of the following U.S. Patents:
5,970,174, 6,025,922, 6,041,200, 6,065,041, 6,112,665, 6,116,707, 6,122,407, 6,134,018, 6,166,821, 6,173,286, 6,185,335, 6,201,614, 6,215,562, 
6,219,155, 6,219,659, 6,222,641, 6,224,048, 6,225,974, 6,226,419, 6,239,895, 6,256,108, 6,271,937, 6,278,901, 6,279,009, 6,289,122, 6,292,270, 
6,327,047, 6,327,050, 6,327,052, 6,331,899, 6,340,975, 6,341,018, 6,341,307, 6,347,256, 6,348,978, 6,366,918, 6,369,895, 6,381,036, 6,429,949, 
6,449,393, 6,457,823, 6,476,927, 6,490,696, 6,501,565, 6,519,053, 6,539,323, 6,543,871, 6,546,364, 6,549,294, 6,549,300, 6,550,991, 6,552,815, 
6,559,958, 6,572,293, 6,590,676, 6,616,355, 6,633,396, 6,636,326, 6,637,958, 6,643,317, 6,647,149, 6,660,103, 6,662,199, 6,678,068, 6,679,640, 
6,707,563, 6,741,262, 6,748,471, 6,753,845, 6,757,436, 6,757,440, 6,778,700, 6,781,596, 6,786,578, 6,816,276, 6,825,943, 6,832,865, 6,836,342, 
6,850,335, 6,856,428, 6,857,803, 6,859,832, 6,866,434, 6,874,860, 6,879,409, 6,885,477, 6,888,644, 6,905,189, 6,930,795, 6,950,110, 6,962,449, 
6,967,728, 6,974,269, 6,978,299, 6,992,792, 7,002,700, 7,023,570, 7,031,015, 7,058,231, 7,064,153, 7,073,901, 7,081,969, 7,090,327, 7,093,046, 
7,095,518, 7,097,369, 7,099,027, 7,105,585, 7,116,444, 7,177,045, 7,177,049, 7,204,484, 7,206,082, 7,212,312, 7,229,225, 7,233,397, 7,233,409, 
7,239,403, 7,245,400, 7,248,752, 7,259,768, 7,259,893, 7,280,090, 7,296,157, 7,301,665, 7,301,667, 7,301,671, 7,302,095, 7,302,103, 7,304,753, 
7,307,761, 7,342,686, 7,343,438, 7,349,124, 7,365,105, 7,367,060, 7,367,559, 7,389,452, 7,396,119, 7,396,864, 7,397,583, 7,397,961, 7,426,033, 
7,427,317, 7,431,436, 7,431,759, 7,433,078, 7,453,596, 7,460,265, 7,460,721, 7,461,377, 7,463,374, 7,466,441, 7,480,070, 7,489,422, 7,495,812, 
7,506,253, 7,522,311, 7,522,770, 7,528,974, 7,552,207, 7,552,923, 7,554,687, 7,562,957, 7,564,583, 7,574,545, 7,574,546, 7,579,388, 7,587,336, 
7,587,468, 7,598,964, 7,600,867, 7,630,106, 7,636,180, 7,648,293, 7,653,683, 7,662,224, 7,669,096, 7,672,013, 7,673,965, 7,684,085, 7,688,458, 
7,688,486, 7,706,015, 7,724,392, 7,729,014, 7,738,147, 7,738,710, 7,742,204, 7,756,346, 7,770,999, 7,791,777, 7,800,773, 7,800,776, 7,812,999, 
7,828,412, 7,831,830, 7,849,316, 7,859,689, 7,859,711, 7,859,724, 7,861,156, 7,869,079, 7,880,934, 7,884,962, 7,889,403, 7,889,361, 7,911,432, 
7,911,433, 7,919,543, 7,982,890, 7,996,806, 8,013,871, 8,014,036, 8,031,363, 8,100,507, 8,107,122, 8,121,338, 8,133,539, 8,139,256, 8,153,195, 
8,162,437, 8,169,630, 8,171,103, 8,172,363, 8,192,010, 8,205,012, 8,243,326, 8,294,925, 8,317,311, 8,322,836, 8,408,676, 8,430,498, 8,459,773, 
8,459,778, 8,477,165, 8,484,316, 8,553,286, 8,567,936, 8,595,384, 8,601,605, 8,610,932, 8,616,691, 8,672,451, 8,684,511, 8,730,525, 8,740,367, 
8,757,762, 8,777,385, 8,780,152, 8,782,808, 8,807,727, 8,810,876, 8,814,346, 8,833,922, 8,860,998, 8,861,053, 8,882,243, 8,885,181, 8,889,232, 
8,922,818, 8,934,119, 8,947,702, 8,960,870, 8,967,777, 8,967,762, 8,976,407, 9,049,403, 9,067,435, 9,079,402, 9,079,427, 9,085,161, 9,126,420, 
9,129,193, 9,134,935, 9,137,208, 9,158,479, 9,195,916, 9,227,428, 9,228,104, 9,232,112, 9,233,569, 9,260,616, 9,272,541, 9,294,574, 9,302,490, 
9,303,097, 9,321,281, 9,335,157, 9,336,465, 9,336,473, 9,365,061, 9,417,829, 9,420,146, 9,446,990, 9,458,334, 9,487,010, 9,527,307, 9,540,531, 
RE38,732.

Trademarks
The APPS logo, Auto-Count, Balance, BESTColor, BioVu, BioWare, ColorPASS, Colorproof, ColorWise, Command WorkStation, CopyNet, 
Cretachrom, Cretaprint, the Cretaprint logo, Cretaprinter, Cretaroller, Digital StoreFront, DirectSmile, DocBuilder, DocBuilder Pro, DockNet, 
DocStream, DSFdesign Studio, Dynamic Wedge, EDOX, EFI, the EFI logo, Electronics For Imaging, Entrac, EPCount, EPPhoto, EPRegister, 
EPStatus, Estimate, ExpressPay, Fabrivu, Fast-4, Fiery, the Fiery logo, Fiery Driven, the Fiery Driven logo, Fiery Link, Fiery Navigator, Fiery Prints, 
the Fiery Prints logo, Fiery Spark, FreeForm, Hagen, Inktensity, Inkware, Jetrion, the Jetrion logo, JobFlow, JobMaster, LapNet, Logic, Metrix, 
MicroPress, MiniNet, Monarch, OneFlow, Pace, Pecas, Pecas Vision, PhotoXposure, PressVu, Printcafe, PrinterSite, PrintFlow, PrintMe, the 
PrintMe logo, PrintSmith, PrintSmith Site, Printstream, Print to Win, Prograph, PSI, PSI Flexo, Radius, Remoteproof, RIPChips, RIP-While-Print, 
Screenproof, SecurPrint, SendMe, Sincrolor, Splash, Spot-On, TrackNet, UltraPress, UltraTex, UltraVu, UV Series 50, VisualCal, VUTEk, the 
VUTEk logo, and WebTools are trademarks of Electronics For Imaging, Inc. and/or its wholly owned subsidiaries in the U.S. and/or certain other 
countries.
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Third-Party Notifications
APPLE, INC. (“APPLE”) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE. APPLE 
DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF 
THE APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE 
RISK AS TO THE RESULTS AND PERFORMANCE OF THE APPLE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED 
WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. 
IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO YOU FOR ANY 
CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS 
INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE 
APPLE SOFTWARE, EVEN IF APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO 
NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE 
LIMITATIONS MAY NOT APPLY TO YOU. Apple’s liability to you for actual damages from any cause whatsoever, and regardless of the form of 
the action (whether in contract, tort [including negligence], product liability, or otherwise), will be limited to $50. 
PANTONE® Colors displayed in the Software or in the documentation may not match PANTONE-identified standards. Consult current PANTONE 
Color Publications for accurate color. PANTONE® and other Pantone, Inc. trademarks are the property of Pantone, Inc. © Pantone, Inc., 2001. 
Pantone, Inc. is the copyright owner of PANTONE color data and/or software. Certified PDF is a registered trademark of Enfocus, patent pending. 
PitStop Professional, PitStop Extreme, PitStop Server, Instant PDF, StatusCheck, CertifiedPDF.net, Instant Barcode, and PDF Workflow Suite are 
product names of Enfocus. Enfocus products and the use of Enfocus products are under license from Markzware under U.S. Patent No. 5,963,641. 
Enfocus is an EskoArtwork Company.
The Software may contain various components which are subject to different licenses, including the EFI modified version of the Linux kernel binary 
image, certain LGPL libraries, certain other open source libraries and tools, and software developed by the Apache Software Foundation 
(www.apache.org). By using the Software or any of the incorporated components, you agree to be bound by the terms and conditions of their 
respective licenses. The respective copyright notices, acknowledgments and licenses can be found on the Fiery WebTools home page. As a reminder, 
the term "Software" as used in the EFI Software End User License Agreement does not include any open source software that is contained in the 
product, and the terms of the EFI Software End User License Agreement do not apply to open source software.

Regulatory Notices and Markings
THE FOLLOWING REGULATORY NOTICES AND MARKINGS APPLY IF THE EFI PRODUCT YOU RECEIVED INCLUDES EQUIPMENT.
WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer 
could void the user’s authority to operate this equipment.
Refer to the Class Compliance sticker affixed to the back of your Fiery (or, in the case of embedded systems, to the sticker affixed to the print engine) 
to identify the appropriate classification (A or B, below) for this product.

FCC Class A Compliance
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause interference, in which case 
the user will be required to correct the interference at his own expense.

Industry Canada Class A Notice
This Class A digital apparatus complies with Canadian ICES-3(A).

Avis de Conformation Classe A de l’Industrie Canada
Cet appareil numérique de la Classe A est conforme à la norme NMB-3(A) du Canada.
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FCC Class B Declaration of Conformity
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC rules. These limits 
are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular installation.
If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, 
the user is encouraged to try to correct the interference by one or more of the following measures:
Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.
In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment 
or unshielded cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the 
equipment without the approval of the manufacturer could void the user’s authority to operate this equipment.

Industry Canada Class B Notice
This Class B digital apparatus complies with Canadian ICES-3(B).

Avis de Conformation Classe B de l’Industrie Canada
Cet appareil numérique de la Classe B est conforme à la norme NMB-3(B) du Canada.

RFI Compliance Notice
This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on a system level (to 
simulate normal operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in 
other installations. It is the user who is responsible for compliance of his particular installation.
Dieses Gerät wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der 
Funkentstörbestimmungen geprüft. Es ist jedoch möglich, dass die Funkentstörbestimmungen unter ungünstigen Umständen bei anderen 
Gerätekombinationen nicht eingehalten werden. Für die Einhaltung der Funkentstörbestimmungen einer gesamten Anlage, in der dieses Gerät 
betrieben wird, ist der Betreiber verantwortlich.
Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.
Die Einhaltung zutreffender Bestimmungen hängt davon ab, dass geschirmte Ausführungen benützt werden.  
Für die Beschaffung richtiger Ausführungen ist der Betreiber verantwortlich.

CE Marking (Declaration of Conformity)
This product complies with the following EU directives: 93/68/EEC, 2002/96/EC, and 2006/66/EC. This declaration is valid for the area of the 
European Union.

EFI SOFTWARE END USER LICENSE AGREEMENT
PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (“LICENSE AGREEMENT”) CAREFULLY. THIS LICENSE AGREEMENT IS A 
LEGAL AGREEMENT BETWEEN YOU AND ELECTRONICS FOR IMAGING, INC. (“EFI”) REGARDING THE EFI SOFTWARE 
(“SOFTWARE”). YOU AGREE THAT THIS AGREEMENT IS LIKE ANY WRITTEN NEGOTIATED AGREEMENT SIGNED BY YOU. BY 
CLICKING TO ACKNOWLEDGE YOUR AGREEMENT DURING REVIEW OF AN ELECTRONIC VERSION OF THIS LICENSE AGREEMENT 
OR BY INSTALLING, COPYING OR BY OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS LICENSE 
AGREEMENT. THIS LICENSE AGREEMENT IS ENFORCEABLE AGAINST YOU AND ANY LEGAL ENTITY (E.G., SYSTEM INTEGRATOR, 
CONSULTANT OR CONTRACTOR) THAT INSTALLS OR USES THE SOFTWARE ON YOUR BEHALF. IF YOU DO NOT AGREE, DO NOT 
INSTALL, COPY, OR OTHERWISE USE THE SOFTWARE, AND RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE FOR A FULL 
REFUND IN ACCORDANCE WITH ITS REFUND POLICIES.
NOTICE TO PARTIES THAT ACT AS AN AGENT OF AN END USER OR OTHERWISE DO NOT INTEND TO BE END USERS OF THE 
SOFTWARE: IF YOU CLICK TO ACCEPT AN ELECTRONIC VERSION OF THIS AGREEMENT, OR INSTALL, COPY OR OTHERWISE USE 
THE SOFTWARE AS AN AGENT ACTING ON BEHALF OF THE INTENDED LICENSEE, THEN YOU WILL BE DEEMED TO BE THE USER 
OF THE SOFTWARE AND BOUND BY THE TERMS OF THIS AGREEMENT UNLESS YOU (I) DELIVER THE TANGIBLE MEDIA 
CONTAINING THE SOFTWARE AND THIS LICENSE AGREEMENT TO THE LICENSEE PRIOR TO PROVIDING THE LICENSEE ACCESS 
TO THE SOFTWARE, AND (II) REMOVE AND DESTROY ANY COPIES OF THE SOFTWARE IN YOUR POSSESSION.
IF YOU HAVE EXECUTED A SEPARATE SIGNED WRITTEN AGREEMENT WITH EFI FOR THE SOFTWARE, IN THE EVENT OF ANY 
CONFLICTING TERMS AND CONDITIONS BETWEEN SUCH WRITTEN AGREEMENT AND THIS LICENSE AGREEMENT, THE TERMS 
AND CONDITIONS OF THE WRITTEN AGREEMENT SHALL CONTROL.
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License
EFI grants you a limited, non-exclusive license to use the Software solely in accordance with the terms and conditions of this License Agreement, 
solely as specified in the EFI product documentation, and solely with the product(s) specified in the EFI product documentation (“Product(s)”). 
Some third-party materials distributed with the Software may be subject to other terms and conditions, which are typically found in a separate 
license agreement or “Read Me” file located near such third party materials.
The term “Software” as used in this License Agreement shall mean the EFI software (including software provided by third party suppliers) and all 
documentation, downloads, on-line materials, bug fixes, patches, releases, release notes, updates, upgrades, technical support materials, and 
information regarding the EFI software. The terms and conditions of this License Agreement shall apply to and govern your use of all such items; 
however EFI may provide other written terms with an update, release or upgrade.
The Software is licensed, not sold. You may use the Software solely for the purposes described in the EFI product documentation. You may not rent, 
lease, sublicense, lend, or otherwise distribute the Software or use the Software in any time sharing, service bureau, or similar arrangement. Certain 
Software may only be installed at a single, physical location and any relocation of such Software will require EFI’s written consent.
You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except one (1) backup or archive copy for the 
purposes permitted in this License Agreement; provided, however, that under no circumstances may you make or have made, or permit to be made, 
any copies of any portion of the Software that is included on any portion of the controller board or hardware of a product. Any copies of the 
Software that you are permitted to make pursuant to this Agreement must contain the same copyright and other proprietary notices that appear on 
or in the Software.
EFI may occasionally verify the number of copies and configurations, and/or the physical location of Software in use by you. Any such verification 
shall be conducted during normal business hours and in such a manner as not to unreasonably interfere with your normal business activities. In the 
event such verification discloses an underpayment of fees, you shall promptly pay such underpaid fees to EFI in accordance with EFI’s then-current 
price list. You agree not to localize, translate, disassemble, decompile, decrypt, reverse engineer, unbundle, repackage, discover the source code of, 
modify, create derivative works of, or in any way change any part of the Software.
As between you and EFI, you assume all risk and are solely responsible for any and all liability resulting from your use of the Software in a way that 
violates (or that produces content that violates) any law or the rights of others including, without limitation, laws concerning copyright infringement 
or privacy.

Intellectual Property Rights
You acknowledge and agree that all rights, title, and interest, including all intellectual property rights, in and relating to the Software, all EFI 
Products, and all copies, modifications, and derivative works thereof, are solely owned by and shall remain with EFI and its suppliers. Except for the 
express limited license granted in this License Agreement, no right or license of any kind is granted. You receive no rights or license under any 
patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or other intellectual property. You agree not to adopt, register, or 
attempt to register any EFI trademark or trade name or any confusingly similar mark, URL, internet domain name, or symbol as your own name or 
the name of your affiliates or products, and agree not to take any other action which impairs or reduces the trademark rights of EFI or its suppliers.

Excluded License
Notwithstanding anything to the contrary, you are not licensed to (and you agree that you will not) integrate or use the Software in any manner that 
would cause the Software in whole or in part to become subject to any of the terms of an Excluded License. “Excluded License” means any license 
that requires as a condition of use, modification and/or distribution of software subject to the Excluded License, that such software or other software 
combined and/or distributed with such software be (i) disclosed or distributed in source code form; (ii) licensed for the purpose of making derivative 
works; or (iii) redistributable at no charge.

Updates
If the Software is an upgrade or update to a previous version of the Software, you must possess a valid license to such previous version in order to use 
such upgrade or update. All upgrades and updates are provided to you on a license exchange basis. You agree that by using an upgrade or update you 
voluntarily terminate your right to use any previous version of the Software. As an exception, you may continue to use previous versions of the 
Software after you use the upgrade or update only to assist you in the transition to the upgrade or update, provided that the upgrade or update and 
the previous versions are installed on the same device. Upgrades and updates may be licensed to you by EFI with additional or different terms.

Confidentiality
The Software, including its structure, organization, and code, constitutes valuable trade secrets and confidential, proprietary information of EFI and 
its suppliers and you may not distribute or disclose the Software. You may, however, permanently transfer all of your rights under this License 
Agreement to another person or legal entity provided that: (1) such a transfer is authorized under all applicable export laws and regulations, 
including the laws and regulations of the United States, including the United States Export Administration Regulations; (2) you transfer to the 
person or entity all of the Software (including all copies, updates, upgrades, media, printed documentation, and this License Agreement); (3) you 
retain no copies of the Software, including no backup, archival, or other copies, however stored; and (4) the recipient agrees to all of the terms and 
conditions of this License Agreement.
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Termination
Unauthorized use, copying, or disclosure of the Software, or any breach of this License Agreement will result in automatic termination of this license 
and will make available to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software and all component parts 
thereof. All provisions of this License Agreement relating to confidentiality of the Software, disclaimers of warranties, limitation of liability, 
remedies, damages, governing law, jurisdiction, venue, EFI’s intellectual property rights, and Adobe Software shall survive any termination of this 
license.
If the Software contains a License Key, upon termination, EFI may immediately and without notice, execute the License Key, defined as a 
programming code, intentionally inserted into the Software, which if executed, renders the Software or portions thereof inoperable. YOU 
ACKNOWLEDGE AND AGREE THAT THE SOFTWARE MAY CONTAIN A LICENSE KEY AND THAT EXECUTION OF SUCH LICENSE 
KEY SHALL RENDER THE SOFTWARE OR A PORTION THEREOF INOPERABLE. YOU FURTHER ACKNOWLEDGE AND AGREE THAT 
THE LICENSE KEY IS NOT A VIRUS AND THAT IN THE EVENT THAT THE LICENSE KEY IS EXECUTED DUE TO YOUR BREACH, YOU 
MAY BE OBLIGATED TO PAY EFI’S THEN CURRENT FEE TO REACTIVATE THE SOFTWARE, PLUS ANY OTHER APPLICABLE FEES, 
INCLUDING LICENSE FEES.

Limited Warranty and Disclaimer
EFI warrants that the Software, if used as specified in the EFI product documentation, will perform substantially in accordance with the EFI product 
documentation for a period of ninety (90) days from the date of receipt when used on the recommended operating system, platform, and hardware 
configuration. All warranty claims must be made, along with proof of purchase, within such ninety (90) day period. EFI makes no warranty or 
representation that the Software will meet your specific requirements, that the operation of the Software will be uninterrupted, secure, fault-
tolerant, or error free, or that all defects in the Software will be corrected. EFI makes no warranty, implied or otherwise, regarding the performance 
or reliability of any other Products or services or any third party products (software or hardware) or services. THE INSTALLATION OF ANY 
THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. USE, MODIFICATION, AND/OR 
REPAIR OF THE SOFTWARE OR AN EFI PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. FURTHER, 
THIS LIMITED WARRANTY IS VOID IF A PROBLEM WITH THE SOFTWARE ARISES FROM ACCIDENT, ABUSE, MISAPPLICATION, 
ABNORMAL USE, VIRUS, WORM, OR SIMILAR CIRCUMSTANCE. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, 
EXCEPT FOR THE EXPRESS LIMITED WARRANTY SET FORTH ABOVE (“LIMITED WARRANTY”), EFI MAKES AND YOU RECEIVE NO 
REPRESENTATIONS OR WARRANTIES RELATING TO THE SOFTWARE, ANY PRODUCT AND/OR ANY SERVICES, WHETHER EXPRESS, 
IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION OF THIS AGREEMENT OR ANY OTHER COMMUNICATION. EFI AND ITS 
SUPPLIERS SPECIFICALLY DISCLAIM ALL IMPLIED WARRANTIES, REPRESENTATIONS, AND CONDITIONS, INCLUDING THOSE OF 
SECURITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. 
THERE IS NO WARRANTY OR REPRESENTATION THAT THE OPERATION OF THE SOFTWARE AND/OR ANY PRODUCT WILL BE 
UNINTERRUPTED, FAULT-TOLERANT, SECURE, OR ERROR-FREE. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, 
YOUR SOLE AND EXCLUSIVE REMEDY, AND THE ENTIRE LIABILITY OF EFI AND ITS SUPPLIERS, RELATING TO ANY AND ALL 
SOFTWARE, PRODUCTS, SERVICES, AND/OR APPLICABLE WARRANTIES SHALL BE, AT EFI’S OPTION, (1) TO REPAIR OR REPLACE 
THE SOFTWARE THAT DOES NOT MEET THE LIMITED WARRANTY; OR (2) PROVIDE A REFUND OF THE PRICE PAID (IF ANY) FOR 
THE SOFTWARE THAT DOES NOT MEET THE LIMITED WARRANTY. EXCEPT AS PROVIDED IN THIS SECTION, EFI AND ITS 
SUPPLIERS SHALL PROVIDE NO REFUNDS, RETURNS, EXCHANGES, OR REPLACEMENTS.

Limitation of Liability
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, YOU AGREE THAT THE ENTIRE LIABILITY OF EFI AND ITS 
SUPPLIERS FOR ALL CLAIMS RELATED TO ANY SOFTWARE, PRODUCT, SERVICES, AND/OR THIS LICENSE AGREEMENT, 
REGARDLESS OF THE FORM OF ACTION (WHETHER IN CONTRACT, TORT, UNDER STATUTE, OR OTHERWISE), SHALL BE LIMITED 
TO THE AMOUNT PAID BY YOU, IF ANY, FOR THE EFI SOFTWARE. YOU AGREE THAT SUCH AMOUNT IS SUFFICIENT TO SATISFY 
THE ESSENTIAL PURPOSE OF THIS LICENSE AGREEMENT AND THAT SUCH A LIABILITY IS A FAIR AND REASONABLE ESTIMATE OF 
ANY LOSS AND DAMAGE LIKELY TO BE SUFFERED IN THE EVENT OF ANY WRONGFUL ACT OR OMISSION BY EFI AND/OR ITS 
SUPPLIERS. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL EFI AND ITS SUPPLIERS BE LIABLE 
FOR COST OF PROCUREMENT OF SUBSTITUTE SOFTWARE, PRODUCTS OR SERVICES, LOST PROFITS OR DATA, THIRD PARTY 
CLAIMS, OR ANY SPECIAL, INDIRECT, RELIANCE, CONSEQUENTIAL, EXEMPLARY, PUNITIVE, OR INCIDENTAL DAMAGES, 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, RELATED TO ANY SOFTWARE, PRODUCT, SERVICES AND/ OR THIS 
LICENSE AGREEMENT. THIS LIMITATION SHALL APPLY EVEN IF EFI AND ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES. YOU AGREE THAT THE PRICE OF THE EFI SOFTWARE REFLECTS THIS ALLOCATION OF RISK. YOU 
ACKNOWLEDGE AND AGREE THAT THE FOREGOING LIMITATIONS OF LIABILITY AND DISCLAIMERS FORM AN ESSENTIAL 
ELEMENT OF THIS LICENSE AGREEMENT, WITHOUT WHICH EFI WOULD NOT HAVE LICENSED THE EFI SOFTWARE TO YOU. 
BECAUSE SOME JURISDICTIONS DO NOT ALLOW SOME OR ALL OF THE EXCLUSIONS AND/OR LIMITATIONS OF LIABILITY 
HEREIN, SOME OR ALL OF THE ABOVE EXCLUSIONS AND LIMITATIONS MAY NOT APPLY TO YOU.
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Export Restrictions
The Software and EFI Products are subject to the export laws and regulations of the United States, including the United States Export 
Administration Regulations. The license granted to you herein is conditioned upon your compliance with all applicable export laws and regulations, 
including the export laws and regulations of the United States. You represent and agree that you will not use, disclose, distribute, transfer, export, or 
re-export any portion of the Software or any EFI Product in any form in violation of any applicable export laws and regulations, including the export 
laws and regulations of the United States. In addition, if the Software is identified as an export controlled item under the applicable export laws and 
regulations, you represent and warrant that you are not a citizen of, or located within, an embargoed or otherwise restricted nation and that you are 
not otherwise prohibited under such laws and regulations from receiving the Software.

Consent to Use of Data
You agree that EFI may collect and use anonymously aggregated technical information gathered in any manner as part of product support services 
related to the Software. Subject to EFI’s then-current privacy policy and applicable laws and regulations, EFI may: (i) use this information to improve 
its products or to provide customized services or technologies to you; (ii) transfer this information to its affiliates, agents, and partners; and (iii) 
transfer this information to the United States and/or any other country where EFI and its affiliates, agents, and partners maintain facilities.

Adobe Software
The Software may contain the following Adobe Systems Incorporated (“Adobe”) materials: (a) software included as part of the printing system, 
including PostScript® software, Font Programs (digitally-encoded machine-readable outline data encoded in special format and in encrypted form 
used to produce various typefaces) and other Adobe software (collectively, “Printing Software”), and (b) other software which runs on a computer 
system for use in conjunction with the Printing Software (“Host Software”). The following terms are applicable to the materials provided by Adobe:

1. Printing Software. You may use the Printing Software (in object code form only) (i) on a single output device that contains an embedded 
controller; OR (ii) for Printing Software residing on a host computer, on up to the authorized number of central processing units (“CPUs”) for which 
you are licensed, for imaging to the licensed output device(s), solely for your own internal business purposes. You may not change the name of any 
driver software file or driver software icon without consent of EFI. You may use Roman character Font Programs and Adobe Type Manager® to 
reproduce weights, styles, and versions of letters, numerals, characters and symbols (“Typefaces”) on up to five (5) computers for use with the 
Printing Software.

2. Host Software. You may install the Host Software in a single location on a hard disk or other storage device on one (or the authorized number 
of) computer(s) for which you are licensed (“Permitted No. of Computers”), and, provided that the Host Software is configured for network use, 
install and use the Host Software on a single file server for use on a single local area network for either (but not both) of the following purposes: (i) 
permanent installation onto a hard disk or other storage device on the Permitted No. of Computers; or (ii) use of the Host Software over such 
network, provided the use of the Host Software does not exceed the Permitted No. of Computers. You may make one backup copy of the Host 
Software (which shall not be installed or used).
You are hereby notified that Adobe Systems Incorporated, a Delaware corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) 
is a third-party beneficiary to this License Agreement to the extent that this License Agreement contains provisions which relate to your use of any 
software, font programs, typefaces, and/or trademarks licensed or supplied by Adobe. Such provisions are made expressly for the benefit of Adobe 
and are enforceable by Adobe in addition to EFI. ADOBE WILL HAVE NO LIABILITY WHATSOEVER TO YOU FOR ANY ADOBE SOFTWARE 
OR TECHNOLOGY LICENSED HEREUNDER.

Oracle Software
The Software may contain the software and/or materials provided by Oracle Corporation ("Oracle"). Java and all Java-based trademarks and logos 
are trademarks or registered trademarks of Oracle and/or its affiliates.

U.S. Government Restricted Rights
Use, duplication, or disclosure of the Software by the United States Government is subject to restrictions as set forth in FAR 12.212 or DFARS 
227.7202-3 -  227.7202-4 and, to the extent required under U.S. federal law, the minimum restricted rights as set out in FAR 52.227-14, Restricted 
Rights Notice (June 1987) Alternate III(g)(3) (June 1987) or FAR 52.227-19 (June 1987). To the extent any technical data is provided pursuant to the 
Agreement, such data is protected per FAR 12.211 and DFARS 227.7102-2 and to the extent explicitly required by the U.S. Government, is subject to 
limited rights as set out in DFARS 252.227.7015 (November 1995) and DFARS 252.227-7037 (September 1999). In the event that any of the above 
referenced agency regulations are modified or superseded, the subsequent equivalent regulation shall apply. The name of the Contractor is 
Electronics For Imaging, Inc.

Governing Law and Jurisdiction
The rights and obligations of the parties related to this License Agreement will be governed in all respects by the laws of the State of California 
exclusively, as such laws apply to contracts between California residents performed entirely within California. The United Nations Convention on 
Contracts for the International Sale of Goods and any other similar convention does not apply to this License Agreement. For all disputes related to 
the Software, Products, services, and/or this License Agreement, you consent to the exclusive personal jurisdiction and venue of the state courts in 
San Mateo County, California and the federal court for the Northern District of California. 
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General
This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, 
Products, Services, and any other subject matter covered by this License Agreement. If any provision of the License Agreement is held invalid, such 
provision shall be deemed modified to the extent necessary to be enforceable and the other provisions in this License Agreement shall continue in 
full force and effect.
If you have any questions, see the EFI web site at www.efi.com.
Electronics For Imaging, Inc. 
6750 Dumbarton Circle 
Fremont, CA 94555 
USA
Copyright © 2004-2017 Electronics For Imaging, Inc. All rights reserved.
45166696 
1 January 2017

http://www.efi.com
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